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 Forté Agent Contents
Forté Agent is a powerful and easy-to-use Usenet newsgroup reader.    It allows you to browse 
newsgroups both online and offline.    Before you start using Agent, please take a quick look at Getting 
Started.
For more information about using Agent, see How to Use Agent.
For full email support, a spell checker, and more advanced newsreading features, try Forté's commercial 
package, Agent.    See Agent Features for a more detailed description of this product.    To purchase your 
own copy of Agent, see Ordering Agent.
If you have any comments, questions, or problems with Agent, see How to Receive Technical Support.
To help familiarize yourself with Agent's Browser window, click on the various components of the picture 
below.    Alternatively, to see what the icons appearing next to groups and articles represent, click here.
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Add Signature dialog box (Signatures dialog box, Options menu)
Use this dialog box to enter the name of a new signature.

Name
Enter the name of the new signature



Use Information From Another Program dialog box
Use this dialog box to select the program from which Agent will acquire its basic setup information.

Program
Select the program from which you wish to get the initialization information.

Copy program's list of newsgroups
Check this box if you want Agent to use the selected program's newsgroup list to fill in its own list.    If 
you have subscribed to newsgroups in the selected program, you will be subscribed to those groups 
in Agent as well.
Note: If the newsgroup list in the other program is out of date, either uncheck this box or choose 
Refresh Group List from the Online menu at a later time.



Use Information From dialog box
Use this dialog box to enter the location of the program from which Agent will acquire its basic setup 
information.

Enter the name of the directory...
Type in the other program's complete path, including drive.    For example, C:\TRUMPET.



Window Layout dialog box (Options menu)
Use this dialog box to select the layout of the panes in the current window.    You can choose how the 
panes should be arranged and what the contents of each pane should be.

Layout of Panes
These buttons show all of the available pane layouts.    Click on a button to choose a layout.

Contents of Panes
For the layout you have selected above, these buttons show all of the ways that you can organize the 
Groups/Folders pane, Message List pane, and Message pane.    The box with black text represents 
the Groups/Folders pane.    Red text represents the Message List pane.    The Message pane has 
blue text.    Click on a button to choose an organization.

After you have chosen a layout and pressed OK, the window will update to reflect your selection.    If you 
desire, resize the panes by dragging the border between the panes.
TIP:    To show only one pane at a time, select Zoom Window from the Navigate menu or press Z.
If you would like to have a particular layout be the one used when you start Agent or open a new Browser 
window, choose Save As Default Window Layout from the Options menu.    This command saves the pane
layout, pane sizing, and whether or not a pane is zoomed.



General Preferences dialog box (Options menu)
Colors Tab
Use this dialog box to define the colors of text in Agent.

Normal Lines
Choose the color for groups, folders, and read message headers.

Unread Messages
Choose the color for unread message headers.

Highlighted Unread Messages
Choose the color for unread message headers when they are selected.    This is usually the inverse of
the Unread Messages color.

Normal Text
Choose the color for body text.

Quoted Text
Choose the color for response text within a message's body.



General Preferences dialog box (Options menu)
Confirmations Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls the confirmation 
messages Agent displays.    These messages warn you when you are about to perform an irreversible 
action.

Delete Groups or Folders 
Check this box and Agent will display a confirmation message when you manually delete a group or 
folder.

Delete Messages or message bodies
Check this box and Agent will display a confirmation message when you manually delete a message 
or its body.

Delete Outbox messages
Check this box and Agent will display a confirmation message when you manually delete a message 
from the Outbox window.

Close message composition window
Check this box and Agent will display a confirmation message when you close a posting or email 
window without sending the message first.

Stop online tasks
Check this box and Agent will display a confirmation message when you cancel an online operation.

Close Program while online tasks are running
Check this box and Agent will display a confirmation message when you exit Agent while it is 
communicating with the news server.

Mark all messages read or unread
Check this box and Agent will display a confirmation message before marking all the messages in a 
group or folder read or unread.

Mark all messages in All groups read or unread
Check this box and Agent will display a confirmation message before marking all the messages in all 
groups read or unread.

Launch executable binary attachments
Check this box and Agent will display a confirmation message before running an executable (*.exe 
file) detached from a message.

Send Queued messages when closing application
Check this box and Agent will give you the option of transmitting all Usenet messages (those for 
which you pressed the Send Later button) to the Internet when you exit the program.    When 
unchecked, your queued messages are not automatically sent.

Default action in confirmation dialogs is YES
Check this box to make "Yes" the default button on all confirmation dialog boxes.    The default button 
is the one activated when you press the Enter key.



General Preferences dialog box (Options menu)
Dial-Up Tab
Use this dialog box to define the settings for automatically dialing a specified Dial-Up Networking (DUN) 
connection.

Open dial-up connection before going online
Check this box to have Agent automatically dial the specified connection each time Agent goes online.

Prompt before connecting
Check this box to have Agent display the Connect To dialog box before trying to connect with the 
specified connection.    A possible reason for using this option is to require a password to be entered 
manually before connecting (for greater security), rather than having Agent supply it automatically.

If another connection is already open, use it instead
Check this box to have Agent use an open connection to your server, if you already have one, 
whenever attempting a connection.

Connection
From the list, highlight the name of the connection to be used.    The list contains all the connections 
currently defined by the DUN.

Properties
Press this button to open the standard DUN connection properties dialog box, where you can edit the 
properties of the selected connection.    (Not available in WinNT)

New connection...
Press this button to open the standard DUN wizard dialog box, where you can create a new DUN 
connection entry.    (Not available in WinNT)

User Name/Password
Enter the username and password to be used for the connection.    If you want Agent to prompt for a 
password each time you connect, leave the password blank and check the Prompt before connecting 
box above.
· Windows 95 - A separate username and password are stored for each connection in the DUN 

database.    Changing the entries here changes the DUN entries.
· Windows NT - There is no facility for accessing the DUN username and password.    For this 

reason, Agent stores a single name and password for use by all connections.

Close dial-up connection after going offline
Check this option to have Agent behave as follows, depending on how you have set up Dial-Up 
Networking.
· Case 1 - If Agent is configured to open a DUN connection when it goes online, then Agent will 

close the connection automatically.
· Case 2 - If no DUN connection is open before you run Agent, but the DUN system automatically 

opens a connection in response to Agent's request to go online, then Agent will close the 
connection automatically.

· Case 3 - If you open a DUN connection before you run Agent, then Agent will not close the 
connection, even if you have configured to automatically close connections.

Note: This option works even if you have not selected the option to have Agent automatically open a 
dial-up connection.

Prompt before disconnecting
Check this option to have Agent prompt you before closing the connection.

Title of Connection Status Window
Use this option if you are running a non-English version of Windows 95.    When the Windows 95 DUN
dialer completes a connection, it displays a window in the middle of the screen showing the 
connection status.    When Agent is configured to open a DUN connection automatically, after the 
connection has been established, Agent searches for the DUN window and minimizes it.    By default, 



Agent searches for a window title beginning with "Connected to."    If you are running a non-English 
version of Windows 95, you can enter the window's correct title here.



Connect To dialog box
Use this dialog box to define the username and password which the user must enter manually before 
dialing-up a connection.

Connection
From the list, highlight the name of the connection to be used.    The list contains all the connections 
currently defined by the Dial-Up Networking (DUN).

User Name/Password
Enter the username and password to be used for the connection.

Save Password
Check this box to have Agent save the password for subsequent connections.    Agent will 
automatically enter your password for you, eliminating the need to reenter it each time a new 
connection is attempted.

Phone Number
Enter the phone number used to dial-up a connection.    If you leave this entry blank, Agent will use 
the default phone number stored in the DUN database for this connection.

Yes
Press this button to start dialing.

No
Press this button to cancel the dial-up connection, but still go online.    Note: If you have the Control 
Panel Internet Auto Dial option enabled, DUN will probably then display its own Connect To dialog 
box.

Cancel
Press this button to cancel the dial-up connection and not go online.



General Preferences dialog box (Options menu)
Display Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how Agent's 
Browser window appears and behaves.

Show Toolbar
Check this box to display the Agent toolbar directly below the menubar.

Show Status Bar
Check this box to display the Agent status bar at the bottom of the window.

Tab Spacing
Enter the length of tab stops, in characters.

Quoted Text
Enter the characters that commonly appear in follow-up messages signifying that text on the same 
line is quoted from the original message. Agent displays this text in the color defined by the Quoted 
Text setting on this dialog box's Colors tab.

Scroll Margins
Enter the number of rows you want to remain visible above or below the highlighted row when 
scrolling up or down in the Message List pane and Message panes.



General Preferences dialog box (Options menu)
Fonts Tab
Use this dialog box to select the fonts you want Agent to use when displaying and printing browsers and 
messages.

Browser
Press this button to change the font for the Groups/Folders pane as well as for the Outbox, Usenet 
Filters, and Address Book windows.    Fonts for the Message List and Message panes are defined 
below.

Fonts for the Language
In the rest of the dialog box, you may select which fonts to use for each language that you have 
defined.    Use this combobox to select the language you may want to modify.

Variable-Pitch Body
Press this button to change the font to be used when displaying message bodies in a variable-pitch 
font.

Fixed-Pitch Body
Press this button to change the font to be used when displaying message bodies in a fixed-pitch font.

Message List
Press this button to change the font used in the Message List pane.

Use the variable pitch body font
Check this box if you want the font that was selected for the Variable-Pitch Body setting to be used in 
the Message List pane.

Message List Subject
Press this button to change the font of the message subjects in the Message List pane.

Use the bold version of the message list font
Check this box if you want the message subjects to be displayed in the bold version of the Message 
List font.

Printer
Press this button to change the font used when printing.

Use the variable-pitch body font for Headers
When this option is checked, Agent uses the variable-pitch body font for the body pane header and 
for the Subject field on the message composition window.    Otherwise, it uses the default system font.
Note:    You only need to check this box if you've selected a font that does not use the default 
Windows character set (e.g., a Cyrillic font for Russian), and you want the text in the different 
character set to be displayed correctly on the body pane header and/or subject edit field.



Browser Font dialog box
Use this dialog box to change the font for all the browser except the Message List pane.
Note: Message subjects are displayed in the font controlled by the Fonts tab on the General Preferences 
dialog box.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

Script
If the font you select has more than one international character sets associated with it, pick the one 
that you want to use.    For example, the True Type font, Courier New has Western, Greek, Turkish, 
Cyrillic, and Central European character sets available.

See Also:
Message Text Display Options



Variable-Pitch Body Font dialog box
Use this dialog box to change the variable pitch font in which the message bodies are normally displayed.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

Script
If the font you select has more than one international character sets associated with it, pick the one 
that you want to use.    For example, the True Type font, Courier New has Western, Greek, Turkish, 
Cyrillic, and Central European character sets available.

See Also:
Message Text Display Options
Fixed-Pitch Body Font dialog box



Fixed-Pitch Body Font dialog box
Use this dialog box to change the fixed pitch font that message bodies are displayed in when you choose 
Fixed Pitch Font from the Message menu.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

Script
If the font you select has more than one international character sets associated with it, pick the one 
that you want to use.    For example, the True Type font, Courier New has Western, Greek, Turkish, 
Cyrillic, and Central European character sets available.

See Also:
Message Text Display Options
Variable-Pitch Body Font dialog box



Message List Font dialog box
Use this dialog box to change the font of the message headers in the Message List pane.
Note: The other items in the Message List pane (e.g., number of lines and author) use the font controlled 
by the Fonts tab on the General Preferences dialog box.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

Script
If the font you select has more than one international character sets associated with it, pick the one 
that you want to use.    For example, the True Type font, Courier New has Western, Greek, Turkish, 
Cyrillic, and Central European character sets available.

See Also:
Message Text Display Options



Message List Subject Font dialog box
Use this dialog box to change the font of the message subjects in the Message List pane.
Note: The other items in the Message List pane (e.g., number of lines and author) use the font controlled 
by the Fonts tab on the General Preferences dialog box.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

Script
If the font you select has more than one international character sets associated with it, pick the one 
that you want to use.    For example, the True Type font, Courier New has Western, Greek, Turkish, 
Cyrillic, and Central European character sets available.

See Also:
Message Text Display Options



Printer Font dialog box
Use this dialog box to change the font used when printing messages.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

Script
If the font you select has more than one international character sets associated with it, pick the one 
that you want to use.    For example, the True Type font, Courier New has Western, Greek, Turkish, 
Cyrillic, and Central European character sets available.



General Preferences dialog box (Options menu)
Languages Tab
Use this dialog box to define languages used in Agent.    You can define any number of languages (up to 
255).    For each language, you can specify what fonts to use to display and print messages (Options | 
General Preferences | Fonts tab).    You can also specify a spell-checker for each language.    Each group 
has a particular language associated with it.    Thus, when you select a group, the message list and body 
panes use that group's language's fonts.

Languages
This field shows all defined languages.

Add
Press this button to add a new language to the Languages list.

Rename
Press this button to rename the selected language.

Delete
Press this button to delete the selected language.

Spell Checker
Enter the spell checker to be used with the selected language.

See Also:
Default Properties for All Groups Language tab
Properties for Selected Groups Language tab



Add Language dialog box
Use this dialog box to add a language to the Languages list on the Languages tab of the General 
Preferences dialog box.

Name
Enter the name you want to see in the Languages list.

Based on
Select the name of the language on which the language being added is based.    Agent will adopt all 
the properties of that language and use them for displaying fonts.



Rename Language dialog box
Use this dialog box to rename the selected language on the Languages tab of the General Preferences 
dialog box.

Old Name
This is the name of the currently selected language.

New Name
Enter the new name you wish to give to the selected language.



Delete Language command
Use this command to delete the selected language on the Languages tab of the General Preferences 
dialog box.

Show Author's full email address
Check this box to display email addresses and full names in the Author column.    When this box is 
unchecked, only full names are displayed.



General Preferences dialog box (Options menu)
Message List Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how messages are 
formatted.

Enable threading by subject
Check this box to have Agent include messages with the same subject under the same thread, even if
the follow-up message doesn't contain a valid reference to the original.    People frequently mispost 
responses and this helps match follow-ups with the message to which they are responses.
Checking this box will also cause Agent to thread your email messages.

Start a New thread...
Check this box to create a new thread when a follow-up Usenet message's subject is different than 
the main message's subject.    When unchecked, Agent attaches follow-up messages to the original 
even when the subject of the thread changes.

Show threads initially Collapsed
Check this box to initially hide all responses in the Message List pane.

Automatically expand threads containing new messages
Check this box to have Agent automatically expand a thread when skipping to an unread message 
within a thread.    Agent expands the thread only if you had previously retrieved and read the first 
message in the thread.

Follow-Up Indentation
Enter the amount of space, in characters, that follow-up messages should be indented from their 
parent in the Message List pane.

Maximum Follow-Up Level
Enter maximum number of response levels (responses to responses) that you want displayed in the 
Message List pane.    Any responses deeper than this appear at the most indented level.

Date sorts descending
Check this box and Agent will display the newest messages at the top of the Message pane when it is
sorted by date.    When this box is unchecked, the newest message appear at the bottom of the pane. 
Note: You must resort the Message pane for this change to take effect.

Size sorts descending
Check this box and Agent will display the largest messages at the top of the Message pane when it is 
sorted by size.    When this box is unchecked, the largest message appear at the bottom of the pane.   
Note: You must resort the Message pane for this change to take effect.



General Preferences dialog box (Options menu)
Navigation Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how Agent behaves 
when you are navigating within a Browser window.

Skipping to the next unread message...
Check this box and Agent will keep your focus in the same pane when you skip between messages in
different groups or folders.

Marking or ignoring...
Check this box and Agent will automatically skip to the next unread message after you mark a Usenet
message for retrieval or select a thread to be ignored.

Watching an Unread message...
Check this box and Agent will automatically skip to the next unread message after you select Watch 
Thread (or press W) when an unread Usenet message is highlighted.

Skipping to the next unread Group...
Check this box to have Agent automatically mark all the messages in the current group or folder 
"read" when you choose Skip to Next Unread Group.

Double-clicking a message launches its binary attachment
Check this box and double-clicking on any message containing an attachment you've saved will run 
the program associated with the attachment's file type.    For more information, see How to Configure 
a GIF or JPG Viewer to Work with Agent.

Single-Key Read views next unread message body
Checking this box enables you to view the next unread body by simply pressing the Space bar, while 
the Groups/Folders pane or Message List pane has the focus.    (This has the same effect as using 
the View Next Unread Body command.)
When unchecked, the behavior is as follows, depending on the current focus:
· If the focus is in the Message pane, pressing Space bar causes Agent to skip to the next unread 

message in a thread.
· If the focus is in the Message List pane or Groups/Folders pane, pressing the Space bar causes 

Agent to skip to the next unread message.

Automatically mark messages read
These three options control when Agent will automatically mark messages read.    Select the desired 
behavior, as described below:
· Whenever the message body is visible in the Message pane - When this option is selected in 

three-pane mode, Agent marks a message read whenever the body appears in the Message 
pane, no matter which pane has the focus.

· Only when the Message pane is selected - When this option is selected, Agent will only mark a 
message read when the focus is on the Message pane.    This reduces the risk of accidentally 
marking a message read when just browsing in the Message List pane.

· Never - When this option is selected, Agent will not automatically mark messages read when you 
are navigating in the panes.    In this case, you can manually mark messages read by highlighting 
the messages and selecting Mark Read from the Message menu.

See Also:
Navigating in Agent
Watching and Ignoring Threads



General Preferences dialog box (Options menu)
Online Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls Agent's behavior 
while online.

Use Offline Defaults
Press this button if you want to use Agent as an offline news and mail reader.    This button optimally 
configures the remaining controls in this dialog box for offline use.    For more information, see How to 
Use Agent as an Offline Newsreader.

Use Online Defaults
Press this button if you want to use Agent as an online newsreader. This button optimally configures 
the remaining controls in this dialog box for online use.    For more information, see How to Use Agent 
as an Online Newsreader.

Times to retry after server refuses connection
Enter the number of times Agent should attempt to reconnect to the news server when it refuses a 
connection.    This normally happens when the news server is busy.

Pause between retries
Enter the number of seconds between each reconnection attempt.

Unload winsock (hang up) between retries
Check this box to have Agent hang up the modem between reconnection attempts.

Go offline automatically after...
Enter the number of seconds of inactivity that Agent waits before automatically disconnecting from 
your news server.    If you uncheck this box, Agent will not disconnect from your news server until you 
close the program or uncheck Online from the Online menu.
If you intend to read Usenet messages online, you might want Agent to go offline after a few minutes 
of inactivity.    This gives you time to read messages, but doesn't leave Agent online too long.    If you 
intend to read messages offline, you probably want Agent to go offline immediately (0 seconds of 
inactivity).

Send keep-alive messages every...
When this box is checked, Agent sends a command to your news server periodically in order to 
maintain the connection to the server.    This option is useful if your computer is connected to the 
server via a dial-up channel that automatically disconnects after a period of inactivity. 
Enter the frequency of keep-alive messages sent from Agent to your news server.    Uncheck this box 
and Agent won't send any keep-alive messages.

Enable priority message retrieval
When this box is checked, Agent opens a second channel to the news server when you attempt to 
retrieve the body of a message while Agent is already busy performing other online operations.    This 
makes it possible for you to begin reading new messages in one group while retrieving headers in 
another. 

Load winsock on program startup (and leave it loaded when offline)
Check this box to have Agent load winsock on program startup and leave it loaded until you close 
Agent.    Uncheck this box and Agent waits to load winsock until Agent goes online and unloads it 
when it goes offline.
TIP:    Always check this box if you are using Dial-Up Networking (DUN) or Remote Access Service 
(RAS).    They use a different method to detect when to open or close your dial-up connection, which 
does not rely on having applications load and unload winsock.

Viewing Unretrieved Messages When Offline
Select the action you want Agent to perform when you are offline and attempt to view a Usenet 
message for which you do not have the body.    This setting affects double-clicking and pressing Enter
on messages, as well as the View Next Unread Message and View Next Unread Message in Thread 
actions on the Navigate menu.



See Also:
Online Menu Commands Explained



General Preferences dialog box (Options menu)
System Tab
Use this dialog box to define settings that affect how Agent works.    This tab defines information that is 
required to use Agent.

News Server
Enter the name of your news (NNTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email Server
Enter the name of your email (SMTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.



General Preferences dialog box (Options menu)
User Tab
Use this dialog box to define settings that affect how Agent works.    This tab defines information about 
you.

Email Address
Enter your email address.    When you send a message, this address appears in the "From" field.    
For example: lance.boehm@forteinc.com.

Full Name
(Optional) Enter your full name.    This name is included with your email address in messages that you
send.    It is helpful to include your full name if your email address does not contain your name.    Also, 
some programs, such as Agent, can display an author's full name rather than his/her email address.

Organization
(Optional) Enter the name of the organization to which you belong.    This name is sent in the 
"Organization" field of Usenet messages you post.    It is not included in your email messages.

Reply To
(Optional) Enter an email address here if you want people to send replies to an address that is 
different than your Email Address listed above.    For example, you may use your business address as
your Email Address, but would prefer that replies be sent to a personal email address.

Note: Changing the Email Address, Full Name, Organization, or Reply To value here also changes the 
corresponding field on the Posting tab of the Default Properties for All Groups dialog box.

Server requires authorization login
Check this box if your news server requires a special user name and/or password to login.    When 
checked, Agent will automatically fill in your user name when requested by the news server.

User Name
Enter the user name required by your news server for logging in.

Remember password between sessions
Check this box if your news server requires a special password to login and you want Agent to 
automatically enter that password for you.

Password
Enter the password required by your news server for logging in.    For security, your password 
appears as asterisks (*) and is stored in an encrypted format in AGENT.INI.

Note: You must take Agent offline and then back online for changes to the user name or password to take 
effect.
Information about your incoming email server is defined on the System Profile tab of the Inbound Email 
dialog box.



Posting Preferences dialog box (Options menu)
Attachments Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how binary 
attachments sent by you are formatted.    For more information on sending attachments, see How to Send
a Binary Attachment.

Send attachment as Multiple messages
Select this option to split long attachments into multiple messages.    The size of each attachment is 
dictated by the number you enter into the Lines per Messages box.

Send attachment as a Single message
Select this option to include the entire attachment in one message, no matter how long the 
attachment is.

Send text as Preface message
Select this option to send an additional message ahead of the attachment message(s).    This is useful
because it allows people to read a description of the attachment before downloading it.

Send text in First message
Select this option to include the description of the attachment in the attachment's first message.

Do not send any text
When this option is selected, Agent will only send the attachment.    Any other text or description you enter
into the Compose window will be ignored.



Posting Preferences dialog box (Options menu)
General Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how messages that 
you send are formatted.

Line length
Enter the maximum number of characters that can appear on a single line.    Agent automatically word
wraps any lines longer than this.

Validate email address
When checked, Agent validates all email address fields (To:, Cc:, etc.) before sending 
messages.    Uncheck this box if you need to enter non-standard addresses.    Note: Agent 
does not verify that the email address exists.    It simply checks the format to make sure 
it is a valid Internet email address.

Require that local addresses be in Address Book
Local addresses are handy for corresponding with people in your own domain.    However, Agent 
cannot necessarily distinguish between a local address and the name of an address book entry.    You
can use this option to eliminate this ambiguity.
Check this box to have Agent warn you when any address without the domain part is not in the 
address book.    You have the option of correcting the address, if you entered it incorrectly, or telling 
Agent to assume that it is a local address and transmits it unchanged.
If you uncheck this box, Agent assumes that any address without the @domain, which is not in the 
address book, is a local address.
TIP:  Most of the time, you will probably want to leave this option checked.    If you ever want to force 
Agent to assume that an address is a local address, you can simply append an @ to it (e.g., 
barbara@).    This tells Agent that the address is definitely a local address.

Include original text in follow-ups and replies
Check this box to include a copy of the original text in follow-up Usenet messages and email replies.

Quote original text in forwarded email
Check this box to insert the quote prefix (defined below) in front of each line of a message's text when
forwarding it via email.

Prefix for quoted lines
For follow-up and reply messages, enter the character(s) that signify that the text on the same line is 
quoted from the original message.    (For more information, see Paste as Quote.)

Follow-Up Usenet Msg
Enter the text to appear just above quoted lines when following-up to a Usenet message with another 
Usenet message.

Reply to Usenet Msg
Enter the text to appear just above quoted lines when replying to a Usenet message with an email 
message.

Forward Usenet Msg
Enter the text to appear just above quoted lines when forwarding a Usenet message to someone via 
email.

Reply to Email
Enter the text to appear just above quoted lines when replying to an email message with another 
email message.

Forward Email
Enter the text to appear just above quoted lines when forwarding an email message to someone via 
email.

For more information, see Composing an Introduction String.





Local address
A local address is an email address without the "@domain" part.    Most email servers accept local 
addresses, and add the local domain automatically.    People can use local addresses when 
corresponding with other people within the same domain.
Local address: barbara
Full address: barbara@acme.com
or
Local address: john.doe
Full address: john.doe@marvelinc.com



Composing an Introduction String
When you reply to a message, it's common practice on the Internet to include some of the text from the 
original message in the reply.    It is also common practice to precede the original text with a line such as 
"Jessye Lynn Sidell wrote:"    You define this introduction string on the Posting tab of the Preferences 
dialog box.

The following table describes the different fields you can include in introduction strings.    When you 
include a field in an introduction string, Agent automatically replaces that field with its value from the 
original message.    To include a field in a string, enclose it within percent signs (e.g., %from%). To include 
the percent sign in the string, enter two of them next to each other (e.g., %%).
Note:    When you use %from%, Agent includes the entire email address of the person who posted the 
message.    (See the field From below.)

Field Description
Date The date the message was sent.
Reply-To Where the author wanted replies sent.
From The email address of the person who posted the message.
Sender The sender of the message.    Note: This may be a different person than the one in the 

From field if the sender wasn't the one who actually posted the message.
Full-Name The full name of the author, extracted from the From field.
Subject The brief description of the message.
Message-Id The message's unique message ID.
Newsgroups The newsgroup to which this message was posted.    If the message was posted to more

than one group, the current group is used.
Followup-To The newsgroups where the sender of the message wants follow-up messages posted.
Expires The date the message is scheduled to expire.
References For follow-up messages, the message IDs of the messages to which this message 

refers.
Organization The author's organization.
Keywords Optional keywords included by the author to help categorize the message.
Summary A summary description of the message.
Lines The number of lines in the message.

You may also use the following to represent special characters:

Character Description
\n The newline character.
\t A tab.
\\ The backslash character itself.



 Default Properties for All Groups dialog box (Group menu)
Attachments Tab
Use this dialog box to define your default group settings.    This tab defines the directory where Agent 
saves binary attachments.

Binary Attachments Directory
Enter the directory where you want Agent to save binary attachments.

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



Default Properties for All Groups dialog box (Group menu)
Attachments Tab
Use this dialog box to define your default group settings.    This tab defines the directory where Agent 
saves binary attachments.

Binary Attachments Directory
Enter the directory where you want Agent to save binary attachments.

Use message subject for filename
Check this box to use the message's subject as the filename when saving a binary attachment.    
When unchecked, Agent uses the filename from the message's uuencoded header instead.

Filename conversions
Select the filename conversion method you want Agent to use when saving a binary attachment.    
Note:    Changing this setting here also changes the corresponding setting in the Properties for 
Selected Groups dialog box.
· Retain original filename, if possible - Use the original filename from the message, to the extent

allowed by the destination file system.    Various file systems disallow certain characters and limit 
the maximum filename length, in which case Agent makes the necessary adjustments.

· Convert to DOS 8.3 filename when saving to a DOS volume - If the destination file system is a
FAT volume (i.e., as DOS disk), convert the filename to the traditional 8.3 format.    Note: 
Windows 95 and Windows NT are capable of storing long filenames on FAT volumes.    When this
option is selected, Agent uses the traditional format even if the file system is capable of storing 
long names.    This option is useful if you intend to copy the files to other systems where long 
filenames are not supported. 

· Always convert to DOS 8.3 filename - Always convert to the traditional 8.3 FAT filename format,
even on file systems that support long filenames (e.g., Windows NT's NTFS), FAT with long 
filename support (e.g., Windows 95), and HPFS (e.g., OS/2). 

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



Default Properties for All Groups dialog box (Group menu)
Languages Tab
Use this dialog box to define the default language to be used for all groups.

Language
Select the default language to be used for all groups.

See Also:
General Preferences dialog box Languages tab
Properties for Selected Groups dialog box Language tab



Default Properties for All Groups dialog box (Group menu)
Marking Read Tab
Use this dialog box to define your default group settings.    This tab controls when Agent marks Usenet 
messages read.
Usually, you'll want to mark all existing messages read each time you retrieve new messages so that only 
the new ones are left unread. 

When retrieving new message headers
Check the option that accomplishes how you want messages marked read when you retrieve new 
message headers.
· Do not mark any existing messages read - prevents Agent from marking any existing 

messages read.
· Mark all existing messages read - marks all existing Usenet messages read each time you 

retrieve new message headers for this group.
· Mark only messages without bodies read - marks read only messages without bodies.

When retrieving marked message bodies
Check the option to accomplishes how you want existing messages marked read when you retrieve 
marked message bodies for this group.    All the new messages Agent retrieves will be marked unread
so that you can easily find them.
· Do not mark any existing messages read - prevents Agent from marking any existing 

messages read when retrieving marked message bodies for this group.
· Mark all existing messages read - marks all existing Usenet messages read each time you 

retrieve new message bodies for this group.
· Mark only messages without bodies read - marks only messages without bodies read for this 

group.

See Also:
Marking Messages Read



Default Properties for All Groups dialog box (Group menu)
Posting Tab
Use this dialog box to define your default group settings.    This tab controls how postings are handled.    
Note: All of these settings can be overridden for a particular message.    See the Compose Usenet 
Message window and the Compose Email Message window for details.

Copy follow-up messages to author via email
When checked, Agent will send a copy of follow-up messages you post to the author of the message 
to which you are responding.    You can easily override this behavior for individual follow-ups by 
removing the author's name from the Email To field on the Compose Usenet Message window.

Signature
Select a default signature for all your postings and email.    Note: Changing this setting here also 
changes the Default Signature defined in the Signatures dialog box. 

Spell Check Language
Select a default language dictionary for all your postings and email.    Note: Changing this setting here
also changes the Default Language defined on the Spelling tab of the Preferences dialog box.    For 
more information, see About Agent's Dictionaries.

File sent messages in folder
Select the folder in which to file messages you send.    Choose "[Leave in Outbox]" to save all sent 
messages in your Outbox or choose "[Delete]" to have Agent delete your messages after sending 
them.

File replies in same folder as original message
When replying or following up to a message in a folder, checking this box tells Agent to save your new
message in that folder instead of the folder specified above.

Fields
This list contains all the Usenet message fields (and some email ones as well) for which you can set 
default values.    See Message Fields for a description of each field.    Setting a default value for these 
fields saves you time when creating messages because you don't have to reenter the common 
information each time.    Note: The global defaults for the From, Organization, and Reply-To 
fields also appear on the User tab of the Preferences dialog box.    Changing these fields 
here also changes them in that dialog box (and vice versa).
To change a particular field's default value:
1. Highlight the desired field
2. Check the "Override default value for field" box
3. Enter the new value in the "Value for <Field>" control.

Value for <Field>
Enter the default value for the field selected in the Fields list.

See Also:
Compose Usenet Message window
Compose Email Message window
How to Post Usenet Messages
How to Send Email



Default Properties for All Groups dialog box (Group menu)
Retrieving Tab
Use this dialog box to define your default group settings.    This tab controls how and what Agent retrieves 
from the news server.

Retrieve bodies for all new messages
Check this box to have Agent automatically retrieve the bodies for all new Usenet messages at the 
same time it retrieves the headers.    This option is handy if you know you'll always want to read all of 
the messages in a particular group.    Of course, it takes a lot longer to retrieve the bodies, so you 
probably don't want to select this option for all groups.

Do not retrieve messages longer than...
Check this box and enter a value to limit the size of bodies that are automatically retrieved by the 
option above.    For example, you may want to read most of the messages in a particular group, but 
not necessarily download the group's FAQ every time it is posted.    If you know the FAQ is usually 
over 200 lines long, limit the maximum size to 200 lines.

Limit number of headers retrieved per session to...
Check this box and enter a value to limit the number of headers retrieved each time you retrieve new 
headers for the group.    For example, if you limit the number to 100 headers, Agent will retrieve no 
more than the 100 most-recent messages.    This option is handy if you want to catch up with a busy 
group, and know you can't possibly read all the messages posted since you last checked.    Note: This
setting only affects the Get New Headers in Subscribed Groups and the Get New Headers in 
Selected Groups commands.    For more information on these commands, see Online Menu 
Commands Explained.

View Empty Group Action
Select the action you want Agent to take when you double-click or press Enter on an empty 
newsgroup.

Server Creates messages out of order
Check this box to have Agent keep track of gaps in the range of retrieved messages.

See Also:
Sample Headers from Selected Groups
Online Menu Commands Explained



View Empty Group actions
The possible actions are:
· Do Nothing - Agent will take no action.
· Get All headers - Agent will get all the headers for the empty group.
· Get sample of headers - Agent will retrieve a sampling of headers for the empty group.    If you select 

this option, you can specify the maximum number of headers to sample.
· Prompt for action - Agent will prompt you before taking any action.



Default Properties for All Groups dialog box (Group menu)
When to Purge Tab
Use this dialog box to define your default group settings.    This tab controls when Agent automatically 
purges (deletes) Usenet messages.    To control which messages Agent purges, see the What to Purge 
tab of the Default Properties for All Groups dialog box.    For more information on purging in general, see 
About Usenet Message Purging.

Purge - When retrieving new headers
When checked, Agent purges messages from a newsgroup when it retrieves new headers for that 
group.

Purge - When closing Agent
When checked, messages from all newsgroups are purged when you exit Agent.

Compact - After manual purges
When checked, selecting a Purge Messages option from the Group menu also compacts your 
databases.    Note: A database is compacted only when the percent of disk space saved is greater 
than the value entered in the "Compact only if wasted space at least..." field below.

Compact - When closing Agent
When checked, Agent will compact all your databases when it closes.    Note: A database is 
compacted only when the percent of disk space saved is greater than the value entered in the 
"Compact only if wasted space at least..." field below.

Compact only if wasted space at least...
Before compacting a database, Agent checks to see how much disk space would be saved by the 
compact operation.    This setting allows you to bypass the potentially time-consuming operation if 
only a small amount of disk space would be saved.    Enter the minimum amount of disk space 
savings, as a percentage of the total size of the database, that will cause Agent to perform an 
automatic compaction after either a manual purge and/or an automatic purge during exit.

When closing Agent, prompt for confirmation...
When checked, Agent asks for confirmation before purging and/or compacting databases when you 
close the program.    When unchecked, the Agent will purge and/or compact the databases without 
asking first.    Note: To purge or compact databases on exit, be sure to check the appropriate box 
above.

See Also:
Compacting Agent's Database Files



Default Properties for All Groups dialog box (Group menu)
What to Purge Tab
Use this dialog box to define your default group settings.    This tab controls which Usenet messages 
Agent automatically purges (deletes).    To control when Agent purges messages, see the When to Purge 
tab of the Default Properties for All Groups dialog box.    For more information on purging in general, see 
About Usenet Message Purging.

Configure Agent's Hard Disk Usage
The buttons in this box help you define the purging options below. Agent maintains a database of 
messages for each group and these buttons provide presets for common purging configurations.    
After pressing one of these buttons, check the other values in the dialog box and change them to 
meet your specific requirements.

Purge Read Messages Without Bodies
This control defines when Agent purges messages you did not retrieve but marked read (i.e., you only
retrieved the message's header).    Usually, these are messages that you are not interested in 
reading.    For more information on each option in the list, click On every purge, When the message is 
older than, and When the message is no longer available.

Purge Read Messages With Bodies
This control defines when Agent purges messages you have retrieved and read.    For more 
information on each option in the list, click On every purge; On every purge, delete body only; When 
the message is older than; and Never.

Purge Unread Messages Without Bodies
This control defines when Agent purges messages you have not retrieved or marked read (i.e., you 
only retrieved the message's header).    Usually, you haven't yet decided if you want to read these 
messages.    For more information on each option in the list, click On every purge, When the message
is older than, and When the message is no longer available.

Purge Unread Messages With Bodies
This control defines when Agent purges messages you have retrieved but not yet read.    For more 
information on each option in the list, click On every purge; On every purge, delete body only; When 
the message is older than; and Never.

Always get complete list of available messages from server
When checked, Agent retrieves a complete list of available messages whenever it gets new headers.  
This option is useful (but not required) when you have selected the "When the message is no longer 
available" option in one of the controls above.    It does, however, increase the time required to get 
new headers.    For a group containing 500 messages, it increases the download time for each group 
by about five seconds for a 14.4 kbps modem connection.
When unchecked, Agent purges messages with numbers lower than the range of available messages
reported by the news server.    Since there are often gaps in the available range of messages, this 
setting may cause Agent to keep messages that are no longer available.

See Also:
Marking Messages Read
Compacting Agent's Database Files



 Properties for Selected Groups dialog box (Group menu)
Attachments Tab
Use this dialog box to define settings for the selected newsgroup.    TIP:    If you highlight several groups 
before opening this dialog box, you will be changing the settings for all the selected groups at once.
This tab defines the directory where Agent saves binary attachments.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Binary Attachments Directory
Enter the directory where you want Agent to save binary attachments decoded from this group.

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



Properties for Selected Groups dialog box (Group menu)
Attachments Tab
Use this dialog box to define settings for the selected newsgroup.    TIP:    If you highlight several groups 
before opening this dialog box, you will be changing the settings for all the selected groups at once.
This tab defines the directory where Agent saves binary attachments.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Binary Attachments Directory
Enter the directory where you want Agent to save binary attachments decoded from this group.

Use message subject for filename
Check this box to use the message's subject as the filename when saving binary attachments.    
When unchecked, Agent uses the filename stored in the message's uuencoded header instead.

Filename conversions
Select the filename conversion method you want Agent to use when saving a binary attachment.    
Note: Changing this setting here also changes the corresponding setting in the Default Properties for 
All Groups dialog box.
· Retain original filename, if possible - Use the original filename from the message, to the extent

allowed by the destination file system.    Various file systems disallow certain characters and limit 
the maximum filename length, in which case Agent makes the necessary adjustments.

· Convert to DOS 8.3 filename when saving to a DOS volume - If the destination file system is a
FAT volume (i.e., as DOS disk), convert the filename to the traditional 8.3 format.    Note: 
Windows 95 and Windows NT are capable of storing long filenames on FAT volumes.    When this
option is selected, Agent uses the traditional format even if the file system is capable of storing 
long names.    This option is useful if you intend to copy the files to other systems where long 
filenames are not supported. 

· Always convert to DOS 8.3 filename - Always convert to the traditional 8.3 FAT filename format,
even on file systems that support long filenames (e.g., Windows NT's NTFS), FAT with long 
filename support (e.g., Windows 95), and HPFS (e.g., OS/2). 

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



Properties for Selected Groups dialog box (Group menu)
Languages Tab
Use this dialog box to define the default language to be used for the selected group.

Language
Select the default language to be used for the selected group.

See Also:
General Preferences dialog box Languages tab
Default Properties for All Groups Language tab



Properties for Selected Groups dialog box (Group menu)
Marking Read Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.
This tab controls when Agent marks Usenet messages read.    Usually, you'll want to mark all existing 
messages read each time you retrieve new messages so that only the new ones are left unread. 

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

When retrieving new message headers
Check the option that accomplishes how you want existing messages marked read when you retrieve 
new message headers.
· Do not mark any existing messages read - prevents Agent from marking any existing 

messages read.
· Mark all existing messages read - marks all existing Usenet messages read each time you 

retrieve new message headers for this group.
· Mark only messages without bodies read - marks read only messages without bodies.

When retrieving marked message bodies
Check the option that accomplishes how you want existing messages marked read when you retrieve 
marked message bodies for this group.    All the new messages Agent retrieves will be marked unread
so that you can easily find them.
· Do not mark any existing messages read - prevents Agent from marking any existing 

messages read when retrieving marked message bodies for this group.
· Mark all existing messages read - marks all existing Usenet messages read each time you 

retrieve new message bodies for this group.
· Mark only messages without bodies read - marks only messages without bodies read for this 

group.

See Also:
Marking Messages Read



Properties for Selected Groups dialog box (Group menu)
Posting Tab
Use this dialog box to define settings for the selected group.
TIP:    If you highlight several groups before opening this dialog box, you will be changing the settings for 
all the selected groups at once.
This tab controls how postings to this group and email replies from this group are handled.    Note: All of 
these settings can be overridden for a particular message.    See the Compose Usenet Message window 
and the Compose Email Message window for details.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.    Note: Checking this box only overrides the "Copy follow-up 
messages to author via email," "Signature," and "Spell Check Language" settings.    Each field in the 
"Fields" list must be overridden independently (see below for details).

Copy follow-up messages to author via email
When checked, Agent will send a copy of follow-up messages you post to the author of the message 
to which you are responding.    You can easily override this behavior for individual follow-ups by 
removing the author's name from the Email To field on the Compose Usenet Message window.

Signature
Select a signature to use for posting to this group or email replies from this group.

File sent Messages in folder
Select the folder in which to file messages you send from this group.    Choose "[Leave in Outbox]" to 
save all sent messages in your Outbox or choose "[Delete]" to have Agent delete your messages after
sending them.

Fields
This list contains all the Usenet message fields (and some email ones as well) for which you can set 
default values.    See Message Fields for a description of each field.    Setting a default value for these 
fields saves you time when creating messages because you don't have to reenter the common 
information each time.    You can even default the Newsgroups field to automatically cross-
post messages to several groups.
To change a particular field's default value:
1. Highlight the desired field
2. Check the "Override default value for field" box
3. Enter the new value in the "Value for <Field>" control.

Override default value for field
Check this box to use the default field value defined on this tab instead of the one defined in the 
Default Properties for All Groups dialog box.

Value for <Field>
Enter the default value for the field selected in the Fields list.    You must check the "Override default 
value for field" box before you can enter a value here.

See Also:
Compose Usenet Message window
Compose Email Message window
How to Post Usenet Messages
How to Send Email



Properties for Selected Groups dialog box (Group menu)
Retrieving Tab
Use this dialog box to define settings for the selected newsgroup.    TIP:    If you highlight several groups 
before opening this dialog box, you will be changing the settings for all the selected groups at once.
This tab controls how and what Agent retrieves from the news server.    Note:    The options View Empty 
Group Action and Maximum headers to sample apply to all groups.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Retrieve bodies for all new messages
Check this box to have Agent automatically retrieve the bodies for all new Usenet messages at the 
same time it retrieves the headers.    This option is handy if you know you'll always want to read all of 
the messages in a particular group.    Of course, it takes a lot longer to retrieve the bodies, so you 
probably don't want to select this option for all groups.

Do not retrieve messages longer than...
Check this box and enter a value to limit the size of bodies that are automatically retrieved by the 
option above.    For example, you may want to read most of the messages in a particular group, but 
not necessarily download the group's FAQ every time it is posted.    If you know the FAQ is usually 
over 200 lines long, limit the maximum size to 200 lines.

Limit number of headers retrieved per session to...
Check this box and enter a value to limit the number of headers retrieved each time you retrieve new 
headers for the group.    For example, if you limit the number to 100 headers, Agent will retrieve no 
more than the 100 most-recent messages.    This option is handy if you want to catch up with a busy 
group, and know you can't possibly read all the messages posted since you last checked.    Note: This
setting only affects the Get New Headers in Subscribed Groups and the Get New Headers in 
Selected Groups commands.    For more information on these commands, see Online Menu 
Commands Explained.

View Empty Group Action
Select the action you want Agent to take when you double-click or press Enter on an empty 
newsgroup.

Server Creates messages out of order
Check this box to have Agent keep track of gaps in the range of retrieved messages.

See Also:
Sample Headers from Selected Groups
Online Menu Commands Explained



Sample Headers from Selected Groups (Online menu)
This dialog box allows you to choose the number of messages to sample for a selected group.

Retrieve the most recent messages, up to the specified number
Select this option if you want to change the number of most recent headers to be sampled for a 
selected group.

Maximum number of messages to retrieve
If you selected the previous option, enter the number of headers you want Agent to sample for the 
selected group.    The default number is 50.

Retrieve All messages posted more recently than the specified date
Select this option if you want Agent to retrieve all message headers that were posted since a 
specified date.    This date is determined by the number of days to be retrieved, specified in the 
following entry field.

Number of days to retrieve
If you selected the previous option, enter the number of days prior to the current date you want as the
starting point in the range of dates for retrieving all messages.    This entry automatically changes the 
specified date from which all message headers will be retrieved.



Properties for Selected Groups dialog box (Group menu)
What to Purge Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.
This tab controls which Usenet messages Agent automatically purges (deletes).    To control when Agent 
purges messages, see the When to Purge tab of the Properties for Selected Groups dialog box.    For 
more information on purging in general, see About Usenet Message Purging.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Configure Agent's Hard Disk Usage
The buttons in this box help you define the purging options below. Agent maintains a database of 
messages for each group and these buttons provide presets for common purging configurations.    
After pressing one of these buttons, check the other values in the dialog box and change them to 
meet your specific requirements.

Purge Read Messages Without Bodies
This control defines when Agent purges messages you did not retrieve but marked read (i.e., you only
retrieved the message's header).    Usually, these are messages that you are not interested in 
reading.    For more information on each option in the list, click On every purge, When the message is 
older than, and When the message is no longer available.

Purge Read Messages With Bodies
This control defines when Agent purges messages you have retrieved and read.    For more 
information on each option in the list, click On every purge; On every purge, delete body only; When 
the message is older than; and Never.

Purge Unread Messages Without Bodies
This control defines when Agent purges messages you have not retrieved or marked read (i.e., you 
only retrieved the message's header).    Usually, you haven't yet decided if you want to read these 
messages.    For more information on each option in the list, click On every purge, When the message
is older than, and When the message is no longer available.

Purge Unread Messages With Bodies
This control defines when Agent purges messages you have retrieved but not yet read.    For more 
information on each option in the list, click On every purge; On every purge, delete body only; When 
the message is older than; and Never.

Always get complete list of available messages from server
When checked, Agent retrieves a complete list of available messages whenever it gets new headers.  
This option is useful (but not required) when you have selected the "When the message is no longer 
available" option in one of the controls above.    It does, however, increase the time required to get 
new headers.    For a group containing 500 messages, it increases the download time by about five 
seconds for a 14.4 kbps modem connection.
When unchecked, Agent purges messages with numbers lower than the range of available messages
reported by the news server.    Since there are often gaps in the available range of messages, this 
setting may cause Agent to keep messages that are no longer available.

See Also:
Marking Messages Read
Compacting Agent's Database Files



On every purge
Select this option to purge this type of message every time Agent purges any messages from the 
newsgroup.    This option reduces the amount of clutter in the Message List pane, but prevents you from 
reading messages that you may have overlooked in previous sessions.



When the message is older than
Select this option to purge this type of Usenet message when it is older than the specified number of 
days.



When the message is no longer available
Select this option to purge this type of message when it is purged from the news server's list of 
messages.    This setting makes the list of messages displayed by Agent a mirror image of those available
from the server.



On every purge, delete body only
Select this option to purge the body of this type of message every time Agent purges any messages from 
the newsgroup.    Purging only bodies saves hard disk space while still allowing you to maintain a 
complete list of messages.



Never
Select this option to prevent messages of this type from being purged.    As an alternative to this option, 
you may want to consider keeping the important messages (highlight the message and choose Keep 
Message from the Message menu) or moving them to a folder.



Properties for Selected Groups dialog box (Group menu)
When to Purge Tab
This tab controls when Agent automatically purges (deletes) Usenet messages.    To control which 
messages Agent purges, see the What to Purge tab of the Properties for Selected Groups dialog box.    
For more information on purging in general, see About Usenet Message Purging.
Note: These controls affect when all groups are purged, not just the selected one.

Purge - When retrieving new headers
When checked, Agent purges messages from a newsgroup when it retrieves new headers for that 
group.

Purge - When closing Agent
When checked, messages from all newsgroups are purged when you exit Agent.

Compact - After manual purges
When checked, selecting a Purge Messages option from the Group menu also compacts your 
databases.    Note: A database is compacted only when the percent of disk space saved is greater 
than the value entered in the "Compact only if wasted space at least..." field below.

Compact - When closing Agent
When checked, Agent will compact all your databases when it closes.    Note: A database is 
compacted only when the percent of disk space saved is greater than the value entered in the 
"Compact only if wasted space at least..." field below.

Compact only if wasted space at least...
Before compacting a database, Agent checks to see how much disk space would be saved by the 
compact operation.    This setting allows you to bypass the potentially time-consuming operation if 
only a small amount of disk space would be saved.    Enter the minimum amount of disk space 
savings, as a percentage of the total size of the database, that will cause Agent to perform an 
automatic compaction after either a manual purge and/or an automatic purge during exit.

When closing Agent, prompt for confirmation...
When checked, Agent asks for confirmation before purging and/or compacting databases when you 
close the program.    When unchecked, the Agent will purge and/or compact the databases without 
asking first.    Note: To purge or compact databases on exit, be sure to check the appropriate box 
above.

See Also:
Compacting Agent's Database Files



Find dialog box (Edit menu)
Use this dialog box to find a group, folder, or message.

Find What
Enter the text to search for.

Find First
Press this button to find the first occurrence of the text you entered above.

Find Next
Press this button to find the next occurrence of the text you entered above.

See Also:
Finding Groups and Folders
Finding Messages



Licensing Agreement dialog box
This dialog box displays Agent's licensing terms and conditions.    You must accept the terms and 
conditions in order to run the program.

Accept
Press this button to accept the terms of the agreement and run Agent.

Decline
Press this button if you do not accept the terms of the agreement.    Agent will not run if you press this 
button.



Page Setup dialog box (File menu)
Use this dialog box to control the format of messages printed with Agent.

Margins
Enter the left, right, top, and bottom margins in inches.

All fields
Select this option to print all of the header information along with the message bodies.

Selected fields
Select this option to print some of the header information along with the message bodies.    In the 
associated text box, enter the names of the fields, separated by commas, you want printed with the 
message bodies.    You can list any field names, including non-standard fields.    Note: Agent prints a 
field only if it appears in the message.    If you want Agent to print the field even if it doesn't appear in 
the message, precede the field name with an exclamation point (e.g., !Keywords).

No fields (Body only)
Select this option to print only the message bodies.

None
Select this option to print messages one directly after the other.

Between messages
Select this option to insert a page break between each message being printed.

Between threads
Select this option to print all the messages in the same thread one after the other and to insert a page
break between messages of different threads.

See Also:
Printing Messages



Server Authorization Password dialog box
Use this dialog box to enter the password required to login to your news server.

Password
Enter the password required by your news server.

Remember password between sessions
Check this box if you want Agent to automatically enter that password for you each time you login to 
the news server.



Refresh Groups List dialog box (Online menu)
Use this dialog box to update your group list and define what Agent should do with groups it no longer 
finds on the news server.
The refresh operation retrieves a complete list of all newsgroups available form the server.    It then adds 
any new groups to Agent's list of groups, and optionally deletes any groups that are no longer available.    
TIP:    If you only want to retrieve new groups added since the last time you updated your group list, 
choose Get New Groups from the Online menu.
Note: Since this operation retrieves a complete list of groups, it can take several minutes to complete.

Keep all extinct groups
Select this option to maintain groups even if they no longer exist on the server.

Delete extinct groups that are empty
Select this option to maintain groups that no longer exist on the server if the group contains 
messages.

Delete all extinct groups
Select this option to delete any group which no longer exists on the server.

See Also:
Online Menu Commands Explained



Rename Signature dialog box (Signatures dialog box, Options menu)
Use this dialog box to change the name of a signature.

New Name
Enter a new name for the signature.



Save Messages As dialog box (File menu)
Use this dialog box to save one or more messages to a text file.    Note: Agent only saves messages 
whose bodies have been retrieved.
Select all the messages you want to save before choosing this menu option.    If you select a collapsed 
thread, Agent will save all messages in the thread.

File Name
Enter the name of the file you want to save to, or select a file from the list of files. 

Directories
Select the directory where you want to save the file. 

List of File Types
Select the type of files you want to display in the list of files. 

Drives
Select the drive where you want to save the file. 

Append to Existing File
Check this box if you want to append the messages to an existing file.    If you uncheck this option and
save the messages to an existing file, Agent will erase the current contents of the file.

UNIX message file
Select this option and Agent will save the messages in the standard UNIX message format.    In this 
format, messages begin with a "From <user>@<domain> <date>" line.    This options also 
causes Agent to add a ">" before any body line that begins with "From<space>" and 
contains an "@" character anywhere in the line.

Precede each message with...
Select this option and Agent will add the specified text to the beginning of each message 
it saves.    You can include the codes \n, \t, \f, and \\ in the specified text to represent 
newlines, tabs, formfeeds, and backslashes, respectively.

No separator between messages
Select this option if you do not want Agent to include any additional text between the saved 
messages.

All fields
Select this option to save all of the header information along with the message bodies.

Selected fields
Select this option to save some of the header information along with the message bodies.    In the 
associated text box, enter the names of the fields, separated by commas, you want saved with the 
message bodies.    You can list any field names, including non-standard fields.    Note: Agent writes a 
field only if it appears in the message. If you want Agent to write the field even if it doesn't appear in 
the message, precede the field name with an exclamation point (e.g., !Keywords).

No fields (Body only)
Select this option to save only the message bodies.

See Also:
Printing Messages



Agent Setup dialog box
Fill in this dialog to provide Agent with the basic information needed to communicate with your news and 
mail servers.    If you don't want to post messages, you only need to supply the name of your news server.
You can enter the other information later in the Preferences dialog box.

Use Information From Another Program
If you're already using one of the listed programs, Agent can get most of its basic setup information 
from the other program's configuration files.    Press this button to select the program you use.

News (NNTP) Server
Enter the name of your news (NNTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email (SMTP) Server
Enter the name of your email (SMTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email Address
Enter your email address.    When you send a message, this address appears in the "From" field.    
For example: john.doe@forteinc.com

Full Name
(Optional) Enter your full name.    This name is included with your email address in messages that you
send.    It is helpful to include your full name if your email address does not contain your name.    Also, 
some programs, such as Agent, can display an author's full name rather than his/her email address.

Spell Check Language
(Not available in Free Agent) Select the default language dictionary to use for spell checking 
messages.    For more information, see About Agent's Dictionaries.

Exit Agent
Press this button if you don't have the basic information available.    The next time you run Agent, this 
dialog box will be displayed again.



Signatures dialog box (Options menu)
Use this dialog box to define the signatures you wish to use in messages you send.

Names
This is a list of the signatures you have defined.    To edit a signature, select it in this list and enter the 
new text in the controls below.

Add
Press this button to create a new signature.

Rename
Press this button to rename the signature highlighted in the Names list.

Delete
Press this button to delete the signature highlighted in the Names list.    If you accidentally delete a 
signature, press the Cancel button to close the dialog box and cancel all of your changes.

Default Signature
Select the signature you wish to use by default.    Select [None] if you don't want to have a default 
signature.    When you post a message, Agent automatically uses your default signature.    You can 
choose a different signature to be the default for each newsgroup (see the Posting tab of the 
Properties for Selected Groups dialog box) or override the signature used for a specific message (see
the Compose Usenet Message window).    Note: Changing this setting here also changes the 
signature set on the Posting tab of the Default Properties for All Groups dialog box.

Text
Enter the text of the signature highlighted in the Names list. If you want a blank line or other separator
to appear between the rest of the message and the signature, you need to include it here.    To insert 
a TAB in the text, press Ctrl+TAB.
TIP:    A common convention on the Internet is to begin your signature with a line containing two 
dashes.    For example:
--
Dave Chin
Forte, Inc.

Use existing file
If you want to share a signature file with another program, enter the name of the file that contains the 
signature.    When you have entered a valid file name, the dialog will display the contents of the file in 
the Text field.    Any changes you make to the signature in this dialog box will be saved to the file, so 
changes here also affect any other program that is using the same file.
TIP: The name of the signature file for the Eudora email program is SIGNATUR.PCE, and it is stored 
in the directory where you installed Eudora.

Browse
Press this button to browse for a signature file.

See Also:
How to Post Usenet Messages
How to Send Email



Signatures
A signature is one or more lines of text that Agent automatically places at the bottom of messages you 
send.    You can define as many signatures as you wish.    When you create a new message, you can 
select which signature to use with that message.    For example, you can define a "personal" signature 
and a different "business" signature.



Manually Decode Binary Attachment dialog box (File menu)
Use this dialog box to manually decode an attachment when Agent can't automatically find all the 
messages composing the attachment.    For more information on retrieving attachments, see How to 
Retrieve a Binary Attachment.

Messages
This is a list of all the messages you selected before opening the dialog box.    If this list does not 
contain all the messages in the attachment, press Cancel and select the remaining messages by 
holding down the Control key and clicking on them.    If the messages are out of order, press the Up 
and Down buttons to get them in order.

Up / Down
Press these buttons to move the highlighted message up or down in the list.    Before launching or 
saving an attachment, you must make sure that the messages are in the correct order.

Launch
Press this button to view the attachment.    Agent first saves the attachment (see below for more 
information) and then passes it to the application associated with the attachment's file type.    For 
more information, see How to Configure a GIF or JPG Viewer to Work with Agent.

Save
Press this button to save the attachment as a file.    Agent saves the attachment in the directory 
specified in the Attachments tab of the Properties for Selected Groups dialog box.

If you are offline and have not yet retrieved the attachment's messages, Agent will immediately go online 
to download and decode the attachment after you press Launch or Save.



View Empty Group dialog box
This dialog box is displayed when you double-click or press Enter on a newsgroup with no messages and 
your View Empty Group Action in the Retrieving tab of the Properties for Selected Groups dialog box is 
set to "Prompt for action."

Sample <##> Message Headers
Press this button to retrieve whatever the maximum number of message headers has been defined 
for this group.    Note: The number you see may not be 50.    The sample size is defined in your 
Default Properties for All Groups dialog box on the Retrieving tab.

Get All Message Headers
Press this button to retrieve all message headers in this group.

Subscribe to Group
Press this button to subscribe to the group.    You can retrieve message headers later by choosing Get
New Message Headers in Subscribed Group from the Online menu.

See Also:
Online Menu Commands Explained



Select Signature File dialog box (Signatures dialog box, Options menu)
Use this dialog box to find a signature file on your hard disk.

File Name
Enter the name of the signature file, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.



Save Attachment File dialog box (View Binary Attachment dialog box, File menu)
This dlg is obsolete.
Use this dialog box to save an attachment as a file.

File Name
Enter the name of the file. 

Directories
Select the directory where you want to save the file. 

List of File Types
Select the type of file you want to save the attachment as.

Drives
Select the drive where you want to save the file.



Attach Binary File dialog box (Compose window)
Use this dialog box to attach a binary file to a message.    Agent will automatically uuencode the file for 
you.    Note: If you want to insert a text file into the message, choose Insert Text File from the File menu 
instead.

File Name
Enter the name of the file to attach, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.

See Also:
How to Post Usenet Messages
How to Send Email



Insert Text File dialog box (File menu)
Use this dialog box to insert a text file into a message.

File Name
Enter the name of the file to insert, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.

See Also:
How to Post Usenet Messages
How to Send Email



Compose Usenet Message window (Post menu)
Use this window to create a message to post in a newsgroup.    For more information, see How to Post 
Usenet Messages.

Newsgroups
Enter the name of the newsgroup you wish to post to.    To post the same message on multiple groups
(cross-post), enter the names of all the groups separated by commas (e.g., alt.usenet.offline-
reader,alt.winsock).

Subject
Enter a brief phrase describing the message.

Email To
(Optional) Enter the email addresses of people you wish to send copies of your posting to.    If you are
posting a follow-up message and want to email a copy of your posting to the original message's 
author, select his/her email address from the drop-down list.    If the recipient is in your address book, 
you can simply enter any word in his/her name and Agent will fill in the complete email address when 
transmitting the message to the Internet.
To send an email to more than one person, enter all the email addresses or names separated by 
commas (e.g., john.doe@forteinc.com,jane.doe@forteinc.com).
Note: If you usually copy the original message's author when posting follow-ups, check the "Copy 
follow-up messages to author via email" box on the Posting tab of the Default Properties for All 
Groups dialog box to initialize this field accordingly.

Pick Address Button    
Press this button to open the Pick Addresses dialog box where you can quickly select the people to 
whom you want to send the message. 

Attachment
(Optional) Enter the name of the file to attach to the message or press the Attachment button to 
browse for the file.    For more information, see How to Send a Binary Attachment.

All Fields
Press this button to hide the list of message fields which appear under Fields (see below).    Press this
button again to show the extra fields.

Fields
This is a list of all the fields that apply to the message.    See Message Fields for a description of each
field.    To change a particular field's value, highlight the field and enter the value in the "Value for 
<Field>" control below.    If a field has "Default" next to it, it's using the default value defined on the 
Posting tab of the Properties for Selected Groups dialog box.

Value for <Field>
The desired value for the field selected above.    If you change a field's value and later decide to revert
back to its default value, check the Use Default box to the right of this control.

Use Default
Check this box if you wish to use the default value that has been defined for any of the Fields above.   
The default values are defined on the Posting tab of the Default Properties for All Groups dialog box.   
Checking this box can be helpful if you change the value for a field and later decide that you want to 
revert back to its default value.

Signature
Select the signature to place at the bottom of this message.    Choose "[None]" if you don't want a 
signature added to the message.    You can view, modify, or create signatures with the Signatures 
dialog box.    You can also define a different default signature for each group with the Posting tab of 
the Properties for Selected Groups dialog box.
Note: Agent does not display your signature in this window.    It will add the signature to the message 
when transmitting it to the Internet.



Filing
Select the folder in which to file the message.    Choose "[Leave in Outbox]" to save the message in 
your Outbox or choose "[Delete]" to have Agent delete the message after sending it.

Send Now
Press this button to immediately transmit your message to the Internet.    This button appears dim 
when the Newsgroups field is blank.

Send Later
Press this button if you use Agent offline and you have other messages you want to send.    This 
button appears dim when the Newsgroups field is blank.
Once you have composed all your messages, select Post Usenet and Email Messages from the 
Online menu to transmit them to the Internet.    Note: Agent does not make a copy of the attached file 
prior to sending it.    If you press Send Later, make sure that the file stays around until you transmit the
message.

Save
Press this button to save your message without sending it.    The message will appear in your Outbox. 
To view your Outbox, choose Open Outbox from the Window menu.    You can double-click the 
message in the Outbox to edit and/or send it.

See Also:
How to Send Email
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created
Message Text Display Options 
How to Use the Address Book 
About Agent's Dictionaries. 
ROT13 Encoding and Decoding



Compose Email Message window (Post menu)
Use this window to create an email.    For more information, see How to Send Email.

To
Enter the recipient's email address.    If the recipient is in your address book, you can simply enter any
word in his/her name and Agent will fill in the complete email address when transmitting the message 
to the Internet.
To send the same email to more than one person, enter all the email addresses or names separated 
by commas (e.g., john.doe@forteinc.com,jane.doe@forteinc.com).

Pick Address Button    
Press this button to open the Pick Addresses dialog box where you can quickly select the people to 
whom you want to send the message.

Subject
Enter a brief phrase describing the message.

Cc
Enter the email addresses (separated by commas) of people to receive a copy of the message.    If 
this field already has any address(es) in it, you will notice that the Use Default box is checked.    (See 
below.)

Use Default
Check this box if you wish to use the default value for the Cc field defined on the Posting tab of the 
Default Properties for All Groups dialog box.    Checking this box can be helpful if you have change 
the value for a field and later decide that you want to revert back to its default value.

Attachment
(Optional) Enter the name of the file to attach to the email or press the Attachment button to browse 
for the file.    For more information, see How to Send a Binary Attachment.

All Fields
Press this button to hide the list of message fields which appear under Fields (see below).    Press this
button again to show the extra fields.

Fields
This is a list of all the fields that apply to the message.    See Message Fields for a description of each
field.    To change a particular field's value, highlight the field and enter the value in the "Value for 
<Field>" control below.    If a field has "Default" next to it, it's using the default value for that field.    
(See Use Default below.)

Value for <Field>
Enter the desired value for the field selected above.

Use Default
Check this box if you wish to use the default value that has been defined for any of the Fields above.   
The default values are defined on the Posting tab of the Default Properties for All Groups dialog box.   
Checking this box can be helpful if you change the value for a field and later decide that you want to 
revert back to its default value.

Signature
Select the signature to place at the bottom of this message.    Choose "[None]" if you don't want a 
signature added to the message.    You can view, modify, or create signatures with the Signatures 
dialog box.
Note: Agent does not display your signature in this window.    It will add the signature to the message 
when transmitting it to the Internet. 

Filing
Select the folder in which to file the message.    Choose "[Leave in Outbox]" to save the message in 
your Outbox or choose "[Delete]" to have Agent delete the message after sending it.



Send Now
Press this button to immediately transmit your message to the Internet.    This button appears dim 
when the To field is blank.

Send Later
Press this button if you use Agent offline and you have other messages you want to send.    This 
button appears dim when the To field is blank.
Once you have composed all your messages, select Post Usenet and Email Messages from the 
Online menu to transmit them to the Internet.    Note: Agent does not make a copy of the attached file 
prior to sending it.    If you press Send Later, make sure that the file stays around until you transmit the
message.

Save
Press this button to save your email without sending it.    The message will appear in your Outbox.    
To view your Outbox, choose Open Outbox from the Window menu.    You can double-click the 
message in the Outbox to edit and/or send it.

See Also:
How to Post Usenet Messages 
How to Receive Email
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created
Message Text Display Options 
How to Use the Address Book 
About Agent's Dictionaries. 
ROT13 Encoding and Decoding



Reply to All command (Post menu)
When checked, Agent opens a reply composition window (Re: <message title>).    The To:, Cc:, and Bcc: 
fields are automatically filled in with all names from the message to which you are replying.

See Also:
Address Book window.



Message Fields
The following table describes the various fields available to you when composing messages.

Field Description
Bcc A list of email addresses (separated by commas) of people to receive a copy of the 

message without the primary recipients (the ones listed in the To and Cc fields) 
knowledge.    If you enter a value for this field when posting a message, it will cause 
Agent to also post an email message to the specified recipients. 

Cc A list of email addresses (separated by commas) of people to receive a copy of the 
message.    If you enter a value for this field when posting a message, it will cause Agent 
to also post an email message to the specified recipients.

Distribution (Usenet messages only) This field is used to alter the distribution scope of the message.   
It is a comma separated list similar to the "Newsgroups" field.    User subscriptions are still
controlled by "Newsgroups", but the message is sent to all systems subscribing to the 
newsgroups on the "Distribution" line in addition to the "Newsgroups" field.    For the 
message to be transmitted, the receiving site must normally receive one of the specified 
newsgroups AND must receive one of the specified distributions.    Thus, a message 
concerning a car for sale in New Jersey might have headers including:

Newsgroups: rec.auto,misc.forsale
Distribution: nj,ny

so that it would only go to persons subscribing to rec.auto or misc. for sale within New 
Jersey or New York.    The intent of this header is to restrict the distribution of a 
newsgroup further, not to increase it.    A local newsgroup, such as nj.crazy-eddie, will 
probably not be propagated by hosts outside New Jersey that do not show such a 
newsgroup as valid.    A follow-up message should default to the same "Distribution" line 
as the original message, but the user can change it to a more limited one, or escalate the 
distribution if it was originally restricted and a more widely distributed reply is appropriate.

Expires (Usenet messages only) The date you want the message to expire. 

Followup-To (Usenet messages only) The newsgroups where you want follow-up messages posted.     
Note: You can set this field to "poster" to force users to post email replies to you.

From The email address and optional full name of the person who posted the message or sent 
the email. 

Keywords Optional keywords to help categorize the message or email message. 

Organization (Usenet messages only) Your organization, company, school, etc. 

Reply-To The email address where you want replies sent.    If you normally want replies sent to 
your From email address, you can leave this field blank. 

Sender The name of the entity responsible for submitting the message or email message to the 
network.    Normally, this field is blank, to indicate that the From field also names the 
submitting entity.    For example, if Rennie Mitchell is visiting George Mitchell and wishes 
to use his computer to post an email message, George would temporarily set his Sender 
field to his own email address and set the From field to Rennie's email address.    This 
indicates that the messages are being submitted by George on Rennie's behalf. 

Summary (Usenet messages only) An optional summary description of the message. 

See Also:
Compose Usenet Message window
Compose Email Message window
How to Post Usenet Messages
How to Send Email



Message Language dialog box (Message menu)
Language

Select the language you wish to use for the message being posted.



Spelling dialog box (Message menu)
Use this dialog box to check the spelling of your message before sending it.
To spell check the entire message:
· Make sure no text is highlighted in the message's body before starting the spell check.    Note: Agent 

only checks the body of the message for spelling errors.

To spell check only a portion of the message:
· Highlight the desired text before starting the spell check. 

Not in Dictionary / Repeated Word
This control shows the misspelled or repeated word.    The word will also be highlighted in the 
Compose window.    TIP: If you want to edit the word, click this box to copy it to the Change To box.

Change To
Enter the word's correct spelling or pick the correct spelling from the Suggestions list.    If you want to 
remove the word from the message, delete the text from this box and press the Delete button (which 
appears in place of the Change button when you delete all the text here).

Suggestions
This is a list of possible replacement words.    If the list is empty, press the Suggest button.    To have 
Agent automatically make suggestions, press the Options button and check the Always Suggest box.

Ignore
Press this button to leave the found word as-is and continue checking the message.    If you don't 
want Agent to flag this word again, press either the Ignore All or Add buttons (see below for a 
description).

Ignore All
Press this button to leave the found word and any other occurrences of it as-is.    Agent will not stop 
on this word again until you close the program and restart it or you press the Reset Ignore All button 
on the Spell Checking Options dialog box.    Note: Press Options to open the Spell Checking Options 
dialog box.

Start
Press this button to continue the spell check after editing the message.    Note: This button appears 
only after you edit the message.

Change / Delete
Press this button to replace the found word with the one in the Change To box.    Note: This button is 
labeled "Delete" when the Change To box is empty.

Change All / Delete All
Press this button to replace all occurrences of the found word with the word in the Change To box.    
Note: This button is labeled Delete All when the Change To box is empty.

Add
Press this button to add the found word to your custom dictionary.    For more information about your 
custom dictionary, see About Agent's Dictionaries.

Suggest
Press this button to fill the Suggestions box with a list of possible replacement words.    To have Agent
automatically make suggestions, press the Options button and check the Always Suggest box.    TIP: 
If you edit the Change To text, you can press this button to spell check the new word.

Options
Press this button to open the Spell Checking Options dialog box.    This dialog box allows you change 
the language dictionary, edit your custom dictionary, and modify other settings that affect how the 
spell checker behaves.



Spell Checking Options dialog box (Spelling dialog box, Message menu)
Use this dialog box to define various settings that affect how the Agent spell checker behaves.    Except 
where noted, changing a setting on this dialog box also changes it on the Languages tab of the General 
Preferences dialog box.

Language
Select the language dictionary to use while spell checking this message.    Note: Changing this setting
only affects the current message.    To specify a default language for all messages, pick the desired 
language from the Default Language list on the Spelling tab of the Posting Preferences dialog box 
(Options menu).    For more information, see About Agent's Dictionaries.

Always Suggest
Check this box to have the spell checker automatically suggest possible replacements words.

Check for repeated words
When checked, the spell checker will stop when it finds the same word twice in a row.

Words in UPPERCASE
Check this box to have the spell checker ignore words composed of all uppercase letters.

Words with numbers
Check this box to have the spell checker ignore words containing numbers.

Quoted lines
Check this box to have the spell checker ignore words which appear on lines beginning with a quote 
character (as defined by the Quoted Text setting on the Preferences dialog boxes' Display tab).

Reset Ignore All
When you press the Ignore All button during a spelling check, Agent adds the selected word to a 
temporary Ignore All dictionary so that it won't flag the word again.    Normally, this dictionary is 
cleared when you close Agent.    Press this button to immediately clear the Ignore All dictionary.

Custom Dictionary for...
The controls in this group allow you to add and remove words from your custom dictionary.    For more
information, see About Agent's Dictionaries.

To add a word to your custom dictionary:
1. Enter the word into the Edit box.
2. Press the Add button.

To remove a word from your custom dictionary:
1. Select the word from the list.
2. Press the Delete button.

To remove all the words from your custom dictionary:
· Press the Clear button. 



Posting Preferences dialog box (Options menu)
Spelling Tab
Use this dialog box to define various settings that affect how the Agent spell checker behaves.

Settings for Language
Select the language whose settings you want to change.    The remaining fields in this dialog box 
display the settings for the selected language.

Always Suggest
Check this box to have the spell checker automatically suggest possible replacements words.

Check for Repeated words
When checked, the spell checker will stop when it finds the same word twice in a row.

Words in UPPERCASE
Check this box to have the spell checker ignore words composed of all uppercase letters.

Words with Numbers and punctuation
Check this box to have the spell checker ignore words containing numbers.

Quoted lines
Check this box to have the spell checker ignore words which appear on lines beginning with a quote 
character (as defined by the Quoted Text setting on the Preferences dialog boxes' Display tab).

Reset Ignore All
When you press the Ignore All button during a spelling check, Agent adds the selected word to a 
temporary Ignore All dictionary so that it won't flag the word again.    Normally, this dictionary is 
cleared when you close Agent.    Press this button to immediately clear the Ignore All dictionary.

Custom Dictionary for...
The controls in this group allow you to add and remove words from your custom dictionary.    For more
information, see About Agent's Dictionaries.

To add a word to your custom dictionary:
1. Enter the word into the Edit box.
2. Press the Add button.

To remove a word from your custom dictionary:
1. Select the word from the list.
2. Press the Delete button.

To remove all the words from your custom dictionary:
1. Press the Clear button. 



Spell Checker Not Available
Forté Agent does not include a spell checker.    To add a spell checker plus lots of other features to your 
news reader, order Forté Agent today!!



Forté Agent Registration dialog box
This dialog box is displayed the first time you run Agent.    You must enter the registration key you 
received via email into the entry box.    If you have not received your registration key within 24 hours of 
placing your order, please send email to order-question@forteinc.com.
Since registration keys can be very long, you will probably want to copy it from your email program and 
paste it into this dialog box.
To paste the registration key from a standard Windows email program:
1. Highlight the registration key in the email message.    Be sure to highlight the entire key and nothing 

else in the message.
2. Choose Copy from the Edit menu to copy the key to the Clipboard.
3. Run Agent.
4. In this dialog box, click in the entry box and press Ctrl+V to paste the key.



Forté Agent Registration dialog box
This is the shrink-wrapped registration dialog box.



New Folder dialog box (Group menu)
Use this dialog box to create a new folder.

Folder Name
Enter the name for the new folder.    The name can be up to 255 characters.

See Also:
Filing Messages in Folders
Filing tab of the Inbound Mail dialog box



New Folder dialog box
Use this dialog box to create a folder for incoming email.    All your incoming mail will be saved in this 
folder.

Folder Name
Enter a name for the folder (up to 255 characters) where incoming mail will be saved.

See Also:
Filing Messages in Folders



Select Folder for Inbound Mail dialog box
Use this dialog box to select the folder in which you want incoming mail saved.

Folder
Select a folder for your incoming mail.

New Folder
Press this button to create a new folder for your incoming mail.

See Also:
Filing Messages in Folders
Filing tab of the Inbound Mail dialog box



Rename Folder dialog box (Group menu)
Use this dialog box to change an existing folder's name.

Old Name
This is the folder's original name.

New Name
Enter a new name for the folder.

See Also:
Filing Messages in Folders



Copy/Move Message to Folder dialog box (All Folders command, Message menu)
Use these dialog boxes to file a message into a folder that doesn't appear on your Copy/Move to Folder 
flyout menus.
Select all the messages you want to file before opening this dialog box.    If you select a collapsed thread, 
Agent will file all the messages in the thread.

Folders
Select the folder in which you want the messages filed.

Manage Menu
Press this button to open the Manage Folder Menus dialog box.

See Also:
Filing Messages in Folders
Filing tab of the Inbound Mail dialog box



Manage Folder Menus dialog box (Options menu)
Use this dialog box to pick which folders appear on your Copy to Folder and Move to Folder flyout menus 
(Message menu).

Folders
This is a list of all the folders that are not on your Copy/Move to Folder flyout menus.

Add
Press this button to include the folder highlighted in the Folders list on your Copy/Move to Folder 
flyout menus.    This folder will be inserted above the one selected in the Menu list.

Delete
Press this button to remove the folder highlighted in the Menu list from your Copy/Move to Folder 
flyout menus.

Menu
This is a list of the folders that appear on your Copy/Move to Folder flyout menus.    You can have no 
more than 9 folders on your flyout menus.

See Also:
Filing Messages in Folders



Inbound Email dialog box (Options menu)
System Profile Tab
This dialog box contains settings Agent uses when receiving email.    Use this tab to specify the name of 
your mail server and other information required to receive mail.    If you don't have all the information 
required to complete this dialog box, check with your service provider or system administrator.

Receive email with POP
Select this radio button if your incoming email is stored on a POP3 mail server.

POP Server
Enter the name of your POP3 mail server or its IP address.    E.g., mail.mycompany.com.

Account
Enter your account name for the POP Server above.    This is the name you use to log onto the mail 
server in order to receive messages.    E.g., GBrown.

Note: In some other email packages (Eudora, for instance), you enter the POP Server and POP Account 
together, separated by the "@" character.    E.g., GBrown@mail.mycompany.com.    In Agent, you enter 
these settings separately.

Remember password between sessions
Check this box and type your password into the box below to have Agent automatically enter your 
password when checking for new mail.    When this box is unchecked, Agent will prompt you for your 
password the first time it checks for new mail in each session.

Password
Enter your email account's password if you want Agent to automatically log onto your mail server 
when checking for new mail.    For security, your password appears as asterisks (*) and is stored in an
encrypted format in AGENT.INI.

Receive email with SMTP
Select this radio button if your incoming email is stored on an SMTP mail server.    If you receive from 
an SMTP server, Agent continually checks for new mail whenever you are online.

Load winsock on startup
Check this box if you want to connect to your service provider immediately upon loading 
Agent.    This option allows Agent to receive new mail whenever it is running and online, 
even if you are using another Internet program.
When the box is unchecked, Agent will receive email only when it is online doing 
something else, such as communicating with your news server or sending messages.

See Also:
How to Receive Email



Session
Each time you load Agent, you begin a new session.    The session ends when you close Agent.



Inbound Email dialog box (Options menu)
Checking for Mail Tab
This dialog box contains settings Agent uses when receiving email.    Use this tab to define how often 
Agent checks for new mail and what it does when it finds some.

Automatically check for email every...
Check this box if you want Agent to periodically check for new mail.    Enter the frequency of these 
automatic checks in the associated entry field.    Note: Agent must be loaded in order to check for new
mail.    If you receive mail from an SMTP server, this option is dim because Agent checks for new mail 
continually while online.

Check only when online
Select this option and Agent will check for new mail only if you are already online with your service 
provider.

Unload winsock (hang up) between checks
Select this option to have Agent hang up your modem after checking for new mail.

Leave winsock loaded between checks
Select this option to have Agent remain online after checking for new mail.

Leave messages on server
Check this box to prevent Agent from removing messages from your mail server after 
retrieving them.    Normally, Agent deletes messages from the server as they are 
retrieved.    This option is useful when you retrieve messages from the same email 
account with more than one computer.
Note: Once a message has been retrieved and left on the server, Agent will not retrieve 
the message again.    If you subsequently uncheck this box, Agent will delete all the old 
messages from the server the next time you check for new email.

Skip messages longer than...
Check this box to keep Agent from downloading long email messages.    In the associated 
entry field, enter the maximum size of messages Agent is allowed to retrieve.    When 
Agent encounters a message larger than the maximum size, it retrieves the first few lines
of the message (see "Maximum lines to sample" below) and leaves the entire message 
on the server.    Thereafter, as long as this setting is in effect, Agent will leave the 
message on the server and not retrieve it again.    To force Agent to retrieve the message 
in full, uncheck this box and it will be retrieved the next time you check for new mail.

Maximum lines to sample
Enter the number of lines to retrieve from messages larger than the maximum message size specified
above.

Display message box
Check this box to have Agent pop up a message when new mail is retrieved.

Play sound
Check this box to have Agent beep or, if you have a sound card installed or the PC Speaker driver 
loaded, play a WAV file when new mail is retrieved.    

WAV file
Enter the location of the WAV file to play when new mail is retrieved.    If you leave this field blank but 
check the Play Sound box, Agent will play the Email Receive sound defined in the Sound module of 
your Windows Control Panel.

Browse
Press this button to search for a WAV file to play when new mail is retrieved.

See Also:
Filing Messages in Folders





Inbound Email dialog box (Options menu)
Filing Tab
This dialog box contains settings Agent uses when receiving email.    Use this tab to define the folders in 
which Agent will automatically file new email messages.

Filters
This is a list of rules you define that controls where Agent files new mail.    When a new message is 
received, Agent checks all the filters in this list, starting at the top, and files the message in the folder 
specified by the first filter it matches.    The last filter in the list is always "[All other messages]."    This 
is a catch-all for messages that do not match any of the other filters.

Add
Press this button to create a new filter.

Edit
Press this button to edit the highlighted filter.

Delete
Press this button to remove the highlighted filter.    Note: You cannot delete the "[All other messages]" 
filter.

Up
Press this button to move the highlighted filter up one position in the Filters list.

Down
Press this button to move the highlighted filter down one position in the Filters list.

See Also:
Filing Messages in Folders



 Inbound Email dialog box (Options menu)
Attachments Tab
This dialog box contains settings Agent uses when receiving email.    Use this tab to define the directory 
where Agent saves binary attachments received in mail messages.

Automatically decode binary attachments
Check this box to have Agent automatically save binary attachments it detects in new email.    When 
this box is unchecked, you can decode binary attachments with the Decode Binary Attachments 
command on the File menu.

Directory
Enter the directory where you want Agent to save binary attachments decoded from mail messages.

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



Add/Edit Email Filter dialog box (Inbound Mail dialog box, Options menu)
Use this dialog box to define filter criteria for automatically routing new, incoming email messages into 
folders.    You manage these filters with the Filing tab of the Inbound Email dialog box.

Field to Search
Select the field Agent will examine to determine if the new message matches this filter.    For more 
information on these fields, see Message Fields.

Search For
Enter the text Agent will look for in the field specified above.    If Agent finds this text in the specified 
field, it will file the message in the folder selected below.

Case sensitive
Check this box if you want this filter to apply only when the message has the same combination of 
uppercase and lowercase letters that appear in the Search For text above.

Exact match
Check this box if you want this filter to apply only when the message completely matches the Search 
For text.    For example, when this box is checked, a message with "We all love Agent" would not 
match Search For text of "Agent".

Put in Folder
Select the folder in which messages that match this filter will be filed.

New Folder
Press this button to create a new folder.

See Also:
Filing Messages in Folders



Edit Email Filter dialog box (Inbound Mail dialog box, Options menu)
Use this dialog box to choose the folder where all new email messages which do not match any other 
filter criteria will be filed.

Put all messages...
Select the folder where you want new email messages filed by default.

New Folder
Press this button to create a new folder.

See Also:
Filing Messages in Folders



Import Messages dialog box (File menu)
Use this dialog box to import messages from another program into Agent.    For more information, see 
Importing Email Messages from Another Program.

File Name
Enter the name of the text file to import. 

Directories
Select the directory where the import file is located. 

List of File Types
Select the type of files you want to display in the list of files. 

Drives
Select the drive where the import file is located.

File according to inbound message filters
Select this option and Agent will use the email filters defined in the Filing tab of the Inbound Email 
dialog box to determine the folders in which to file the imported messages.    This option is dim if you 
have not yet opened the Inbound Email dialog box (Options menu) and designated a default inbound 
folder.

Put all messages in folder
Select this option and Agent will file all imported messages in the folder selected in the list on the 
right.

If a message contains an X-Folder field...
Check this box and Agent will file imported messages in the folders specified by the messages' X-
Folder field, overriding the other settings on this dialog box.

Automatically create folders
Check this box and Agent will create the folders specified by the messages' X-Folder fields as 
needed.    When this box is unchecked, imported messages with an X-Folder field specifying a folder 
that doesn't exist are filed according to the radio buttons above.

See Also:
Import Message File Format
Save Messages As dialog box



Import Addresses dialog box (File menu)
Use this dialog box to import addresses from another address book into the Agent address book.

Look in
Select the location of the import file. 

File Name
Enter the name of the text file to import.

Files of Type
Select the type of files you want to import from the list.

Replace existing entries that match new names
Check this box to have Agent automatically replace existing names in the address book with matching
names in the import file.

See Also:
Import/Export Address File Format
How to Use the Address Book



Export Addresses dialog box (File menu)
Use this dialog box to export addresses from an Agent address book to a file.

Save in
Select the location in which to save the export file.

File Name
Enter the name of the text file to export.

Save as type
Select the types of files you want to save as an export file.

See Also:
Import/Export Address File Format
How to Use the Address Book



Check Addresses dialog box
Use this dialog box to check the validity of an address that has been entered.    This dialog box may be 
seen in the following situations: when composing a message, when saving a message, and when creating
a new address book entry.

Problem Description
This field describes the problem with the address (i.e., Not a valid email address, Not in address 
book, Matches more than one entry, or Not a valid email address).

<text of the bad address>
This is the text in the address that Agent has determined is invalid.

Change To
Enter a replacement for the address in question.

Suggestions
If the name entered is ambiguous, this list of all matching address book entries appears.    Double-
clicking any of these names is the same as pressing the Change button (below).

Change
Press this button to change the address to the text in the "Change To" field, above.    Note: If you 
change an entry, Agent revalidates it and displays a message if the new entry is also invalid, giving 
you the option of accepting the new entry or canceling the change.

Leave As Is
Press this button to leave the address unchanged.

Convert to Local Address:
If you have just entered a local address and your server is set up to handle local addresses, press 
this button and the "@" character is appended to the name, forcing Agent to treat it as a local 
address.

Delete
Press this button to delete the address portion of the address book entry.    This does not delete the 
entry.

Cancel <Operation>
Press this button to have Agent cancel the operation that caused the dialog box to appear (checking, 
sending, or saving).

See Also:
How to Use the Address Book



Local addresses
Addresses that do not require a domain suffix (e.g., forteinc.com), because they are in the same domain 
(that is, they have the same service provider, which is set up to handle local addresses).
For example, Ginny might use the following addresses:
Local:    ginnyb
Full Internet:    ginnyb@forteinc.com



Find Address dialog box (Edit Menu when Address Book is open)
Use this dialog box to find addresses in the Agent address book.

Find What
Enter the text to search for.

Look in Names/Addresses/Comments
Check the boxes for the areas of the address book in which to search.    Note: You can check one, 
two, or all three boxes.

Find First
Press this button to find the first occurrence of the text you entered above.

Find Next
Press this button to find the next occurrence of the text you entered above.

See Also:
Finding Addresses
How to Use the Address Book



New Address dialog box
Use this dialog box to add new names and addresses to the Agent address book.    You can also use this 
dialog box to create mailing lists.

Name
Enter the name to add to the address book.    If you are creating a mailing list, enter a name for the 
mailing list, such as "Agent Beta Testers, U.S.".

Addresses
Enter the address associated with the name entered above.    If you are creating a mailing list, enter 
the addresses for each person on the list, separated by commas (e.g., 
john.doe@forte.com,amy.doe@forte.com).

Comments
(Optional) Enter a description of the person or group being added.

Field Text
(Optional) Enter the mailing list name that members of this list will see when they receive a message 
sent to members of that list.    When blank, everyone on the mailing list sees the email addresses of 
everyone else on the list.    When filled in, recipients see only this text.    For example, you might enter 
"Multiple recipients of list <multilists@forteinc.com>".    That is what the recipients will see in the To: 
field on the message they receive.    Note: The Field Text value should be a valid email address, since
it will appear in the message in a header field that is normally expected to contain a valid address.    
Some email systems may reject your message if it contains a field with an invalid email address.
TIP:    You may want to use the address to which recipients of your list should send replies.    For 
example:
My mailing list <reply-here@my.company.com>

See Also:
How to Use the Address Book
Adding People to the Address Book



Pick Address dialog box
Open this dialog box to select a name defined in the Agent address book and insert it into the "To:", "Cc:", 
or "Bcc:" fields on the message composition window (Usenet or email).

Names
The list of names defined in the address book.
TIP: You can type the first few letters of a name to rapidly skip to that name.

To
Press this button to insert the highlighted name(s) into the "To:" field on the composition window.

Cc
Press this button to insert the highlighted name(s) into the "Cc:" field on the composition window.

Bcc
Press this button to insert the highlighted name(s) into the "Bcc:" field on the composition window.

Find
Press this button to open the Find Address dialog box used to quickly search the address book for a 
desired name.

Edit
Press this button to open the address book, where you can edit the address for the selected entry in 
the Pick Address dialog box.    When the address book opens, the currently highlighted entry in the 
Pick Address window is highlighted in the address book.

Comments
The description for the highlighted name defined in the New Address dialog box.    This information is 
read-only.    To change it, you can press the Edit button to jump to the address book window.

Expand addresses
This option applies to Usenet and email messages you are sending.    Check this box to cause Agent 
to insert the actual email address(es) for an address book entry, rather than the name of the entry.    
For example, if you select the name amya from the address book, it will be inserted into the 
composition window in its expanded format, amya@forteinc.com.

See Also:
How to Use the Address Book
Finding Addresses



Rename Address dialog box (Address menu)
Use this dialog box to change the currently highlighted name in the Agent address book.

Old Name
The current address book name is displayed.

New Name
Enter the name with which you want to replace the "old name" in the address book.

See Also:
How to Use the Address Book



Paste as Quote command (Edit menu)
When text is pasted in the composition window using the Paste as Quote command, each line of the 
pasted text is prepended by the quoted text character string (defined on the Posting tab of the 
Preferences dialog box).    For example:

> Ask not what your country can do for you.
> Ask what you can do for your country.

By using this command, you can avoid cumbersome text editing when you want a block of inserted text to
appear as if it were quoted text.
This command can be useful when composing replies and forwarding text if you want to quote only 
portions of the text, not all of the text from the original message.



Address Book Window (Window menu)
Use this window to view and modify Agent's address book.    For more information, see Adding People to 
the Address Book.

Names
This is a list of all the entries in your address book.    Highlight a name in the list and you will see the 
email addresses or comments associated with an entry.
TIP: You can quickly find a name in this list by typing the first few letters of the name.    For example, 
typing "ji" will skip over "Jeanne" and select "Jim."

Addresses
This is a list of all addresses associated with the highlighted name.    Individuals should have only one
address in this box (if you have multiple addresses for a single person, you should create multiple 
address book entries).    Mailing lists (groups of people to whom you commonly send the same 
message) should include the email address of everyone on the list, each on a separate line, or with 
addresses separated by commas.

Comments
(Optional) Enter notes about the selected address book entry.

Field Text
(Optional) Enter the mailing list name that members of this list will see when they receive a message 
sent to members of that list.    When blank, everyone on the mailing list sees the email addresses of 
everyone else on the list.    When filled in, recipients see only this text.    For example, you might enter 
"Multiple recipients of list <multilists@forteinc.com>".    That is what the recipients will see in the To: 
field on the message they receive.    Note: The Field Text value should be a valid email address, since
it will appear in the message in a header field that is normally expected to contain a valid address.    
Some email systems may reject your message if it contains a field with an invalid email address.
TIP:    You may want to use the address to which recipients of your list should send replies.    For 
example:
My mailing list <reply-here@my.company.com>

See Also:
Adding People to the Address Book
How to Use the Address Book
How to Post Usenet Messages
How to Send Email
Confirm Edits
Confirm Deletes
Expand Addresses



Confirm Edits command (Address menu)
When checked, Agent prompts you before automatically saving address book changes.    Note: Address 
book changes are automatically saved when you select another entry or close the Address Book window.



Confirm Deletes command (Address menu)
When checked, Agent prompts you before deleting address book entries.

See Also:
Address Book window.



Expand Addresses command (Address menu)
This command applies to Usenet and email messages you are sending.    When checked, Agent 
automatically expands an address to its full address format, when it is inserted into the composition 
window via the Address Book or Pick Addresses window.    For example, if you select the name ginnyb 
from the address book, it will be inserted into the composition window in its expanded format, 
ginnyb@forteinc.com.

See Also:
Address Book window
Pick Address window
How to Use the Address Book



Add Usenet Filter dialog box
Open this dialog box to add a new kill or watch filter.    The default settings which appear in most of the 
fields are specified on the Filter tab of the Default Group Properties dialog box.

Search For
Enter the filter criteria on which you want Agent to search.    If a message header is selected in the 
Message List pane, Agent automatically inserts the selected message's subject or author into this 
field.

Paste Subject
If a message header is selected in the Message List pane, you may press this button to paste the 
selected message's subject into the Search For field.

Paste Author
If a message header is selected in the Message List pane, you may press this button to paste the 
selected message's author into the Search For field.    You can choose three different formats for the 
author's information; either the name of the author, the author's email address, or the entire field, 
which includes both the author's name and email address.

Kill Action
If you are creating a Kill filter, select the Kill action that you want Agent to perform.

Watch Action
If you are creating a Watch filter, select the Watch action that you want Agent to perform.

Scope
Select Global if you want the filter to apply to all groups, or select Group: <newsgroup> if you want 
the filter to apply only to the current group.

Priority
Enter the priority for this filter, between 0 (lowest) and 1000 (highest).    If a message matches more 
than one filter, the filter with the highest priority will be applied.

Expire this filter in
Check this box if you want this filter to be automatically deleted after the number of days specified.

Disable filter
Check this box to temporarily disable the filter.

Apply filters to group immediately
Check this box to apply all filters to the selected group when you add a new filter for that group.

See Also:
How to Create Kill and Watch Filters
Kill and Watch Filter Examples
Using Filter Expressions



Kill and Watch filters
These two types of filters make up a filtering mechanism that Agent uses each time you retrieve new 
headers.    Kill filters tell Agent to filter out messages with unwanted subjects or authors, and Watch filters 
tell Agent to keep track of messages with subjects or authors that interest you.
Filters for a specified group can be viewed and modified on the Usenet Filters window (Group | Usenet 
Filters).



Kill actions
There are three possible Kill actions:
· Skip - Agent will not retrieve the header at all.
· Mark Read - Agent will retrieve the header, but mark it read.
· Ignore - Agent will retrieve the header, but mark its thread Ignore .



Watch actions
There are four possible Watch actions:
· Retrieve body immediately - Agent will retrieve the message body immediately .
· Mark for later retrieval - Agent will mark the message for later retrieval .
· Watch - Agent will watch the entire thread.     This action also retrieves the body.
· Keep - Agent will cause the message to be marked keep , when this box is checked.



Usenet Filters window
This window contains the list of all kill and watch filters that apply to the current group.    For each filter 
listed, you will see the following information (starting from left to right):
· Status (the  icon indicates a disabled filter, and the  icon indicates a global filter)
· Priority (the higher-priority filters are processed first)
· Action (kill actions are red and watch actions are green)
· Search expression (message subject or author filter criteria)
Double-clicking any item on the list opens the Edit Usenet Filter dialog box.



Edit Usenet Filter dialog box
Open this dialog box to edit the highlighted kill or watch filter in the Usenet Filters window.    This dialog 
box is almost identical to the Add Usenet Filter dialog box.

Search For
Enter the subject or author information on which you want Agent to filter.

Kill Action
If you are editing a Kill filter, select the Kill action that you want Agent to perform.

Watch Action
If you are editing a Watch filter, select the Watch action that you want Agent to perform.

Scope
Select Global if you want the filter to apply to all groups, or select Group: <newsgroup> if you want 
the filter to apply only to the current group.

Priority
Enter a new priority value for the action selected above by entering a value between 0 (lowest) and 
1000 (highest).    The higher-priority values are tested first.

Expire this filter in
Check this box if you want to limit the number of days that this filter will be used, and enter the 
number of days that you want to use the filter.

Disable filter
Check this box to temporarily disable the filter.

See Also:
How to Create Kill and Watch Filters
Kill and Watch Filter Examples
Using Filter Expressions



Properties for Selected Groups dialog box (Group menu)
Filters Tab
Use this dialog box to define the initial settings that will appear in the Add Usenet Filters dialog box for the
selected group(s).
TIP:    If you highlight several groups before opening this dialog box, you will be changing the settings for 
all the selected groups at once.

Disable filtering for this group
Check this box to disable filtering for the selected group(s).

Override default settings
Check this box to use the settings defined on this tab instead of those defined on the Filters tab of the
Default Properties for All Groups dialog box.

Kill Action
Select the default Kill action for the selected group's filters.

Watch Action
Select the default Watch action for the selected group's filters.

Scope
Select Global if you want the filter to apply to all groups, or select Group: <newsgroup> if you want 
the filter to apply only to the current group.    This will be the initial setting that appears when adding a 
Usenet filter for the selected group(s).

Search For
Select whether you want Agent to search on the subject or author information, when evaluating filter 
criteria.

Kill Priority/Watch Priority
Enter the values for the selected Kill and Watch actions above.    This can be any value between 0 
and 1000.    Filters with higher priorities are applied first.

Expire this filter in
Check this box if you want to limit the number of days that this filter will be used, and enter the 
number of days that the filter will be valid.

See Also:
How to Create Kill and Watch Filters
Kill and Watch Filter Examples
Using Filter Expressions



Default Properties dialog box (Group menu)
Filters Tab
Use this dialog box to define your default group settings.    This tab controls the default settings which 
appear in the Add Usenet Filters dialog box.

Disable filtering for all groups
Check this box to disable filtering for all groups.

Kill Action
Select the default Kill action for your filters.

Watch Action
Select the default Watch action for your filters.

Scope
Select Global if you want the filter to apply to all groups, or select Group: <newsgroup> if you want 
the filter to apply only to the current group.

Search For
Select whether you want Agent to search on the subject or author information, when evaluating filter 
criteria.

Kill Priority/Watch Priority
Enter default priorities for kill and watch filters.    This can be any value between 0 (lowest) and 1000 
(highest).

Expire this filter in
Check this box if you want the filter to be automatically deleted after the number of days specified.

See Also:
How to Create Kill and Watch Filters
Kill and Watch Filter Examples
Using Filter Expressions



Find Filter dialog box (Edit menu)
Open this dialog box to find a filter in the Usenet Filters window.

Find What
Enter the text to search for.

Find First
Press this button to find the first occurrence of the text you entered above.

Find Next
Press this button to find the next occurrence of the text you entered above.

See Also:
Finding Filters



Select View dialog box (Filter menu)
Use this dialog box to select which filters will appear in the filter list.    Any combination of actions and 
scope may be selected.    You cannot select a view that is empty (i.e., at least one Action and one Scope 
below must always be selected).

Kill Actions
Check the box(es) for the Kill actions that you want to appear in the Usenet Filters window.

Watch Actions
Check the box(es) for the Watch actions that you want to appear in the Usenet Filters window.

Scope
Select which filters you want to view in the Usenet Filters window.    Select Global if you want to view 
only those filters which apply to all groups.    Select All group-specific filters if you want to view all non-
global filters.    If you want to view all filters for all groups, select both Global and All Groups.    Select 
Group if you want to view only filters which apply to the current group.

See Also:
How to Create Kill and Watch Filters
Kill and Watch Filter Examples
Using Filter Expressions



Add Kill Filter command
Select this command to add a kill filter to the Usenet Filters window.

See Also:
How to Create Kill and Watch Filters
Kill and Watch Filter Examples
Using Filter Expressions



Add Watch Filter command
Select this command to add a watch filter to the Usenet Filters window.

See Also:
How to Create Kill and Watch Filters
Kill and Watch Filter Examples
Using Filter Expressions



Confirm Delete command (Filter menu)
Select this command to confirm that the selected filter(s) was actually deleted from the Usenet Filters 
window.



Add Copy of Filter command (Filter menu)
Select this command to add a copy of the highlighted filter in the Usenet Filters window.    When you 
select this command, the Add Usenet Filter dialog box will appear with all fields set to the values in the 
highlighted filter.



Delete command (Filter menu)
Select this command to delete selected filters in the Usenet Filters window.



Edit command (Filter menu)
Select this command to edit selected filters in the Usenet Filters window.



Select View command (Filter menu)
This command allows you to change which filters are listed in the Usenet Filter window.

See Also:
Select View dialog box



Usenet Filters command (Group menu)
Select this command to open the Usenet Filters window.
Double-clicking any item on the list opens the Edit Usenet Filter dialog box.

See Also:
How to Create Kill and Watch Filters
Kill and Watch Filter Examples
Using Filter Expressions



Apply Usenet Filters (Group menu)
Select this command to apply all Usenet filters to all of the selected groups.

See Also:
How to Create Kill and Watch Filters
Kill and Watch Filter Examples
Using Filter Expressions



Build: 32 bit Agent:
NoFree:    No (Free Agent only topics)
YesOrder:    Yes (How to order Agent)
NoMSMain:    No (Newsreader Contents Graphic)
NoCRight:    No (Microsoft's copyright page statement)
NoFreeTech:    No (Free Agent Tech Support info)
YesMail:    Yes (Receive email topics)
YesFolders:    Yes (All aspects of folders)
YesAddBook:    Yes (Address Book topics)
YesSpelling:    Yes (Spell check topics)
YesSorting:    Yes (Sorting topics)
YesBit32:    Yes (Features only available in the 32bit version)
Forté AgentFullName:    Forté Agent (The long name of the program)
AgentName:    Agent (The short name of the program)
agentLcName:    agent (The lowercase short name of the program)



How to Use Agent
Before you start using Agent, please take a quick look at Getting Started.

Once you're up and running, check out the topics below for more help using Agent.

How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader

How to Receive Email
Importing Email Messages from Another Program

How to Post Usenet Messages
How to Send Email
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created

Adding People to the Address Book
How to Use the Address Book
Filing Messages in Folders
About Message Sorting

How to Create Kill and Watch Filters 
Kill and Watch Filter Examples 
Using Filter Expressions

How to Send a Binary Attachment
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent

Online Menu Commands Explained

About Usenet Message Purging
Compacting Agent's Database Files
Marking Messages Read

Navigating in Agent
Watching and Ignoring Threads
Message Text Display Options

ROT13 Encoding and Decoding
Copying a WWW URL to the Clipboard
How to Get All the Message Bodies in a Newsgroup
Printing Messages
Finding Groups and Folders
Finding Messages
Finding Filters
Finding Addresses

Frequently Asked Questions



Frequently Asked Questions
This topic answers some of the most common questions users have about Agent.

Can I run multiple copies of Agent
How to configure Agent for multiple users
Agent forgets settings or loses all its data
Pressing (M)ark or (I)gnore causes Agent to jump around
Errors reported by the news server
Errors reported by Winsock
Pressing any buttons while offline causes Agent to hang
Headers/Messages are marked as read after performing an online task
How to re-send a failed message
Agent failed to decode a binary file
Expand Threads doesn't always work
How to restore a deleted group
What is the Log window



Log Window (Window menu)
Agent's Log window is for debugging problems with Agent, Winsock, and your servers.    Under normal 
circumstances, you should never have to open it.



Can I run multiple copies of Agent?
Agent will allow multiple instances of itself to run, provided each instance is using a different directory.    If 
you try an instance of Agent on a directory that is already in use, it switches the focus to the already-
running instance and exits.

Running multiple instances of Agent is useful if, for example, you wish to have two separate 
configurations of Agent, one for email and one for Usenet, each in its own startup directory.



How to configure Agent for multiple users
Agent stores its settings and data files in the working directory specified by its Program Manager icon.    
This allows you to easily share a single copy of the program's executable files (i.e., agent.exe and 
agent.hlp) among several users.

To setup Agent for multiple users:
1. Create a directory for the program files (e.g., c:\agent).
2. Create a personal directory for each user (e.g., c:\agent\his and c:\agent\hers).
3. Create a Program Manager icon for each user with the Command Line pointing to the program itself 

(e.g., c:\agent\agent.exe) and the Working Directory pointing to the user's personal directory 
(e.g., c:\agent\his and c:\agent\hers).



Agent forgets settings or loses all its data
Agent expects to find its setting and data files in the directory in which it runs.    If it can't find them, it 
assumes it is being run for the first time and displays the license screen. It will also "forget" any 
preferences, properties, and subscribed groups you have saved.

To correct this problem, select (single click) the Agent icon on your Program Manager desktop.    On the 
Program Manager menu, select Properties from the File menu.    You will be presented with the Program 
Item Properties dialog box.    Make sure the Working Directory is set to the directory where Agent stored 
its data files (usually the same directory where Agent is installed).

If you run Agent from a program that doesn't allow you to specify the working directory, you can pass this 
information to Agent on its command line.    For example, the command to run Agent may look like this:

c:\agent\agent.exe c:\agent



Pressing (M)ark or (I)gnore causes Agent to jump around
Agent automatically skips to the next unread message when you mark a message for retrieval or ignore a 
thread.    If you don't like this behavior, you can disable it from the Navigation tab of the Preferences 
dialog box by unchecking the "Marking or ignoring a message skips to the next unread message" box.



Errors reported by the news server
This topic will help you track down errors reported by your news server and detected by Agent.
441 400 Bad file number Writing history file - Throttling
441 400 loadav [innwatch.load] 305 gt 300
441 Can't send connect request to server, No such File or Directory

These errors all mean that the news server has an internal problem unrelated to anything you are 
doing.    Contact your service provider to have it fixed.    When this happens, Agent saves the 
message you were trying to post in its Outbox    (Window | Open Outbox), so that you can try to send 
it again later, after your news server is working properly.

441 Can't generate Message-ID Error 0
The error is generated internally by the server if either the server is unable to obtain the current date 
and time (from itself), or if it is unable to find out its own host name.    All of this happens after Agent 
has posted the message to the server.    We recommend that you contact your service provider and 
tell them about the error, since it indicates a problem with their server.

441 Posted in the Future
This error means the date/time on the message, as sent by Agent, is more than 24 hours later than 
the current date/time on the news server.    You should double-check your PC's date and time. 

480 Authentication required for command error trying to post
This error means that your news server requires you to provide authentication before you can post.    
You need to check with your service provider to find out exactly what is required.    In most cases, you 
need to supply the server a user name and password.    Once you get this information from your 
provider, you can enter it on the User tab of the Preferences dialog box.

500 Command not Recognized
Your news server is not configured to handle a command issued by Agent (usually the XOVER or the 
XHDR commands for retrieving information about messages). Agent requires that the server accept 
one of these commands.    You will need to contact your service provider and see if they can provide a
server that honors these commands.

500 Error trying to connect to server
This error    means that Agent is attempting to log you into your news server, but your server doesn't 
actually require a login.    Go to the User tab of the Preferences dialog box and uncheck the "Server 
requires authorization login" box.

502 Authentication Error
Check to see if your news server really requires authentication.    If it doesn't or if you are not sure, 
open the Preferences dialog box (Options menu), go to the User tab, and uncheck the "Server 
requires authorization login" option.    If you know that your server does require authentication, 
double-check your User Name and Password on this dialog box.

502 You are not in my access file
502 You only have permission to transfer
502 You have no permission to talk

These all indicate that you are not properly set up as an authorized user of the news server.    You will 
have to contact your service provider or news administrator to get this corrected.

550 Addressee unknown
Usually, this means you tried to send an email to someone whose email address was unknown to the 
email server, and the server refused to try to forward the mail to another server.



Errors reported by Winsock
This topic will help you track down errors reported by your Winsock driver and detected by Agent.
10055 WSAENOBUFS

There is not enough memory available for WINSOCK.DLL to create any buffers for Agent.    The 
problem is with low memory (memory below 640k), not overall memory.    Try to free up more 
conventional memory.

10060 WSAETIMEOUT
This may be a case where Agent loads the WINSOCK.DLL, but the winsock driver fails to load.    Try 
loading the driver prior to Agent.    If this works, then make sure the winsock driver is in the DOS path. 
You may also need to free more conventional memory.

10061 Connection refused by server
This error means that the server is either too busy to accept more connections, or possibly has been 
taken down for maintenance.

11004 Host Name not Found
This error means that the Winsock driver was unable to find the host name for your news (NNTP) or 
mail (SMTP) server.    Double-check the name of these servers in the System tab of the Preferences 
dialog box.    Usually, they will be something like "news.company.com" and "mail.company.com", 
where "company.com" is your provider's domain name.    As a workaround, try entering the numeric 
(IP) address for the servers.

11004 No Data of Requested type
An error occurred during initialization of the Winsock driver. Check your Winsock driver setup.



Pressing any buttons while offline causes Agent to hang
Agent is designed to make online and offline newsreading as convenient as possible.    When configured 
for offline use it will automatically connect to your service provider when it needs to go online and 
disconnect as soon as it is through.    To make this process as efficient as possible, you should have only 
one copy of the file WINSOCK.DLL on your drive.    Also, it's best to keep all of the Winsock files (e.g., 
WINSOCK.DLL, TCPMAN.EXE, etc.) in the same directory, and to make sure that this directory is in the 
PATH= statement of your AUTOEXEC.BAT file.



Headers/Messages are marked as read after performing an online task
By default, Agent automatically marks unwanted messages read whenever you retrieve message headers
or bodies.    This makes it easy for you to find the new messages because they will be the only ones that 
are unread. To change this behavior, uncheck the appropriate box on the Marking Read tab of the Default 
Properties for All Groups dialog box.



How to re-send a failed message
By default, whenever you post a Usenet message or send an email, Agent saves it in the Outbox. This 
means that if the post fails for any reason, the message is still there and you can try to post it again. To do
this, select the Post Usenet and Email Messages from the Online menu.

See Also:
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created



Agent failed to decode a binary file
Agent finds the sections of a binary file by searching for messages with identical subject lines, except for 
the "[n/m]" or "n of m" part.    If it finds all the parts, it uses the [n/m] to figure out how to sort them.    In 
most cases, this method works quite well, because most users who post binaries use automated tools 
(like Agent) that conform to this convention.    But, when some users post binaries, they assign a different 
subject line to each message.    When this happens, Agent cannot find all the sections automatically.

The message "Unable to locate any sections" means you selected the [0/m] message, which 
technically isn't part of the binary, and Agent was not able to find messages [1/m] through [m/m].

The message "Only able to locate x of m sections" means that you selected one of the [n/m] sections, 
but Agent couldn't find all of the other m sections.

The message "No binary attachment found" means the binary may have been posted using an 
encoding scheme other than uuencoding. In this case, retrieve the messages as normal message bodies,
then export the file to text using the Save Message As command from the File menu. The file can then be 
decoded using one of the widely available decoding programs such as Wincode or UDEC.

See Also:
How to Retrieve a Binary Attachment



Expand Threads doesn't always work
There are two options on the Message List tab of the Preferences dialog box (Options menu) that 
determine whether threads are displayed in expanded or collapsed form:

· Show threads initially Collapsed
When checked, all threads will be shown collapsed when you first open a newsgroup. When 
unchecked, they will all be shown expanded.

· Automatically expand threads containing new messages
When checked, threads will be expanded when you jump into them with the Skip to/View Next Unread
Message commands.    Note: They are expanded only if you've already retrieved and read the first 
message in the thread.



How to restore a deleted group
Select Refresh Groups List from the Online menu.    This will rebuild your groups list without affecting the 
unread counters for your remaining groups.    You won't lose any information by performing this action.

See Also:
Delete Group Command



Copyrights
Free Agent and Agent are trademarks and Forté is a registered trademark of Forté Advanced 
Management Software Inc.    Copyright © Forté 1996.
The Sentry Spelling-Checker Engine -- Copyright © Wintertree Software Inc.

Eudoraä is a trademark of the University of Illinois Board of Trustees, licensed to QUALCOMM Inc.
Microsoft is a registered trademark and Explorer, MS-DOS, and Windows are trademarks of Microsoft 
Corporation.

Netscape is a trademark of Netscape Communications Corporation.

Pegasus is a trademark of David Harris, all rights reserved.

PKZIP is a trademark of PKWARE Inc.



TBD - Agent Icons
The following table describes what the icons appearing next to groups and messages represent:

Icon Meaning

The message is in the process of being retrieved.



How to Receive Technical Support
Forté does not provide direct technical support to Forté Agent users.    You can, however, receive help 
with the program from other users by posting your question in one of the following newsgroups:

· alt.usenet.offline-reader.forte-agent
· comp.os.ms-windows.apps.winsock.news
· WINCON (CompuServe forum)
Information about the latest Agent release and answers to the most frequently asked questions can be 
found on Forté's Web site at http://www.forteinc.com.    For those without convenient Web access, 
we've prepared a downloadable file containing the text (in HTML format) of our web pages.    You can find 
this file on Forté's FTP site at ftp.forteinc.com/pub/support.zip.

Note: If you find a bug in the program, you can still contact Forté via email to:
agent-bugs@forteinc.com
See Also:
Frequently Asked Questions



How to Receive Technical Support
Agent users are entitled to 90 days of technical support via email.    If you're having a problem using 
Agent, you can send us an email by choosing Support Question from the Post menu.    This option will 
start a properly addressed and formatted message for your question.    If, for some reason, you cannot 
post messages from Agent, send your question to agent-support@forteinc.com.    Be sure to 
include your serial number in the email if you do not send it from Agent.    The serial number can be found 
on the About Agent screen accessible from the Help menu.

If you have a site-based version of Agent, the Support Question menu option is not present.    Please 
contact your system administrator if you are having problems.

Information about the latest Agent release and answers to the most frequently asked questions can be 
found on our Web site at http://www.forteinc.com.    For those without convenient Web access, we 
have prepared a downloadable file containing the text (in HTML format) of our web pages.    You can find 
this file on our FTP site at ftp.forteinc.com/pub/support.zip.

You can also receive support through various newsgroups.

· alt.usenet.offline-reader.forte-agent
· comp.os.ms-windows.apps.winsock.news
· WINCON (CompuServe forum)
See Also:
Frequently Asked Questions



Agent Features
Forté's commercial newsreader, Agent 1.0 will include all the functionality of Forté Agent plus the features 
described below:
Note:    Most of these features have been implemented and the remaining features will be released when 
they are ready.

Spell Checker
100,000+ word dictionary with language specific dictionaries available.    Custom dictionary for adding 
your own words.

Folders
Store messages in user-defined folders.

Kill Lists
Automatically ignore messages based on the subject or author. 

Watch Lists
Automatically retrieve messages based on the subject or author. 

Sorting
Display messages in various orders.    E.g., By author or date. 

Filtering
Show only a subset of the messages.    E.g., Show only unread messages. 

Launch URL's
Automatically run your WWW browser or FTP program when you find an interesting URL (e.g., 
<http://www.forteinc.com/>) in a message. 

Read/Write newsrc Files
Support the use of multiple newsreaders (e.g., one at home and another one at work).    Keeps track 
of which messages have been read by both programs. 

Enhanced cross-post management
Reading a cross-posted message in one group marks it read in all other groups. 

Customizable toolbar
Choose which commands appear on the toolbar. 

Advanced Group Searching
Filter the Group Pane to only show groups with specific text in the group's name. 

International Character Support
Display characters from various languages in messages using the standard MIME format. 

MAPI Support
Integrate Agent email with the corporate email system.

Receive Email
Receive email from POP and SMTP mail servers. 

Support for MIME Attachments
Encode and decode attachments using the email standard MIME format. 

Address Book
Keep track of people's email addresses and various other information.

For more information on Agent's features, see Forté's home page at <http://www.forteinc.com>.    
To purchase your own copy of Agent, see Ordering Agent. 



Ordering Agent
Forté is offering a pre-release version of Agent, called Agent .99, to individuals who wish to purchase our 
commercial newsreader product.    Agent .99 is available in both 16-bit and 32-bit versions, and includes 
all the features of Free Agent plus a multilingual spelling checker, basic email, address book, folders, and 
sorting plus free technical support, via email, until 90 days after the release of Agent 1.0.    Note:    Forté 
does not provide telephone support to individual customers.    By purchasing Agent .99 now, you will also 
receive a free upgrade to Agent 1.0 when it's    available.

You can purchase Agent .99 in any of the following ways:

1. Through the World Wide Web.    This is the fastest and easiest way to get Agent.    Forté's ordering 
page is on a secure Netscape Commerce Server, ensuring that your confidential information remains 
confidential.    For details on ordering Agent through the Web, please see our home page at 
<http://www.forteinc.com>.

2. If you don't have convenient Web access, the next best way to order Agent is by fax or mail.    Simply 
print out and complete the Agent Order Form and either fax it to Forté's Agent Order Desk in 
Carlsbad, California at 619.431.6497 or mail it to:

Agent .99
c/o Forté
2141 Palomar Airport Road
Suite 100
Carlsbad, CA 92009

3. Company Purchase Orders.    For information on purchasing Agent for your company, send an email 
message to agent-sales@forteinc.com.    Please note that the minimum order quantity for Purchase 
Orders is 10 units.

4. If neither of the above methods are suitable, you can call the Agent Order Hotline at 619.431.6496.    
The Hotline is open from Monday to Friday, 8:00 a.m. - 5:00 p.m. Pacific time.    Please note that this 
Hotline is for placing Agent orders only, and we cannot provide technical support via telephone.



How to Send a Binary Attachment
Attaching files to messages is quick and easy with Agent.    Since the Internet only supports text 
messages, Agent automatically translates all non-text attachments to a standard text-based format.    
Follow the steps below to attach a file to a message:

1. Create a new message.
Select one of the options on the Post menu to create the message.    Click here for more help sending
Usenet messages and email.

2. Attach the desired file.
Press the Attachment button to browse for the file, or type the file's name directly into the Attachment 
box.    You can control your attachment options with the Attachments tab on the Preferences dialog 
box.

3. Add a text message (optional).
You can include a message along with the attachment.    The message appears before the 
attachment. If you include a message, Agent also includes your signature.

4. Send the message.
If you use Agent online, press Send Now to immediately transmit your message to the Internet. 
If you use Agent offline and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Usenet and Email Messages from the Online 
menu to transmit them to the Internet.
Note: Agent does not make a copy of the attached file prior to sending it.    If you press Send Later, 
make sure that the file stays around until you transmit it.

See Also:
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created



How to Retrieve a Binary Attachment
Many newsgroups are devoted to the distribution of binary files, typically pictures and sounds.    These 
binary files are posted as text attachments to one or more messages.    Agent makes quick work of 
translating the text attachments into their binary equivalent.

To retrieve an attachment:
1. Select any message in the attachment.    In most cases, Agent will be able to find all the messages 

which compose the attachment.    If it can't, usually because the attachment was not posted in one of 
the standard ways (see How Agent finds all the parts of an attachment), follow the steps under "To 
manually decode a binary attachment" below. 
If you select messages from more than one attachment, Agent will retrieve all the attachments that 
have any messages selected. 

2. Retrieve and/or view the attachment.    Choose either Decode Binary Attachments or Launch Binary 
Attachments from the File menu.    Agent saves all attachments in the directory entered in the 
Attachments tab of the Properties for Selected Groups dialog box.

If you are configured for online use (see the Online tab of the Preferences dialog box for details), 
Agent will immediately begin downloading and decoding the attachment.    Also, if you selected the 
Launch option, once the file has been saved, Agent will run the Windows application associated with 
the attachment's file type (see below). 
If you are configured for offline use, Agent will mark all parts of the attachment for retrieval.    The next 
time you select Get Marked Message Bodies from the Online menu, Agent will download and decode 
the selected attachments (but not automatically launch them). 

Occasionally, you may find multi-part attachments whose subject lines do not match standard convention 
(e.g., they don't include the typical [1/2], [2/2] notation).    To decode such files, you must tell Agent about 
all of the attachments components.

To manually decode a binary attachment:
1. Select all the messages that contain the attachment by clicking on one message and then, with the 

Control key pressed, clicking on the remaining messages.
2. Choose Manually Decode Binary Attachment from the File menu.
3. Make sure the messages are in order.    If they are not, use the Up and Down buttons in the Manually 

Decode Binary Attachment dialog box to order them.
4. Launch or save the attachment by pressing the corresponding button.    If you are offline and have not

yet retrieved the attachment's messages, Agent will immediately go online to download and decode 
the attachment.

Once an attachment is retrieved, the Binary Message icon  appears next to all the messages in the 
attachment.    To view the attachment, simply double-click or press Enter on any one of its messages.    
This causes Agent to launch the application associated with the attachment's file type.    The file type is 
determined by the attachment's filename extension.    For example, "foo.gif" is a GIF file.    For more 
information, see How to Configure a GIF or JPG Viewer to Work with Agent.

After you have viewed an attachment, you may decide that you want to remove it from your hard drive.    
Although you can obviously do this in another program such as File Manager, Agent makes it easy for you
to remove attached files.

To delete a binary attachment:
1. Select any message in the attachment.
2. Choose Delete Selected Binary Attachments from the File menu.



How Agent finds all the parts of an attachment
Agent finds the sections of a binary attachment by searching the current group or folder for messages 
with identical subjects, except for the "[n/m]" or "n of m" part.    In most cases, this works quite well 
because people generally use automated tools (like Agent) to post attachments.    Unfortunately, some 
people assign different subjects to each message (e.g., "foo.jpg [8/8] -- last one!!").    When this happens, 
you can still save the attachment by selecting all of its sections and choosing Manually Save Binary 
Attachment from the File menu.



Getting Started
Getting up and running with Agent is simple.    Just follow the steps below and you'll be reading messages
in no time.

1. Set your online preferences.
Choose Preferences from the Options menu and select the Online tab.    If you wish to stay online with
your service provider while using Agent, press the Use Online Defaults button.    If you wish to 
minimize your time online, press the Use Offline Defaults button. 

2. Get a list of groups.
If you did not copy the list of newsgroups from another program or retrieve a complete list when you 
first started Agent, select Refresh Group List from the Online menu.    Since there are several 
thousand groups, this may take a while.    Once the groups are retrieved, Agent will display them in 
the Groups/Folders pane.

3. Subscribe to groups.
Scan through the list of groups for ones you want to follow regularly.    To find a particular group, 
choose Find from the Edit menu. 
When you find a group that may be of interest, double-click on it.    If you want to get a feel for the 
group before subscribing, press the Sample 50 Message Headers button.    If you know you're 
interested in the group, press the Subscribe to Group button. 
If you decide later that you're interested in a group, you can subscribe to it by selecting Subscribe 
from the Group menu.    A newspaper  appears next to each subscribed group. 
To unsubscribe from the group, choose the Subscribe menu option again. 

4. View only subscribed groups.
From the Group menu, choose Subscribed Groups and Folders from the Show flyout menu.    Now 
your Groups/Folders pane is filtered to show only the groups you're interested in.    To view all groups 
again, select All Groups and Folders from the Show flyout on the Group menu. 

5. Retrieve message headers in your subscribed groups.
Choose Get New Headers in Subscribed Groups from the Online menu to download all the message 
headers in all your subscribed groups. 
There may be several hundred new messages for each group so this operation may take a while.    
But, since Agent retrieves messages in the background, you can use your computer for other tasks 
while Agent is working. 

6. Browse the message headers.
Once the message headers are retrieved, browse them to see which ones interest you.    If you're 
using the online defaults, simply double-click or press Enter on a message to retrieve it (see How to 
Use Agent as an Online Newsreader for more information).    If you're using the offline defaults, mark 
all the messages in which you're interested.    To mark a message, select it and press "M" or choose 
Mark for Retrieval from the Message menu.    When a message is marked, the download arrow  
appears next to it. 

7. Retrieve marked messages.
If you're using the offline defaults, you marked several messages in the previous step.    To retrieve 
the full text of all marked messages, select Get Marked Message Bodies from the Online menu.    See
How to Use Agent as an Offline Newsreader for more information. 

TIP: Clicking the right mouse button in a window displays a Context menu, a context-sensitive list of 
common operations.    Simply select an option from the list to quickly perform that action.

See Also:
How to Use Agent
How to Receive Email





Toolbar
The toolbar contains buttons which give you fast access to the most common actions in Agent.
To see what a particular toolbar button does, move the mouse cursor over the button in Agent and a 
ToolTip box will appear with the button's name.



Groups/Folders pane
This is where a list of newsgroups and folders are displayed.    In this pane you can view all newsgroups 
and folders, subscribed newsgroups and folders, only folders, or only new newsgroups.    To change what 
is displayed in this pane, choose the appropriate option from the Group menu.
TIP: You can also change what is displayed by clicking the header text on the top of this pane.



Message List pane
This is where the messages in the selected group or folder are displayed.    To view messages in another 
group or folder, select it in the Groups/Folders pane.
TIP: You can change the sort of the Message List by clicking the column headings.



Unread Counter
This number shows you how many messages in the associated group or folder you have not yet read.



Ignore Thread Icon
When this icon appears next to a Usenet message, Agent will not retrieve new responses to it.    To switch
between ignoring and not ignoring a thread, select Ignore Thread from the Message menu.



Expand Thread Icon
Click this icon to show the message's responses.



Collapse Thread Icon
Click this icon to hide the message's responses.



Number of Responses
This is the number of responses to the message.    To view the responses, click the Expand Thread icon

.



Number of Lines
This is the number of lines in the message.



Message Body Icon
This icon tells you that the body of the message has been retrieved.



Folder Icon
This icon represents a place where you can store messages.



Message Body Not Available Icon
This icon tells you that the message has been deleted from your news server and is no longer available 
for retrieval.



Retrieval Icon
This icon tells you that the body of the message is currently being retrieved.



Watch Thread Icon
This icon tells you that Agent will automatically retrieve the bodies of new responses to this Usenet 
message when retrieving new message headers.    To switch between watching and not watching a 
thread, select Watch Thread from the Message menu.



Unread Message
When a message header is displayed in this color it means that you have not yet viewed the message's 
body.



Read Message
When a message header is displayed in this color it means that you have already viewed the message's 
body.



Mark for Retrieval Icon
This icon tells you that the body of the associated Usenet message will be retrieved the next time you 
select Retrieve Marked Messages from the Online menu.

When this icon appears next to a group, one or more messages in the group are marked for retrieval.

To mark or unmark a message, select Mark for Retrieval from the Message menu.



Keep Message Icon
This icon tells you that Agent will not automatically delete (purge) the message.    To prevent a Usenet 
message from being automatically purged, select Keep Message from the Message menu.    To undo the 
Keep status, select Keep Message again.

Agent never automatically purges messages from folders.



Message pane
This is where a message's text is displayed.    To view a different message's body, select the message in 
the Message List pane.



Status Bar
This area displays information about Agent such as the online status (online or offline), the current task, 
and the number of queued tasks.



Zoom Button
Press this button to maximize the Groups/Folders, Message List, or Message pane.    To restore the 
window back to showing all three panes, press the button that looks like this .



Subscribed Group Icon
This icon appears next to subscribed groups.    To switch between subscribing and unsubscribing to a 
group, select Subscribe from the Group menu.    To view only your subscribed groups, select Subscribed 
Groups and Folders from the Show flyout on Group menu.



New Group Icon
This icon appears next to new groups.    To get the list of groups that have been added to your news 
server since the last time you retrieved groups, select Get New Groups from the Online menu.



Follow Up Messages
These messages are responses to the one above them.    Since follow ups have the same subject as their
parent, only the author is shown.



Binary Attachment Icon
This icon tells you that the message contains a binary attachment that has already been decoded.    
Double-click the message to view the attachment.



Message with Attachment
This message contains a binary attachment.    To decode an attachment, choose Launch Binary 
Attachments from the File menu.



Groups and Folders
These are the Usenet newsgroups and folders you have created.    To retrieve message headers in a 
group, select the group and choose Get New Message Headers in Selected Groups from the Online 
menu.    To create a new folder, select New Folder form the Group menu.    Use the mouse to drag and 
drop messages between groups and folders.



Thread
A thread is a series of related messages grouped together.    For example, when people post responses to
a question, the question and all responses together are called a thread.



Follow Up Message
A follow up message is a response to another posting.    Follow ups generally have the same subject as 
the original and appear indented below it.



How to Post Usenet Messages
Reading newsgroups wouldn't be much fun if you couldn't contribute as well.    Fortunately, posting 
messages with Agent is just as easy as reading them.

1. Select the group you wish to post to.
A group is selected when it is highlighted in the Groups/Folders pane or when you are viewing 
messages for it in the Message List pane.    

2. (Optional) Select the message you are responding to.
If your message is a follow up to another posting, select that message first so that your posting is 
properly formatted. 

3. Open a new Posting window.
From the Post menu, choose New Usenet Message or Follow Up Usenet Message, depending on the
type of posting you want. 

4. Fill in the Posting window's fields.
If you selected a newsgroup (and message) before opening the Posting window, most of the fields will
be filled in for you.    When posting a follow-up message, you might want to send a copy of your 
response via email to the original message's author.    To do this, simply select the author's email 
address from the Email To list.    If you want to override the default signature, press the All Fields 
button and select the desired signature in the Signature list.    For more information filling in this 
window, see the Compose Usenet Message window topic.    If you want to paste text from a previous 
message so that it appears as quoted text, you can use the Paste As Quote command.

5. (Optional) Attach a file.
If you want to attach a file to the new message, enter the file name next to the Attachment button or 
press the Attachment button to browse for the file.    For more information on attaching files, see How 
to Send a Binary Attachment.

6. Send the message.
If you use Agent online, press Send Now to immediately transmit your message to the Internet.
If you use Agent offline and you have other messages you want to compose, press Send Later.    
Once you have composed all your messages, select Post Usenet and Email Messages from the 
Online menu to transmit them to the Internet.
Note: Agent does not make copies of attached files prior to sending them.    If you attach a file and 
press Send Later, make sure that the file stays around until you transmit the message. 

See Also: 
Reply to All command 
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created
How to Send Email
Message Fields
About Agent's Dictionaries.
ROT13 Encoding and Decoding



How to Send Email
With Agent, sending email to people is a snap and sending email replies to messages is even easier.

1. (Optional) Select the message you are responding to or forwarding.
If you're replying to or forwarding a posting, select that message first so that your email is properly 
formatted. 

2. Open a new Posting window.
From the Post menu, choose New Email Message, Reply via Email, or Forward via Email depending 
on the type of email you want to send. 

3. Fill in the Posting window's fields.
If you selected Reply via Email, the required fields should be filled in for you.    Otherwise, fill in at 
least the To and Subject fields.    Press the All Fields button to send "carbon copies" to other people, 
select a different signature, or define other information associated with the message.    For more 
information filling in this window, see the Compose Email Message window topic. If you want to paste 
text from a previous message so that it appears as quoted text, you can use the Paste As Quote 
command.

4. (Optional) Attach a file.
If you want to attach a file to the email, enter the file name next to the Attachment button or press the 
Attachment button to browse for the file.    For more information on attaching files, see How to Send a 
Binary Attachment.

5. Send the email.
If you use Agent online, press Send Now to immediately transmit your message to the Internet. 
If you use Agent offline and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Usenet and Email Messages from the Online 
menu to transmit them to the Internet.
Send Later Note: Agent does not make copies of attached files prior to sending them.    If you attach 
a file and press Send Later, make sure that the file stays around until you transmit the message. 

See Also: 
Reply to All command 
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created
How to Post Usenet Messages 
How to Receive Email
Message Fields
About Agent's Dictionaries.
ROT13 Encoding and Decoding



Making Sure Messages Were Sent Properly
When you first start using a new program, you probably want to make sure it's doing what you told it to 
do.    To make sure your messages have been successfully sent, choose Open Outbox from the Window 
menu.    By default, all the messages you send with Agent appear in this window (see the Posting tab of 
the Default Properties for All Groups dialog box for details).    The icons next to each message tell you the 
status of that message:

Icon Meaning
The message was successfully sent.    Note: If you have filed this message automatically in a 
folder, look in the folder for a record of the message.
A problem occurred sending this message.    Double-click on the message to make sure all the 
fields are filled in correctly and then press Send Now or Send Later to re-send the message.
The message is queued for uploading (you pressed the Send Later button after creating the 
message).    To send the message now, choose Post Usenet and Email Messages from the 
Online menu.
The message is in the process of being sent.

See Also:
How to Re-send a Message You Created



Watching and Ignoring Threads
As you probably already know, some newsgroups on the Internet are very active.    There can be several 
hundred new postings a day.    To help you cut through some of this noise, Agent provides you with two 
very powerful yet very simple features: Watching threads and Ignoring threads.

Watching Threads
When you're browsing though messages and come upon one that you know you'll be interested in 
responses to, select Watch Thread from the Message menu or press "W."    The Watch Thread icon,

, will appear next to the message.    Agent automatically retrieves the bodies of all responses to 
watched threads when retrieving message headers. 
Note: When you watch a thread with unretrieved messages, Agent automatically marks all the 
unretrieved messages in the thread for retrieval and, if the selected message is unretrieved, skips to 
the next unread message (outside of the current thread).    To retrieve the marked messages, select 
Get Marked Message Bodies from the Online menu (for details, see How to Use Agent as an Offline 
Newsreader).    To keep Agent from skipping to the next unread message, uncheck the "Watching an 
unread message skips to the next unread message" box on the Navigation tab of the Preferences 
dialog box.

Ignoring Threads
The opposite of watching threads is ignoring threads.    When you run across a message that you 
know you won't be interested in responses to, select Ignore Thread from the Message menu or press 
"I."    The Ignore Thread icon, , will appear next to all the messages in the thread.    Agent 
automatically marks the message and any responses to it, even those retrieved in later sessions, 
read.    This can significantly reduce the number of new, unread messages presented to you each 
time you get new message headers. 
Note:    After you ignore a thread, Agent automatically skips to the next unread message.    To turn this 
behavior off (keep the focus on the current message), uncheck the "Watching an unread message 
skips to the next unread message" box on the Navigation tab of the Preferences dialog box.

Important!    Be sure to keep at least one header in a watched or ignored thread in order for this feature 
to work.    This ensures that the feature will work, no matter how you have set the purge properties 
(Properties | Purge, or Default Properties | Purge).

See Also:
Navigating in Agent
Marking Messages Read



ROT13 Encoding and Decoding
Some Internet messages contain text encoded with a scheme called ROT13.    ROT13 encoded text 
cannot be read without first decoding it.    For example, "Hello World" encoded with ROT13 looks like this: 
Uryyb Jbeyq

To decode a ROT13 message:
Select the encoded text and choose Apply ROT13 from the Edit menu or press Ctrl+R.

To encode a ROT13 message:
Select the text to encode and choose Apply ROT13 from the Edit menu or press Ctrl+R. 

Note: When you decode text in a message you have retrieved, the decoding only affects your display.    If 
you come back to this message later, you will again see the original, encoded text.    Encoding text in a 
message you're creating, on the other hand, affects the actual text.    If you then post the message, other 
people will see it with the text encoded. 

See Also:
How to Post Usenet Messages
How to Send Email



Copying a WWW URL to the Clipboard
Many Internet messages contain addresses of World Wide Web (WWW) pages.    Although Agent doesn't 
directly support Web browsing, it makes it easy for you to copy these addresses, called URLs, to the 
Windows Clipboard for pasting into another program like Mosaic or Netscape.

To copy a WWW URL to the Clipboard:
While viewing a message with a URL, choose Copy WWW URL from the Edit menu or press Ctrl+U. 
Agent will scan the message starting at the cursor's current location, highlight the first URL it finds, 
and copy it to the Clipboard.    To search for another URL, simply press Ctrl+U again.    If Agent can't 
find the URL, you may need to customize the URLPattern setting in AGENT.INI.

To paste a WWW URL into MS Explorer:
Launch Microsoft Internet Explorer and choose Open from its File menu.    Click in the Address field 
and press Ctrl+V.

To paste a WWW URL into Mosaic:
Launch Mosaic and choose Open URL from its File menu.    Click in the URL field and press Ctrl+V.

To paste a WWW URL into Netscape:
Launch Netscape and choose Open Location from its File menu.    Click in the edit field and press 
Ctrl+V.



Common Internet Acronyms
AFAIK As far as I know
<BG> Big Grin
<g> Grin
BRB Be right back
BTW By the way
CP Copy protection
FUBAR Fouled up beyond all recognition (or 

repair)
FWIW For what it's worth
FYI For your information
GD&WVVF Grinning, ducking, and walking very, very

fast
GR&D Grinning, running, and ducking
IAE In any event
IANAL I am not a Lawyer
IMHO In my humble opinion
IMO In my opinion
IOW In other words
LOL Laughed out loud
LZ Loser!
OIC Oh, I see
OTOH On the other hand
PITA Pain in the A$$
PMJI Pardon my jumping in
PMFJI Pardon me for jumping in
ROFL Rolling on floor, laughing
ROTFL Rolling on the floor laughing
ROTFLMAO Rolling on the floor laughing my a$$ off
RSN Real soon now
RTFM Read the f@%# manual (or message)
SNAFU Situation normal, all fouled up
TIA Thanks in advance
TPTB The powers that be
TTFN Ta ta for now

How to Get All the Message Bodies in a Newsgroup
Agent provides you with two ways to retrieve the bodies of all the messages in a newsgroup:

To always retrieve all the bodies in a particular group:
1. Select the group(s) for which you want to retrieve bodies.
2. Choose Properties for Selected Groups from the Group menu.
3. Select the Retrieving tab on the Properties for Selected Groups dialog box.
4. Make sure the "Override default settings" box is checked.
5. Check the "Retrieve bodies for all new messages" box.

To retrieve all the bodies in a group on an ad-hoc basis:
1. Select any message in the Message List pane of the group for which you want to retrieve bodies.
2. Choose Select All from the Edit menu or press Ctrl+A.
3. If you are online, choose Get Selected Message Bodies from the Online menu.    If you are offline, 

choose Mark for Retrieval from the Message menu.    You can later retrieve the marked messages by 
selecting Get Marked Message Bodies from the Online menu.

See Also:
How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader



Online Menu Commands Explained



How to configure a GIF or JPG viewer to work with Agent
The Internet contains a wide variety of graphic images which are usually stored in GIF or JPG formatted 
files.    Although Agent doesn't display these images directly, you can view them from Agent if you have a 
GIF or JPG viewing program.    To configure your system for viewing graphics from Agent:

1. Run File Manager.
From Program Manager, double-click the File Manager icon.

2. Open the Associate dialog box.
Choose Associate from File Manager's File menu. 

3. Create an association.
In the Associate dialog box, enter GIF or JPG into the Files with Extension box.    Enter the full path of 
your graphics viewer into the Associate With box or press Browse to search for the viewer on your 
hard drive. 

See Also:
How to Retrieve a Binary Attachment



How to Use Agent as an Offline Newsreader
If you pay an hourly rate for your Internet connection, an offline newsreader can save you lots of money 
by minimizing the time you are connected to your service provider.    To use Agent as an offline reader, 
follow the steps below:

1. Make sure you are configured for offline operation.
Choose Preferences from the Options menu and select the Online tab.    Press the Use Offline 
Defaults button and Agent will automatically configure itself for offline use. 

2. Get headers for new messages.
To retrieve the headers of all the new messages in all your subscribed groups, choose Get New 
Headers in Subscribed Groups from the Online menu.    If you only want the new headers in a 
particular group, select that group and choose Get New Headers in Selected Groups from the Online 
menu. 

Agent will now go online and retrieve the new headers.    As soon as it is done, it will go offline so that you 
are no longer incurring connect charges. 

All the message headers Agent retrieved will be colored red (assuming you're using Agent's default color 
scheme - see the Preferences dialog box, Colors Tab).    This signifies that the message is new, or 
"unread." 

3. Mark messages for retrieval.
Browse through the message headers just retrieved and look for ones that interest you.    When you 
find one, highlight it and do any one of the following: 

· Click the Mark for Retrieval toolbar icon 
· Choose Mark for Retrieval from the Message menu
· Press the M or Enter key
· Double-click on the message

Repeat the above step for each message whose body you wish to retrieve. 

4. Get marked message bodies.
Once you've marked all the interesting messages in all your groups, choose Get Marked Message 
Bodies from the Online menu. 

Agent will now go online to retrieve the full text of all your marked messages and go offline as soon as it's 
done. 

5. Read the retrieved messages.
Any messages you did not mark in the previous step will automatically have been marked read when 
you retrieved marked message bodies in the previous step (see Marking Messages Read for details). 
You can now use the options on the Navigate menu to quickly find and read the messages you just 
retrieved. 

See Also:
Navigating in Agent
How to Use Agent as an Online Newsreader
About Usenet Message Purging
Online Menu Commands Explained
Watching and Ignoring Threads
Properties for Selected Groups dialog box, Retrieving tab



How to Use Agent as an Online Newsreader
If you don't pay an hourly rate for your Internet connection, you probably want to remain connected to 
your service provider while using Agent.    To use Agent as an online reader, follow the steps below:

1. Make sure you are configured for online operation.
Choose Preferences from the Options menu and select the Online tab.    Press the Use Online 
Defaults button and Agent will automatically configure itself to stay online. 

2. Get headers for new messages.
To retrieve the headers of all the new messages in all your subscribed groups, choose Get New 
Headers in Subscribed Groups from the Online menu.    If you only want the new headers in a 
particular group, select that group and choose Get New Headers in Selected Groups from the Online 
menu. 

Agent will now go online if you're not currently connected.    It will remain online until you manually go 
offline (by exiting the program or deselecting Online from the Online menu) or until it detects an extended 
period of inactivity. 

All the message headers Agent retrieved will be colored red (assuming you're using Agent's default color 
scheme - see the Preferences dialog box, Colors Tab).    This signifies that the message is new, or 
"unread" (see Marking Messages Read for more information). 

3. Read messages.
To read a message, select it and choose View Selected Message from the Navigate menu.    You can 
also read a message by simply double-clicking on it or highlighting it and pressing Enter.    To read the
next unread message, use the View Next Unread Message (Ctrl+N) or View Next Unread Message in
Thread (Ctrl+T) commands on the Navigate menu.    These commands jump to the next unread 
message and retrieve its body at the same time. 

See Also:
Navigating in Agent
How to Use Agent as an Offline Newsreader
About Usenet Message Purging
Online Menu Commands Explained
Watching and Ignoring Threads
Properties for Selected Groups dialog box, Retrieving tab



Message Header
A brief description of a message.    A message's header contains key information about the message, 
such as its author and subject, but does not include the text, or "body," of the message itself.



Message Body
The actual text of a message.    The other components of a message, such as its subject, author, etc., are 
called the message's "header."



Marking Messages Read
New messages you retrieve are initially marked unread.    When you view a message's body, Agent then 
marks that message read.    Since you probably don't read all the Usenet messages whose headers you 
retrieve, Agent automatically marks the ones you don't care about as read.

To automatically mark old messages read when retrieving new messages:
By default, Agent automatically marks all Usenet messages read whenever you retrieve message 
headers.    This makes it easy for you to find the new messages because they will be the only ones 
which are unread.    To change this behavior, choose Properties from the Group menu and select the 
Marking Read tab.

To automatically mark messages read when skipping between groups:
When jumping from one group to another via a navigation command (Skip to Next Unread Group, for 
example), Agent can automatically mark as read all messages in the group you are skipping from.    
To enable this behavior, check the "Skipping to next unread group marks all messages in current 
group read" box on the Navigation tab of the Preferences dialog box.

To manually mark messages read:
Select the messages you want to mark read and choose Mark Read from the Message menu.    To 
mark all the messages in a group or folder read, select the group or folder and choose Mark Selected 
Read from the Group menu or Mark All Read from the Message menu (these two commands are 
equivalent).    To mark all the messages in all your groups and folders read, choose Mark All Read 
from the Group menu.

To manually mark a message unread:
Select the messages you want to mark unread and choose Mark Unread from the Message menu.    
To mark all the messages in a group or folder unread, select the group or folder and choose Mark All 
Unread from the Message menu.

See Also:
Watching and Ignoring Threads
Navigating in Agent



About Usenet Message Purging
In general, Agent automatically deletes, or "purges," old Usenet messages for you.

When does Agent purge messages:
There are three times when messages can be purged:

· When retrieving new headers
Agent can purge a newsgroup's old messages whenever it retrieves new message headers for 
that group.    To turn this feature on, check the "When retrieving new headers" box on the When to
Purge tab of the Default Properties for All Groups dialog box.

· When closing Agent
Agent can purge old messages from all newsgroups when exited.    To enable this option, check 
the "When closing Agent" box in the When to Purge group on the When to Purge tab of the 
Default Properties for All Groups dialog box.

· On demand
You can manually purge old messages by selecting one of the options from the Purge 
Newsgroups flyout on the Group menu.    Or, to immediately delete a message without purging 
the other messages in the group, select the message and, from the Message menu, choose 
either Delete Message (to remove the entire message) or Delete Message Body (to remove the 
message's text while continuing to display its header in the Message List pane).    A message will 
appear asking you to confirm the delete action.    To turn off the delete confirmation message, see 
the Confirmations tab of the Preferences dialog box.

Which messages does Agent purge:
Agent provides you many options when deciding which Usenet messages to automatically purge.    
You can purge messages once you've read them or after a certain period of time.    You can even 
setup Agent to mirror your news server - so you'll only see messages that are available for retrieval.    
To define which messages get purged, see the What to Purge tab of the Properties for Selected 
Groups dialog box.

How to prevent Agent from purging a message:
Occasionally you will come across a message that you don't want Agent to automatically purge.    To 
prevent Agent from deleting a message, regardless of the group's purge settings, highlight the 
message and choose Keep Message from the Message menu or press the Keep Message toolbar 
button .    The Keep Message icon, , will appear next to the message.    To remove the Keep 
Message icon, choose the Keep Message command again.

Note: When the Keep Message icon appears next to a message, you cannot manually delete the 
message or its body.    You must remove the Keep Message icon first.

See Also:
Compacting Agent's Database Files



Purge Newsgroups Flyout
Subscribed Groups - Purges messages from all your subscribed groups.
Selected Groups - Purges messages from the current group or highlighted groups.
All Groups - Purges messages from all your groups.



Compacting Agent's Database Files
So that Agent can work quickly and efficiently, it does not always ensure that its database files are as 
small as possible.    If disk space is at a premium, there are two ways that you can compact your 
databases to remove the wasted space that may accumulate.

To manually compact the database files:
Choose Compact Databases from the File menu.    Agent will scan the databases to determine how 
much disk space you will save.    After the scan is complete, you may choose to either proceed with 
the compaction or cancel without affecting any files.

To automatically compact the database files:
You define when Agent should automatically compact your databases with the When to Purge tab of 
the Default Properties for All Groups dialog box.    In general, you probably don't need to compact 
your databases automatically.    Compacting after you change your purge settings should be sufficient 
for most people.

See Also:
About Usenet Message Purging



Navigating in Agent
Agent provides you with a rich set of tools for moving between newsgroups, folders, and messages.    
Most of these tools can be accessed from the Navigate menu, the toolbar, and the keyboard.    Although 
you probably won't use all the available options, this topic will make you familiar with them so that you can
choose which navigation techniques best suit you.

Moving between panes
As you probably already know, Agent is composed of three panes: the Groups/Folders pane, the 
Message List pane, and the Message pane.    You can view all three panes at the same time, or, to 
maximize the information you see on-screen, Zoom the Browser window to expand the current pane to fill 
Agent's window.

To Zoom a Browser window:
· Select Zoom Window from the Navigate menu.
· Press "Z".
· Click the Maximize icon  in the pane you wish to expand. 

To view all three panes at the same time (turn Zoom off):
· Select Zoom Window from the Navigate menu.
· Press "Z".
· Click the Restore icon .

You can easily move the focus between the panes with both the mouse and the keyboard.

To move between panes with the mouse:
· When viewing all three panes, simply click on the desired pane. 
· When zoomed in on a pane, click the tab for the pane you wish to view: 

To move between panes with the keyboard:
· Press the Tab key to move from the Groups/Folders pane to the Message List pane to the 

Message pane. 
· Press Shift+Tab or Escape to move in the reverse order. 

· Press the "1", "2", or "3" keys to move from pane to pane.    Pressing "1" places the focus in the 
Groups/Folders pane, "2" places the focus in the Message List pane, and "3" places the focus in 
the Message pane.

Moving between messages
Moving between messages is probably the single most common action you perform in Agent.    That's why
Agent provides you so many different ways to do this.

To move to the previous or next message:
· From the Message List pane, you can use the up and down arrow keys to move between 

messages. 
· From the Message pane, choose Up to Previous Message (or press "U") or Down to Next 

Message (or press "D") from the Navigate menu.    Note: These commands also work in the 
Message List pane. 

To move to the next unread message:
· Press "N" or the Skip to Next Unread Message toolbar icon  to skip to the next unread 

message, regardless of whether or not you have already retrieved its body.

· Press "B" to skip to the next unread message with a body.    "B" simply skips to the message and
selects it.

Note about Skipping to Next Unread:  By default, if the next unread message is in a different group 
or folder, pressing "N" or "B" causes Agent to open that group or folder and select the first unread 



message.    If you would prefer Agent to move you to the Groups/Folders pane instead (so that you 
can more easily tell when you're done with a group or folder), uncheck the "Skipping to next unread 
message jumps to first unread message in next group" box on the Navigation tab of the General 
Preferences dialog box.
· Press "T" or the Skip to Next Unread Message in Thread toolbar icon  to skip to the next 

unread message in the current thread.    This action is handy because when you reach the last 
follow-up message, Agent stops navigating, telling you that the thread is over. 

· Press "S" or the Skip to Next Unread Group toolbar icon  to skip to the first unread message in
the next group or folder.    By default, this action marks all the unread messages in the current 
group or folder as read before skipping to the next one.    This is a convenient way to tell Agent 
that you have read all the interesting messages in the current group.    You can disable this 
behavior by unchecking the "Skipping to next unread group marks all messages in current group 
read" box on the Navigation tab of the General Preferences dialog box.

· Press Ctrl+B to skip to the next unread message with a body and display its body text.

Navigating and retrieving Usenet messages at the same time
Since you need to retrieve a Usenet message's body before you can read it, Agent allows you to skip to 
an unread message and retrieve it (or mark it for retrieval) in one step.    Note: Whether Agent retrieves 
the message or marks it for later retrieval is controlled by the Viewing Unretrieved Messages When 
Offline radio buttons on the Online tab of the General Preferences dialog box.

To retrieve the next unread message:
· Press Ctrl+N or the View Next Unread Message toolbar icon  to skip to the next unread 

message and retrieve it (or mark it for retrieval).    Note: The action is controlled by the same 
preference settings affecting "N" (see above).

· Press Ctrl+T or the View Next Unread Message in Thread toolbar icon  to skip to the next 
unread message in the current thread and retrieve it (or mark it for retrieval). 

When configured for offline use (see the Online tab of the General Preferences dialog box for details), you
generally mark all the desired messages for retrieval and then retrieve marked message bodies.    By 
default, Agent skips to the next unread message (performs the "N" action) when you mark a message for 
retrieval.    You can turn this behavior off by unchecking the "Marking or ignoring a message skips to the 
next unread message" box on the Navigation tab of the General Preferences dialog box.

Using a single key to view the next unread message body
On the Navigation tab of the General Preferences dialog box, you can check the Single Key Read views 
next unread message body option.    This allows you to view the next unread body by simply pressing the 
Space bar, while the Groups/Folders pane or Message List pane has the focus (exactly like using the 
View Next Unread Message Body command).

Expanding and collapsing threads
Agent displays follow-up messages indented under the original message.    To save screen real-estate, 
these threads are initially shown collapsed, so only the top-most message is visible.    When a thread is 
collapsed, the Expand Thread icon  appears next to it.

To expand a thread:
· Click the Expand Thread icon. 
· Select the message and press the "+" key. 
· To expand all the threads in a group, hold down the Shift key while pressing the "+" key. 

When a thread is expanded, the Collapse Thread icon  appears next to it.

To collapse a thread:
· Click the Collapse Thread icon. 
· Select the message and press the "-" key. 
· To collapse all the threads in a group, hold down the Shift key while pressing the "-" key. 

Agent can also automatically expand threads for you.    By default, Agent expands threads when you skip 



to them.    Note: Agent will automatically expand the thread when you skip to it only if you have already 
retrieved the body of the original message.    To prevent Agent from expanding threads when you skip to 
them, uncheck the "Automatically expand threads containing new messages" box on the Navigation tab of
the General Preferences dialog box.    If you always want all threads expanded, uncheck the "Show 
threads initially collapsed" box on the Navigation tab of the Preferences dialog box.

See Also:
Watching and Ignoring Threads
Marking Messages Read
How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader
Online Menu Commands Explained



Printing Messages
Agent allows you to print one or more messages in a single group or folder with one command.

To print messages:
1. Define the page parameters (including margins, headers, and page breaks) using the Page Setup 

dialog box (File | Page Setup).
2. Select the printer font you want to use with the Printer Font dialog box (Options | General Preferences

| Fonts | Printer button).
3. Select all the messages to print.    If you select a collapsed thread, Agent will print all messages in the 

thread.    Agent only prints messages whose bodies have been retrieved. 
4. Choose Print from the File menu.    Press OK on the Print dialog box to start printing the messages. 

See Also:
Save Message As dialog box



Finding Groups and Folders
Agent allows you to search for groups and folders by name and for messages or filters by subject and 
author.    You can also quickly find addresses in the address book by simply typing the first few letters of a 
name.

To find a group or folder:
1. Make sure the focus is in the Groups/Folders pane.    Note: You can do this by selecting any group or 

folder in the Groups/Folders pane.
2. Choose All Groups and Folders from the Show flyout on the Group menu.
3. Choose Find from the Edit menu. 
4. Enter any part of the desired group's or folder's name in the Find dialog box.    For example, if you 

enter win into the Find dialog box, Agent will find, among others, alt.winsock, alt.sewing, 
and rec.crafts.winemaking. 

5. Press Find First to find the first group or folder in the Groups/Folders pane with this text in its name.    
Press Find Next to find the first group or folder below the currently selected one with this text in its 
name. 

6. If the found group or folder isn't the one you were looking for, press F3 or choose Find Next from the 
Edit menu to search for the next group or folder with the text you entered. 



Finding Messages
Agent allows you to search for messages by subject and author.

To find a message:
1. Make sure the focus is in the Message List pane of the group you want to search.    Note: You can do 

this by selecting any message in desired group.
2. Choose Find from the Edit menu to open the Find dialog box.
3. Enter any part of the desired subject or name in the Find dialog box. 
4. Press Find First to find the first message whose subject or author contains the text you entered.    

Press Find Next to find the first message below the currently selected one with this text in the subject 
or author fields. 

5. If the found message isn't the one you were looking for, press F3 or choose Find Next from the Edit 
menu to search for the next message in this group that contains the text you entered.



Finding Filters
Agent allows you to search for filters by subject and author.

To find a filter:
1. Make sure the focus is in the Usenet Filters window (Group | Usenet Filters).
2. Choose Find from the Edit menu. 
3. Enter any part of the desired subject or author in the Find Filter dialog box.
4. Press Find First to find the first message whose subject or author contains the text you entered.    

Press Find Next to find the first message below the currently selected one with this text in the subject 
or author fields. 

5. If the found message isn't the one you were looking for, press F3 or choose Find Next from the Edit 
menu to search for the next message in this group that contains the text you entered.



Finding Addresses
Agent allows you to quickly find addresses in the address book by using the Edit | Find command.    This 
will bring up the Find Address dialog box.    Alternatively, you can find an address by simply typing the first 
few letters of a name.



 How Agent Knows Which Usenet Messages are New
THIS TOPIC IS OBSOLETE
When you select either Get New Headers in Subscribed Groups or Get New Headers in Selected Groups,
Agent only retrieves the messages that have been posted to the groups since the last time you checked 
for new messages.    

How does Agent know which messages are new and which ones you've previously retrieved?    Every 
time a message is posted to a group, the news server assigns it a number that is one higher than the last 
message posted to that group.    Each time you retrieve headers for a group, Agent keeps track of the 
highest message number retrieved.    This number is stored in the "Highest message retrieved" field on 
the Retrieving tab of the Properties for Selected Groups dialog box.    The next time you tell Agent to 
retrieve new headers for a group, it will retrieve only the headers of messages whose number is greater 
than the "Highest message retrieved" value.

You can reset the high message number by selecting the desired group and choosing Catch Up With 
Selected Groups from the Online menu.    This causes Agent to connect with the news server and query it 
for the highest message number without retrieving any new headers.

See Also:
Online Menu Commands Explained



Online Menu Commands Explained
The Online menu contains the commands which cause Agent to interact with the Internet.    This topic 
describes these actions in detail and provides links to related Help topics.

Get New Headers in Subscribed Groups 
Retrieves all the message headers that have been posted to your subscribed groups since the last 
time you checked for new messages.    By default, Agent marks a group's existing messages read 
before it retrieves new headers for that group.    To change this behavior for all your groups, uncheck 
the "New message headers" box on the Marking Read tab of the Default Properties for All Groups 
dialog box.

Get New Headers in Selected Groups 
Retrieves all the message headers that have been posted to the selected groups since the last time 
you checked for new messages.    By default, Agent marks a group's existing messages read before it
retrieves new headers for that group.    To change this behavior for a particular group, select that 
group and uncheck the "New message headers" box on the Marking Read tab of the Properties for 
Selected Groups dialog box.

See Also:
How to Get All the Message Bodies in a Newsgroup
Marking Messages Read
Retrieving tab of the Default Properties for All Groups dialog box

Get Marked Message Bodies 
Retrieves the bodies of all the messages you marked for retrieval.    Messages from all groups with 
marked messages are retrieved with this command (not just ones from the selected group).    Also, by 
default, messages that were not marked for retrieval are made read when Agent retrieves marked 
message bodies for that group. To change this behavior, uncheck the "Marked message bodies" box 
on the Marking Read tab of the Default Properties for All Groups dialog box.

See Also:
How to Use Agent as an Offline Newsreader

Get Selected Message Bodies 
Retrieves the full text of the selected message(s).    You can also retrieve a message's body by 
double-clicking on the message or by highlighting it and pressing Enter.    Note: Even if you are 
configured for offline use (see the Online tab of the Preferences dialog box for details), selecting this 
menu command causes Agent to go online and retrieve the selected messages.

See Also:
How to Use Agent as an Online Newsreader

Sample <##> Headers from Selected Groups
Retrieves up to the defined maximum number of message headers from the most recently posted 
messages in the selected groups.    This command is useful when you are looking at new groups and 
don't want to get stuck retrieving hundreds of headers for a group you may not be interested in.    
Note: You can change the number of messages retrieved when you sample a group with the 
Retrieving tab of the Default Properties for All Groups dialog box.
If, after sampling some of the headers, you decide that you are interested in the group, choose Get All
Headers in Selected Groups to retrieve the remaining messages.

See Also:
View Empty Group dialog box

Get All Headers in Selected Groups
Retrieves message headers for every message in the selected groups.    In general, you should use 
one of the Get New Headers commands to retrieve messages because they retrieve only the 
messages you haven't seen.    This command is useful, however, after you've sampled some headers 



from a group and want to retrieve the remaining ones.    You can also use this command to retrieve 
messages that you manually deleted or that were automatically purged.

See Also:
About Usenet Message Purging

Catch Up With Selected Groups
Retrieves the highest message number for the selected groups without retrieving any message 
headers.    The next time you get new headers for the groups, Agent will only retrieve messages 
posted after you did the catch up.
Note: Some other newsreaders employ a slightly different implementation of catch up.    When you 
"catch up" in those programs, they do not retrieve the highest message number.    Instead, they simply
mark read the messages you previously retrieved.    You can achieve the same behavior in Agent with 
the Mark Selected Groups Read command on the Group menu.

See Also:
Marking Messages Read

Post Usenet and Email Messages
Transfers any queued messages to the Internet.

See Also:
How to Post Usenet Messages
How to Send Email
Making Sure Messages Were Sent Properly 
How to Re-send a Message You Created

Check for New Email
Retrieves new email messages from your POP server.    Note: This command is dim when you are 
configured to receive mail from an SMTP server because Agent automatically receives your SMTP 
mail whenever it goes online.

See Also:
How to Receive Email

Get New Groups
Retrieves all the newsgroups which were added to your news server since that last time you updated 
your group list.    The new groups Agent retrieves will have the New Group icon, , next to them until 
the next time you get new groups.    To view just the new groups, choose Show Only New Groups 
from the Group menu.    Note: On rare occasions, a group may be added to your news server in such 
a way that Get New Groups will not retrieve it.    For this reason, you may want to periodically use the 
Refresh Groups List action instead.

Refresh Groups List
Retrieves a complete list of groups from the news server.    Use this command when you want to 
recover a group you previously deleted or when you want to purge groups that are no longer available
on the news server.

See Also:
Refresh Groups List dialog box

Stop All Tasks 
Causes Agent to immediately abort the current and any pending online tasks.

Online 
Toggles Agent's Online status.    When this menu option is checked (the toolbar button appears 
illuminated), Agent is online and selecting it will take Agent offline.    When this menu option does not 



have a check mark next to it (the toolbar button appears as above), Agent is offline and selecting it 
will cause Agent to connect to your service provider.    You can also press the toolbar button to toggle 
Agent's online status.



Delete command (Group menu)
Use this command to remove a group or folder from Agent.

To remove a specific group or folder :
Select the group or folder and choose Delete from the Group menu.

To remove all extinct news groups:
Choose Refresh Group List from the Online menu.    On the Refresh Group List dialog box, select the 
"Delete all extinct groups" option.

To recover news groups you deleted:
Choose Refresh Group List from the Online menu.



Cancel Usenet Message command (Message menu)
Use this command to remove a Usenet message you posted.    Canceling a message sends a message to
your news server asking it to delete the message.    This message is also passed along to the other news 
servers on the Internet so that they can delete the message as well.    Note: You cannot cancel email 
messages after sending them.

To cancel a Usenet message:
1. Select the message and choose Cancel Usenet Message from the Message menu.    You can only 

cancel your own messages.    Note: Cross-posted messages only need to be canceled from one of 
the cross-posted groups.

2. In the Compose Usenet Message window, press Send Now or Send later to transmit the message to 
your news server.    You should not make any other changes to the message. 

After sending the message, the message will continue to appear in Agent until it's 
automatically pruned or you delete it (see About Usenet Message Purging for details).    Since 
some news servers do not accept cancel requests, you may want to verify that the posting 
was actually deleted.
To verify that the message was deleted:
1. Highlight the message you canceled.
2. Delete the message's body by selecting Delete Message Body from the Message menu. 
3. Try to retrieve the message's body again by choosing Get Selected Message Bodies from the Online 

menu.    If the cancel request was accepted, the Message Body Not Available icon  will appear next 
to the message. 



Message Text Display Options
The following settings control the appearance of message text:

Normal Font
The standard font used to display message text is defined in the Variable-Pitch Body Font dialog box. 

Fixed Pitch Font
You can also display message text in a fixed-pitch font. Many people on the Internet have fancy 
ASCII-graphic signatures.    These signatures will look like a jumble of lines and letters unless they are
displayed in a fixed-pitch font.    To display messages you've retrieved in a fixed-pitch font, choose 
Fixed Pitch from the Message menu.    To display messages you're composing in a fixed-pitch font, 
choose Fixed Pitch from the Compose window's Message menu.    To return to the standard, variable-
pitch font, select the Fixed Pitch menu option again.    You define which fixed-pitch font you want 
Agent to use in the Fixed-Pitch Body Font dialog box.

Word Wrap Lines
Occasionally you will see messages with very long lines that don't fit on your screen.    When this 
happens, simply select Word Wrap from the Message menu and Agent will break these lines at the 
end of the window.
Messages you send are automatically word wrapped at the length defined in the Posting tab of the 
Preferences dialog box.    If your Compose window is narrower than this value, select Word Wrap 
from the Message menu and Agent will wrap your lines when they reach the end of the window.    
Note: This wrapping is for your display only.    When the message is sent, each line is wrapped at the 
value defined in the Preferences dialog box.

Display Header Fields
Messages can have many fields associated with them, only a few of which are important (e.g., 
Subject and Author).    Since you generally don't care about the remaining fields, Agent hides them 
from you.    To see these remaining fields, select Show All Header Fields from the Message menu.    
For a description of what these fields represent, see Message Fields.

See Also:
Compose Usenet Message window
Compose Email Message window



About Agent's Dictionaries
Agent's spell checker supports the following languages:
· American English
· International English
· French
· German
· Italian
· Spanish

To install a dictionary for another language:
1. Download the desired language's dictionary file from our FTP site.    The dictionary files are located in

ftp.forteinc.com/pub/dictionaries/.
2. Unzip the dictionary file into your Agent directory.

(E.g., pkunzip german.zip c:\agent)

After restarting Agent, you can spell check messages in any of the installed languages.

To define a new language in Agent:
1. From the Options menu, open the General Preferences Languages tab.

2. Press the Add button to open the Add Language dialog box and enter the name for the new language 
in the Name field.    Then select the language on which the new language is based.    Agent will adopt 
all the properties of that language and use them for displaying fonts.

3. When you press OK, the Add dialog box closes and the new language is added to the Languages list.

To define the language used for spell checking:
On the General Preferences Languages tab, select the language you want for spell checking from the
Spell Checker list.

To spell check a message:
While composing the message, choose Spelling from the Message menu.

To set the default language displayed for all messages in all groups:
On the Language tab of the Default Properties for all Groups dialog box, pick the desired language 
from the Language drop-down list

To set the default language displayed for all messages in a particular group:
Select the group and then, on the Language tab of the Properties for Selected Groups dialog box, 
pick the desired language from the Language drop-down list

To override the default language for a particular message:
Highlight the message for which you want to override the default language, then open the Message 
Language dialog box by selecting Language from the Message menu.    Now, select the desired 
language from the Language drop-down list.

You can also add your own words to Agent's dictionaries.    The spell checker supports one custom 
dictionary for each language.

To remove words from your custom dictionary:
1. Open the Spelling tab of the Preferences dialog box (Options menu).
2. In the Default Language drop-down list, choose the language associated with the custom dictionary.
3. Select the word to delete in the Edit list.
4. Press the Delete button.

See Also:
Compose Usenet Message window
Compose Email Message window
How to Post Usenet Messages
How to Send Email



Filing Messages in Folders
With Agent's folders, you can organize and store your messages in any manner you like.

To create a folder:
1. Choose New Folder from the Group menu.
2. Enter a name for the folder (up to 255 characters) and press OK.

Folders appear in the Groups/Folders pane below the newsgroups.

To view folders:
· Choose one of the "Folder" options from the Show flyout on the Group menu. 

There are different ways to file messages in folders:    You can drag and drop them, or use the commands 
on the Message menu, or, for inbound email messages, have them automatically filed for you.    Note: You
cannot file messages without bodies into a folders.

To drag and drop a message into a folder:
1. View all three panes in your Browser window (i.e., make sure the Zoom Window option on the 

Navigate menu is unchecked).
2. Highlight the message in the Message List pane.    
3. Click anywhere on the highlighted message and hold down the mouse button.
4. While continuing to hold the mouse button down, move the mouse cursor over the folder in which you 

want the message filed.
5. By default, Agent will move a message when you drag and drop it.    To copy the message instead, 

press and hold the Control key.
6. Release the mouse button to drop the message into the destination folder.

To file a message into a folder using the menus:
1. Highlight the message in the Message List pane.
2. On the Message menu, click either the Copy to Folder or Move to Folder flyout.
3. Select the desired folder from the flyout or choose All Folders to open a dialog box with a list of all the

folders you've created.    Note: Use the Manage Folder Menus dialog box to display your most 
frequently used folders on the Copy/Move to Folder flyout menus.

The fastest way to file your incoming email messages is to let Agent do it for you.    You can define a set of
rules which tell Agent where to store each new email message it encounters.    For example, you can 
create a rule that files all incoming email messages with "Agent" anywhere in the subject field into a folder
called "Agent Info."

To copy or move messages from the Outbox to a folder:
1. Display the Outbox by choosing Open Outbox from the Window menu.
2. Highlight the messages in the Outbox.
3. If you want to drag and drop the messages into a folder, select Tile Vertically from the Window menu 

and make sure the Groups/Folders pane is visible.
4. File the messages into a folder by either dragging and dropping them or choosing the desired folder 

from the Copy to Folder or Move to Folder flyout on the Message menu (see above for more details 
on these two steps).



How to Receive Email
Receiving email with Agent is simple and straightforward.    You can check for new mail with the click of 
your mouse or you can have Agent periodically check for you.

If you receive your email from an SMTP server, Agent continually checks for new mail whenever you are 
online.    If you receive your email from a POP server, however, you must explicitly tell Agent to check for 
new mail.

To check for new mail:
· If you receive mail from a POP server, choose Check for New Email from the Online menu.
· If you receive mail from an SMTP server, choose Online from the Online menu.    Whenever you are 

online, Agent will receive new email from your SMTP server.

To have Agent periodically check for new mail from your POP server:
1. Choose Inbound Email from the Options menu and click on the Checking for Mail tab.
2. Check the "Automatically check for email every" box.

TIP:    A quick way to tell if you have received mail is to minimize the Agent window.    When you have new
mail the Agent program icon will appear as follows:

See Also:
System Profile tab of the Inbound Email dialog box
Filing Messages in Folders



About Message Sorting
Agent allows you to sort your messages by thread, subject, author, date, and size.    It remembers the last 
sort you used for each newsgroup and folder, so when you view that group or folder again, the messages 
will be displayed in the same order they were in the last time you viewed the group or folder.

How to sort your messages:
· On the Group menu, click the "Sort by" flyout and choose the desired sort.  Tip: To sort several 

groups or folders at once, select all of them in the Groups/Folders pane before choosing the desired 
sort from the "Sort by" flyout.

· Click on the label above the column you wish to sort by.    For example, to sort by author, click the 
Author button that appears directly above the author column.    Note: To sort by thread or size, click 
the leftmost column until Thread or Size appears in the column label.

By default, Agent displays the most recent messages on the bottom of the Message List pane when 
sorted by date and the smallest messages on the bottom when sorted by size.

To change the order of the date and size sorts:
1. Choose Preferences from the Options menu and click on the Message List tab.
2. Check the "Date sorts descending" and/or the "Size sorts descending" box.    Note: You must resort 

the group or folder after checking or unchecking these boxes for the changes to take effect.



Sort
The ordering of messages in the Message List pane.



Importing Email Messages from Another Program
To help smooth the transition from your old email program, Agent allows you to import messages from a 
text file that is in the standard UNIX email message format (RFC-822).    To further facilitate this transition,
you can download a utility from Forté's FTP site which exports messages from Eudora or Pegasus into 
the standard UNIX format.    These utilities can be found at <ftp.forteinc.com/pub/converters/>.
Note: If you use an email program other than the ones mentioned above, check our Web page to see if an
export utility has been written for your program since this help file was produced.

To import messages from Eudora or Pegasus:
1. Run the export utility from a DOS window with the following command line:

emailcvt <data directory> <filename> [<folder prefix>]
where <data directory> is your email program's database directory and <filename> is the 
name of the DOS file that contains the file Agent will read.    The argument <folder prefix> is 
optional.    If provided, it is appended to the beginning of the names of all Agent folders that are 
created in the import process.    For example, if the folder prefix was "Email" then email will be 
imported into folders called "Email.In", " Email.Out", etc.

2. Choose Import Messages from the File menu.

3. In the File Name box, enter the location of export file from step #1.

4. (Optional) Check the "If a message contains an X-Folder field..." and "Automatically create folders" 
boxes.

5. Press OK to begin the import.

See Also:
Import File Format
Save Messages As dialog box



How to Re-send a Message You Created
Messages you send can be saved in the Outbox or a folder (see Posting tab of the Default Properties for 
All Groups dialog box for details).    The process of re-sending a message you created is slightly different 
based on where the message is located.

To re-send a message from a folder:
1. Highlight the message in the Message List pane.
2. Choose New Copy of Message from the Post menu.
3. (Optional) Change the message as required (e.g., change the recipient).
4. Press either Send Now or Send Later to transmit the message to the Internet.

To re-send a message from the Outbox:
1. Highlight the message in the Outbox.
2. Choose Open from the Message menu.
3. (Optional) Change the message as required (e.g., change the recipient).
4. Press either Send Now or Send Later to transmit the message to the Internet.

See Also:
Compose Usenet Message window
Making Sure Messages Were Sent Properly



Import Message File Format
Agent can import messages from a text file in the standard UNIX message format (RFC-822).    If you 
were using Eudora or Pegasus for email, Forté provides converters for exporting messages from these 
programs into the standard UNIX format.    For more information, see Importing Email Messages from 
Another Program.

As a convenience to those not using Eudora or Pegasus, the following describes in some detail the 
standard UNIX message format Agent can import:

· Each message must be preceded by a line of the form:
From <user>@<domain> <dow> <mon> <day> <hour>:<minute>:<second> <year>
Where:

<user>@<domain> is the email address of the sender of the message.    Agent actually ignores this 
address, so it can be any address.    For example, "???@???" is acceptable.

The rest of the line is the date of the message.    Agent requires that the date be in a legal format, but 
it ignores the date unless the message itself contains no Date: field.    The elements of the date are:

<dow> is one of: Sun, Mon, Tue, Wed, Thu, Fri, Sat (Agent ignores this).

<mon> is one of: Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Nov, Dec.

<day> is the day of the month.

<hour>:<minute>:<second> is the time of day in 24-hour time, for example 16:21:53.

<year> is the year.

Example From line:
From ???@??? Fri Sep 8 13:21:43 1995

· The message's header fields must follow immediately after the From line.    Each header field line 
must begin with the name of the field, without any preceding whitespace, followed by a colon and a 
space, followed by the value of the field.    For example:
To: mark.sidell@forteinc.com
A field value may be continued on subsequent lines.    Each continuation line must begin with at least 
one space character.    For example:
To: mark.sidell@forteinc.com,
   jon.berke@forteinc.com

· The header fields must be followed by a single blank line, followed by the body of the message.    The 
blank line should contain no space characters.

· If any line in the body is in the same format as the From line described above, it must be quoted with 
some other character, so that Agent does not think it is the beginning of the next message.    To quote 
the line, all that is required is that the word "From" not appear at the very beginning of the line.    By 
convention, these lines are quoted with '>'.    For example:

>From robin.mitchell Fri Sep 8 13:21:43 1995
Here's an example message:
From mark.sidell@forteinc.com Fri Sep 8 13:21:43 1995
From: mark.sidell@forteinc.com
To: jon.berke@forteinc.com
Subject: Import file formats
Date: 21 Aug 1995 19:47:12 GMT

Jon, here is an example of a quoted From line.  The following line looks just 



like a From line that begins a message, so I have quoted it. 

>From robin.mitchell Fri Sep 8 13:21:43 1995
That's all for now! 



Import/Export Address File Format
Import and export address files are formatted according to the following criteria:

· Import and export address files consist of a series of field definitions, one per line.    Each definition is 
of the form:
<field>:<value>
The <field> name must begin with the first character of the line.    A line may be no more than 1000
characters long, including the \r\n termination.    Multi-line field values may be represented by 
continuing the value on subsequent lines.    Each continuation line must begin with one or more 
whitespace characters (SP or TAB).    The initial whitespace is removed from the value during import.

· The file may contain blank lines, which are ignored.
· The first field for each address entry must be a Name field.    The value is the name of the address 

entry.    Fields other than Name prior to the first Name field    are ignored.
· All fields appearing after a Name field are part of the entry named by that field, until the next Name 

field is scanned.

The additional fields that may be included are defined below.    Fields that are not in this list are 
ignored.

Book - The name of the address book in which this entry resides.    This field is optional on import.    
Agent will have options that control the destination address book if this field is not specified.

Addresses - The entry's email address list field.

Comments - The entry's comments field.

Field-Text - The entry's Field Text field.



Adding People to the Address Book
Addressing a message to a person or a group of people (a mailing list) is much easier when they are in 
your address book.

To add a person or group to the address book:
1. Open the Address Book window.
2. Choose New from the Address menu to open the New Address dialog box.
3. Enter the person's name (e.g., Mark Happel) or the group's description (e.g., My Mailing List) in the 

Name box.
4. When adding an individual, enter his or her email address in the Addresses box.    When creating a 

mailing list, enter each person's email address separated by commas.
5. (Optional) Enter a description of the person or group in the Comments box.
6. (Optional) Enter the name of the mailing list in the Field Text box.
7. Press OK to save the new address book entry.

To add the author of an existing message to the address book:
1. Select any message authored by the person for whom you wish to create an address book entry.
2. Choose Add Author to Address Book from the Message menu.    This opens the New Address dialog 

box filled in with the name and address of the selected author.
3. Press OK to save the new address book entry.

See Also:
How to Use the Address Book
How to Post Usenet Messages
How to Send Email



How to Use the Address Book
Agent allows you to customize an address book to contain your most frequently used addresses for 
people and groups.    Using the address book, you can efficiently address messages you send.    Select 
from the topics below to better understand how to use the address book:

To open the Address book:
Select Open Address Book  from the Window menu.

To add a person or group mailing list to the address book:
Select New from the Address menu and complete the dialog box.    (The address book must be open.)    
Press the Help button for a description of each field.
For more information, see the topic Adding People to the Address Book.

To edit an address book entry in the address book:
1. From the Address Book Window, select the entry in the Names list.
2. Modify the entry's Addresses, Comments, or Field Text.
3. Choose Save from the Address menu or click the Save Address icon on the tool bar.

Note: To abandon your changes, choose Reset from the Address menu.

To change an address book entry's name:
1. Select the entry in the Names list.
2. Choose Rename from the Address menu, or click the Rename icon on the tool bar.

To delete an address book entry:
1. Select the entry in the Names list.
2. Choose Delete from the Address menu, or click the Delete Address icon on the tool bar.

To find an address:
You have different options, depending on what you are doing.

· To quickly find an address in the address book, select Find from the Edit menu and the Find Address 
dialog box will appear.    If you need help using this dialog box, press the Help button.

· When you are composing a message, press the Pick Address button  in the composition window.    
This opens the Pick Address dialog box, which lists all the addresses defined in the address book.    
Select an address from the list and it is immediately inserted into the To, Cc, or Bcc fields.

To start a new message:
1. From the address book, select the person or group to whom you wish to send the new message.
2. Choose To, Cc, or Bcc from the Address menu to open a new Compose Email Message window, or 

click the To, Cc, or Bcc icon from the tool bar.



How to Create Kill and Watch Filters
Kill and watch filters consist of:
· A filter expression.
· Seven possible filter actions:    three kill actions and four watch actions.
· A priority between 0 (lowest) and 1000 (highest).    Filters are evaluated in priority order.    If more than

one filter matches a message, the highest priority filter's action is performed.

· An optional expiration date, expressed in the number of days the filter should be kept.    Agent 
automatically deletes expired filters.    This helps you keep the number of filters from getting out of 
hand.

· An enabled/disabled flag.    This allows you to temporarily disable a filter without deleting it altogether. 
You can also use the Group Properties dialogs to temporarily disable all filters for selected groups.

How to create kill and watch filters
There are two general procedures for creating filters.    You can determine the one that best applies to 
what you are trying to accomplish.    Once you have reviewed the ways to create filters, take a look at 
some examples that better illustrate specific uses.

To create a filter based on a message:
1. Select a message header in the desired group.

2. Select Usenet Filters from the Message menu.

3. Select Add Kill Filter or Add Watch Filter, depending on which type of filter you want to create, and the
Add Usenet Filter dialog box will appear.

4. Complete the settings in the Add Usenet Filter dialog box.    The Search For expression is already 
filled in, based on the currently selected message.    For a description of these settings, see the online
help for that dialog box.

To create a filter from scratch:
If the filter is going to be for a specific group, make sure the group is highlighted.

1. Select Usenet Filters from the Group menu to open the Usenet Filters window.

2. From the Filter menu, select Add Kill Filter or Add Watch Filter, depending on which type of filter you 
want to create, and the Add Usenet Filter dialog box will appear.

3. Complete the settings in the Add Usenet Filter dialog box, as in the previous procedure.    However, in 
this procedure, the Search For field is blank, requiring the user to enter a filter expression that uses 
the valid syntax required.

If the filter defaulted to the wrong group, then do the following:

a. From the Filter menu, choose Select View to open the Select View dialog box.

b. Check the Group <x> box (whatever group is showing).    Then press OK.

c. Close the Usenet Filters window, and repeat steps 1-3 above.

See Also:
Kill And Watch Filter Examples
Using Filter Expressions



Filter Expressions
A rule defining a word or phrase, or a boolean combination of words or phrases (i.e., 
expressions that use 'and', 'or', and 'not' operators).    The filter expression can stipulate 
whether a given phrase must appear in the message subject, author field, or both.    In 
addition, the expression can specify an acceptable range of line numbers.    Wildcards can be
used to match words that begin with a particular sequence of characters.



Kill and Watch Filter Examples
This topic illustrates the basic elements used to create filters.    All the examples are based on this 
scenario:

George is a "sky sports" enthusiast subscribed to the group alt.aviation.methods and has just 
discovered an interesting header, How does a Blimp Fly.  He thinks the following:

1. Question: 'I want to learn more about blimps.    Can I create a Blimp filter?'
Answer: Yes.    You can do this with a simple watch filter.

2. Question: Will subject: Blimp catch all instances of blimp?'
Answer: Good question!    Blimp (initial capital letter) will not catch all instances, because 

filtering is case sensitive.    To filter on all instances of a subject, the filter expression 
needs to be in all lower case letters.    Click to see how to edit the filter from Blimp to 
blimp.

3. Question: 'What about plurals, say if blimps is in the message header?'
Answer: Another excellent question.    To catch all singular and plural instances, edit the 

existing filter rule using the wildcard *.

4. Question: 'I think some messages are too long!    Can I filter on messages that are 100 lines or 
less?

Answer: Easily, using the line range filter and the 'and' operator.

5. Question: Can I filter out any messages by that obnoxious author Fester!?
Answer: No problem.    To do this, you will use an author qualifier and the not operator.

6. Question: 'What if I want to know about airships, too?'
Answer: Fine.    You can use parentheses to modify precedence and the or operator to do this.

7. Question: 'Is there an easy way to reduce the clutter in this group?
Answer: There's a great way to do this.    Just create a kill filter with a lower priority.'

You can continue to add to your filter rule to do any number of things.    For information about valid 
expressions in filter rules, see Using Filter Expressions.

See Also:
How to Create Kill and Watch Filters



Simple watch filter
1. Highlight the message header How Does a Blimp Fly?.
2. Select Usenet Filters -> Add Watch Filter from the Message menu.
3. Complete the following settings in the Add Usenet Filter dialog box:
Search For: subject: Blimp
Watch Action: Retrieve Body immediately
Scope: Group



Editing the filter to catch all upper or lower case instances
Make sure alt.aviation.methods is highlighted, then:
1. Select Usenet Filters    from the Group menu to open the Usenet Filters window.
2. Highlight the filter rule you want to edit and select Edit from the Filter menu.
3. On the Edit Usenet Filter dialog box, edit the filter rule to say subject: blimp.
Removing all capital letters (i.e., changing the "B" to lowercase) tells Agent to filter on all instances of the 
word, whether they contain capital or lowercase letters.



Wildcard example
Edit the rule to say subject: blimp*.    The star is a wildcard that tells Agent to evaluate any character 
appended to blimp.



Line range filter and 'and' operator
Edit the filter rule to say subject: blimp* and [*,100].
This tells Agent to retrieve only messages about blimps that are 100 lines or less,



Author qualifier and 'not' operator
Edit the filter again to say subject: blimp* and not author: fester and [*,100].



Parentheses for precedence and the 'or' operator
Edit the filter rule to say subject: (blimp* or airship*) and not author: fester and [*,100].



Wildcard example
Create a new kill filter with the following settings:
Search For: subject: *    (All headers will be evaluated.)
Kill Action: Skip
Scope: Group: alt.aviation.methods
Priority: 100    (Make this value lower than the watch filter.    That way, Agent first retrieves the 

messages about blimps because the watch filter has a higher priority, then this kill filter 
tells Agent to skip everything else.)



Using Filter Expressions
Filter expressions are word-based.    An expression is composed of words which are separated by spaces 
or punctuation.    A word is any sequence of letters and/or numbers.    Note:    Words can contain the 
question mark character.
Comparing an expression to a message
When comparing an expression to a message, Agent ignores all punctuation and spaces, and compares 
complete words only.    Click for an example of matching phrases with different punctuation and spaces.

Single word expression
The simplest expression is a single word.    A single word matches a message if Agent finds the complete 
word in either the subject or author field.    The match is normally case-insensitive.      However, you can 
force an exact, case-sensitive match by capitalizing one or more letters in the word.    Click for an 
example.

Expression phrases
You can combine individual words to form phrases.    When matching a phrase, Agent ignores all spaces 
and punctuation in both the filter expression and the message being tested.    Click for an example.

Special words and punctuation
The words and, or, and not have special meanings in Agent.    When included in a filter expression without
quotes (e.g., subject: apples or oranges), these words are treated as expression operators with the 
purpose of comparing information.    When quotes are used (e.g., subject: hide "and" seek), the special 
meaning is ignored and Agent treats the words like normal text.
Similarly, the punctuation and symbols & | ! = [ ] , ( ) : * have special meaning in Agent.    When enclosed 
in quotes, these characters are treated as whitespace.
Important!    Only use quotes when they are appropriate.    The only time you will find it necessary to use 
quotes is when you want words and punctuation with special meaning to be treated as normal text.    Click
for an example of when quotes are appropriate.

Quotes used when pasting subject and author information
When you press the Paste Subject and Paste Author buttons on the Add Usenet dialog box (Message | 
Usenet Filters | Add Kill/Watch Filter), Agent automatically handles quotation marks, as follows:
· The words and, or, and not
· Specific punctuation and symbols

Boolean Expressions
You can use the special words and, or and not to form boolean expressions.    For example, red rose or 
blue carnation matches all messages containing either the phrase red rose or the phrase blue carnation.   
If you prefer, you can also use the special symbols &, |, and ! in place of and, or and not, respectively.    
The operator precedence, highest to lowest, is: not, and, or.    You can use parentheses (...) to change the
precedence.

Subject and author qualifiers
By default, Agent matches an expression against both the subject and the author fields.    You can restrict 
a match to a particular field by preceding the words to be matched with either subject: or author:.    (Note:  
The : must appear immediately after the word, with no intervening spaces.    Otherwise, Agent treats the : 
as a normal punctuation character and ignores it.)    Click for an example.
The subject: and author: qualifiers apply only to the phrase up to the next boolean operator.    Click for an 
example.

Wildcard character
The * character, when appended to a word, creates a wildcard, which matches any word that begins with 
the specified characters.    Click for an example.
Rule:    A wildcard word must contain at least 3 characters.    For example, wi* is not a legal wildcard, but 



win* is.    This restriction allows Agent to test the filters more efficiently.
The * character, when alone, matches everything.
Tip:    Wildcard filters that consist of just * can be very useful if you want to watch certain messages and 
skip all others.    When you use the * expression, you'll usually want to set the filter's priority to the lowest 
possible value, so that the wildcard filter is tested last.
Important!    Don't use quotes when using the wildcard.    This will cause Agent to treat the * as normal 
text.    See Special words and punctuation below for more information.

Exact match operator
If you place the = sign operator in front of a word sequence, Agent will require an exact match of that 
word sequence.    When using the exact match operator, Agent still ignores all punctuation.    Agent also 
ignores any "re:"s that prefix the subject.    Click for an example.
Note:    It will almost never be necessary to require an exact match for an author field.    If you do define an
exact match for an author's name, Agent always compares against the author's full address, even if you're
only displaying the author's full name in the browser.    Click for an example.

Line count ranges
In addition to words and phrases, you can include line count ranges in your expressions.    A line count 
range is a pair of numbers in the form [<low>,<high>].    It tells Agent to match all messages with line 
counts in the range <low> to <high>.

See Also:
How to Create Kill and Watch Filters
Kill and Watch Filter Examples



Identical phrases with different punctuation and spacing
The following phrases are all identical:

Mark F. Sidell <mark.sidell@forteinc.com>
Mark F Sidell mark sidell forteinc com
Mark-F-Sidell-mark-sidell-forteinc-com



Case-sensitivity example
The word

windows
matches 

windows
Windows
WINDOWS

but
WinDows

only matches
WinDows



Wildcard example
The word and wildcard

window*
matches any word that begins with window, including:

Windows
windowing



Expression phrases example
To match the following URL

http://www.forteinc.com/
you can use any of the expressions below:

http":"//www.forteinc.com/
http www forteinc com
http-www-forteinc-com



Pasted words "and", "or", and "not"
The words and, or, and not without quotes are treated as operators in filter expressions.    With quotes 
(i.e., "and", "or", "not"), these words are treated as normal text.    When you press the Paste Subject or 
Paste Author buttons on the Add Usenet dialog box, Agent automatically places quotes around these 
words when they are part of the subject or author information.



Pasted punctuation and symbols
The following punctuation and symbols are converted to a space:

& | ! = [ ] , ( ) * " : <tab> <space>
If there are more than one of these characters in a row, they'll all be converted to a single space.



Punctuation and symbols with special meaning
& This symbol is equivalent to the word and.
| This symbol is equivalent to the word or.
! This punctuation is equivalent to the word not.
= This symbol means an exact match, when preceding a word sequence (e.g., =apple pie).
[ ] This punctuation is used to define a line range (e.g., [*,100] means 100 lines or less).
, This punctuation is used within the square brackets (see above) to establish a line range.
( ) This punctuation is used to establish precedence of operators in compound expressions.
: This punctuation is treated as a subject or author qualifier (i.e., subject:, author:).
* This punctuation is treated as a wildcard.    When attached to words, it matches any additional 

characters attached to the word.    Alone, the wildcard matches anything.



Quoted words example
To match the phrase this and (that), you can use any of the following expressions:
this "and" that
"this and (that)"
this "and" "(" that ")"



Exact match example
For example:

subject: =apple
would match

apple or APPLE!!! or Re: apple or re: re: apple
But it would not match

red apple or apple pie or Orange
If you want to force Agent to do an exact match, but also to include re in the match, you can do something
like the following:

subject: re and =apple
This filter will only match subjects which contain (exactly) apple and which also contain re.



Address comparison example
For an exact match of the address: "jdoe@acmeinc.com(John Doe)", you need to use:

author:= "jdoe@acmeinc.com (John Doe)"
instead of

author:= John Doe



Line range example
The range [10,20] matches all messages with at least 10 lines and no more than 20 lines.
A * in place of one of the numbers is a wildcard.    For example, [*,10] matches all messages with no more
than 10 lines, and [15,*] matches all messages with at least 15 lines.



Subject and author qualifiers example
The expression author: tom gold tells Agent to search only the author field for the phrase tom gold.
You can combine subject and author-specific searches to form boolean expressions.    The following 
expression matches all messages for which the subject contains the word agent and the author contains 
the phrase tom gold.    In addition, the expression matches only those messages with at least 20 lines.
subject: agent and author: tom gold and [20,*]
Note:    The alternative qualifier from: may be used in place of author:.



Qualifiers range
The expression subject: agent and forteinc searches for agent in the subject only, but searches for 
forteinc in both the subject and author.    You can define a field-qualified boolean expression by enclosing 
it in parentheses (...).
For example, for the expression "subject: (agent and forteinc)", Agent searches for agent 
and forteinc in the subject only.



Scroll Lock Behavior
For each pane in Agent, there is a separate Scroll Lock status.    By repeatedly selecting the Scroll Lock 
key, you can enable and disable the scroll lock for each individual pane.    When the scroll lock state is 
enabled, you will see SCRL on the status bar.
Unfortunately, the Scroll Lock light on your keyboard can be erratic.    In Microsoft Windows 95, the 
keyboard scroll lock light is erratic, and in Microsoft Windows NT, an individual program cannot control the
keyboard scroll lock light at all..    So, Agent does not try to keep its own SCRL indicator on the status bar 
in synch with the keyboard light.
For the reasons just described, you need not be surprised or alarmed if the scroll lock indicator light does 
not match the behavior in one of Agent's panes.    Always refer to the status bar to determine whether 
scroll lock is enabled or disabled for the pane in focus.



 Deleting *.IDX and *.DAT Files
In your Agent data directory, you will see a number of .idx and .dat files.    You may have wondered the 
following:
Question: Can I delete the *.idx and *.dat files?
Answer: The answer is that you will do no harm to Agent if you delete the files, except that you will 

lose any group specific properties that you may have set, because they're stored in the IDX 
file.    (This does not affect default properties, just the settings you've overridden for the 
group.)    The program will remember the highest message number for the group, since it's 
stored in the GROUPS.DAT file.
Agent, in fact, automatically deletes IDX and DAT files if you close an empty group for which 
you have not defined properties.    So, the easiest way to delete IDX and DAT files is to view 
the groups in question and simply delete all of their messages.
Note:    To delete these files manually, you have to turn on the [Debugging] ShowUID setting 
to figure out the filenames.
If you have defined properties for the group and delete all of its messages, Agent still does a 
good job of minimizing disk space.    In this case, it deletes the DAT file altogether and 
reduces the size of the IDX file to a minimum size.



Build: 32 bit Agent:
NoFree:    No (Free Agent only topics)
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YesFolders:    Yes (All aspects of folders)
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YesBit32:    Yes (Features only available in the 32bit version)
Forté AgentFullName:    Forté Agent (The long name of the program)
AgentName:    Agent (The short name of the program)
agentLcName:    agent (The lowercase short name of the program)



AGENT.INI
The AGENT.INI file is where you will find most of Agent's settings.    You can edit this file with any text 
editor, as AGENT.INI is a standard Windows INI file.

The default name is AGENT.INI and the default location is the directory C:\AGENT.    However, you can 
change the name and location of your Agent directory, if you wish.

Below are the major categories under which Agent's settings are classified.    Click on the section name 
below to jump directly to that section.
[Address]
[Article]
[Attachment]
[Browser]
[Colors]
[Confirm]
[Debugging]
[Directories] 
[Email] 
[FolderMenu]
[Groups]
[Languages]
[Language <x>]
[Message]
[Online]
[Print]
[Profile]
[Purging]
[Servers] 
[Spelling]
[TimeZone]
[Timing]
[View]

;=====================================================================
[Profile]
FullName="<full name>"
;This setting is the full name as you want it to appear in your
;messages.  You may leave this blank.

EMailAddress="<email address>"
;This setting is your email address.

ReplyTo="<email address>"
;This setting is where replies to your messages should be sent,
;if different from your email address.

Organization="<organization name>"
;This setting is the name of your organization.
;You may leave this blank.

DoAuthorization=0
;When non-zero, Agent will perform authorization login to the news
;server.

SavePassword=1
;When non-zero, Agent will save the authorization password between
;sessions.

UserName="<username>"
;This setting is the news server authorization username.



Password="<password>"
;This setting is the news server authorization password (encrypted).

IsLicensed=1
;When non-zero, you have accepted the license agreement.

Key="<key>"
;This setting is the registration key entered when Agent was first run.
;Do not edit or delete this value or you will not be able to run Agent.

Build="<build>"
;This setting is the exact version and build you are running.

EnableSupportMenu=0
;When non-zero, the Post | Support Question menu option is enabled.
;This setting is to be used by System administrators for site-based
;copies of Agent.

;=====================================================================
[Servers]
NewsServer="<news server name>"
;This setting is the name or IP address of your NNTP news server.

MailServer="<mail server name>"
;This setting is the name or IP address of your SMTP email server.

NNTPPort=119
;This setting controls the winsock port to use for connecting to the
;NNTP news server.  When this value is the standard news server port
;number (119), Agent first asks the winsock driver for the port number
;to use.  If that call (getservbyname) fails, Agent then tries to use
;this port number.  When this value is *not* the standard news server
;port number, Agent uses it instead of the asking the winsock driver for
;the port number to use.

SMTPPort=25
;This setting controls the winsock port to use for connecting to the
;SMTP email server.  When this value is the standard email server port 
;number (25), Agent first asks the winsock driver for the port number
;to use.  If that call (getservbyname) fails, Agent then tries to use
;this port number.  When this value is *not* the standard email server 
;port number, Agent uses it instead of the asking the winsock driver for
;the port number to use.

PopServer="<POP server name>"
;This setting is the name or IP address of your POP server.

POPPort=110
;This setting controls the port to use for connecting to the POP
;server.  When this value is the standard POP server port number (110),
;Agent first asks the winsock driver for the port number to use.  If
;that call (getservbyname) fails, Agent then tries to use this port
;number.  When this value is *not* the standard email server port
;number, Agent uses it instead of the asking the winsock driver for the
;port number to use.

SMTPServerPort=25
;This setting controls the port to use for listening for inbound SMTP 
;connections, used when receiving email via SMTP.  Default is 25.

;=====================================================================
[Groups]
LastUpdate=<date and time>
;This setting shows most recent date and time at which the program
;retrieved a list of new Usenet groups, in GMT.  When the program
;retrieves a list of new groups, it asks for all groups created after
;this date.  Setting this to blank forces the program to retrieve a
;list of all groups.



RefreshMode=1
;This setting is the number associated with the last option selected in
;the Refresh Group List dialog box.

LastFolderSelection=<folder name>
;This setting is the name of the last folder selected with the
;Copy/Move messages dialog (All Folders menu option).

DemonDolt=1
;This setting controls the 'Server creates messages out of order'
;option on the Group Properties Retrieving tab.  When non-zero, this
;setting is enabled and Agent will do XHDR, instead of LISTGROUP.  When
;this setting is zero, Agent will do LISTGROUP.

;=====================================================================
[Online]
AutoDisconnect=1
;When non-zero, Agent will disconnect from news server after
;<NoActivityTimeout> seconds of inactivity.  When zero, Agent
;will never disconnect.

NoActivityTimeout=300
;This setting controls the period of no activity after which the
;program should disconnect from the NNTP server (seconds).

MailAutoDisconnect=1
;When non-zero, Agent will disconnect from the POP email server after 
;<MailNoActivityTimeout> seconds of inactivity.  When zero, Agent will
;never disconnect.

MailNoActivityTimeout=5
;This setting controls the period of no SMTP activity after which Agent
;should disconnect from the SMTP server (seconds).

SendKeepAliveMsgs=1
;When non-zero, Agent will send "keep alive" messages to the news
;server.  This keeps the dial-up connection alive.

KeepAlivePeriod=60
;This setting controls how often to send a keep alive message during
;periods of inactivity (seconds).

XHdrOnly=1
;When non-zero, Agent will use XHDR commands to request message header
;information from the news server, rather than XOVER.  Some servers do
;not support the newer XOVER command, which is faster than XHDR.  Agent
;will automatically detect whether the server recognizes XOVER and
;falls back to XHDR if it doesn't.  But, you can also use this option
;to force it to always use XHDR.

EnablePriorityTask=1
;When non-zero, Agent will enable priority tasks for retrieving message
;bodies.  This allows the program to open two channels to the news
;server, with one reserved as a priority channel for retrieving 
;messages.

AutoView=0
;This setting tells Agent what to do when you double-click a message
;without a body.  The options are:
; 0 Retrieve the message's body
; 1 Mark the message for later retrieval
; 2 Retrieve the body if online, mark for retrieval if offline
; 3 Do nothing

RetryGetHostName=0
;When non-zero, Agent will retry connecting to the host PC, until Agent
;times out.  When zero, Agent will report an error after the first 
;attempt.

RetryConnectAttempts=0



;This setting controls how many times to retry connecting to the server
;after getting any of the following errors:
; - Connection refused (winsock error 10061)
; - Operation timed out (winsock error 10060)
; - 400 Service not available
;When zero, report an error after the first attempt.

RetryConnectPause=30
;This setting controls how long to wait between connection attempts 
;when retrying (seconds).

RetryConnectCloseWinsock=0
;When non-zero, Agent will close winsock after each connection failure
;and reload it before retrying.  If you are using a winsock dialer,
;this causes the dialer to hang up the modem between connection attempts.

UseGetHostName=0
;When non-zero, Agent will use the function gethostname()to obtain the
;name of the host PC itself, for use when logging into SMTP servers.
;When zero, Agent will use the winsock function WSAAsyncGetHostByAddr()
;to obtain the name of the host PC.  This option can be used as a
;workaround for winsock drivers that do not support
;WSAAsyncGetHostByAddr().

EnableMsgIdRetrieval=1
;When non-zero, if Agent fails to retrieve a Usenet message body by
;message number, it will attempt to retrieve it by message ID.  Some
;news servers are slow in responding to message ID requests, so you can
;set this option to zero to disable message ID retrieval.

ErrorTimeout=300
;This setting controls the amount of time Agent waits after displaying
;the online error dialog box before going offline automatically
;(seconds).  Agent does not cancel any online tasks until you confirm
;that you want to do so on the dialog.  If you choose to resume
;processing, Agent will go online again.  This parameter applies only
;if auto-disconnect is enabled (AutoDisconnect=1).

LoadWinsockOnStartup32=0
;When non-zero, Agent will automatically load winsock when starting
;your PC.

RasOpen=0
;When non-zero, Agent will automatically establish a Remote Access
;Server (RAS) dial-up connection before going online.
;
RasOpenPrompt=1
;When non-zero, Agent will prompt before establishing a Remote Access
;Server (RAS)dial-up connection.

RasConnection="<RAS connection name>"
;This setting is the name of the Remote Access Server (RAS) dial-up
;connection to use.

RasClose=1
;When non-zero, Agent will automatically close the Remote Access Server 
;(RAS) dial-up connection after going offline.

RasClosePrompt=1
;When non-zero, Agent will prompt before closing the Remote Access
;Server (RAS)dial-up connection.

RasUserName="<RAS username>"
;This setting is the username to be used for Dial-Up Networking
;(DUN)login (Windows NT only).

RasPassword="<RAS password>"
;This setting is the password to be used for Dial-Up Networking (DUN)
;login (Windows NT only).

RasConnectedTitle="Connected to"



;This setting is the title of the "Connected to..." window that Dial-
;Up Networking(DUN) displays after a connection has been established.
;The window is always displayed in the middle of the screen; so, after
;establishing a dial-up connection, Agent searches for the window and
;automatically minimizes it to get it out of the way.

;=====================================================================
[View]
AutoOpenMode=1
;When non-zero, Agent will automatically maintain positioning in
;subsidiary browsers when the highlight in a browser changes.

ShowToolBar=1
;When non-zero, Agent will display the toolbar at the top of the
;screen.

ShowStatusBar=1
;When non-zero, Agent will display the status bar at the bottom of the
;screen.

StatusBarFont=MS Sans Serif, 80, 0, 0, 0,0,0
;This setting controls the font used for text in the status bar.
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

InitialView=1
;This setting controls what displays in the initial view for the
;Groups/Folders pane.  The options are:
; 0 All Groups
; 1 Subscribed Groups
; 2 New Groups
; 3 Folders 

MainWindowPosition="0 1 -1 -1 -4 -4 86 57 875 677"
;This setting controls initial screen position of the program's main
;window.

BrowserPosition="3 3 94 347 -4 -23 15 18 663 348"
;This setting controls the initial screen position of the browser.

ProgressStyle=0
;This setting controls the format of the graphical online task 
;progress indicator in Agent's Status Bar.  The options are:
; 0 Display the progress indicator in its own box on the Status Bar.
; 1 Display the progress indicator in its own box, and include text
; showing the percentage of the task completed so far.
; 2 Display, in its own box, text showing the percentage of the task
; completed so far without a graphical progress indicator.
; 3 Display the graphical progress indicator over the text describing
; the current task.
; 4 Do not display the progress indicator.

ProgressDelay=1000
;This setting controls how long to wait when the percent complete
;changes from a zero to a non-zero value, before updating the online
;task progress indicator display (milliseconds).  Once the delay
;threshold has been exceeded, Agent updates the display continuously.
;This delay causes Agent to not display the progress indicator for
;extremely short operations, such as downloading short message bodies.

GroupPropTab=0
;This setting shows the tab last displayed in the Properties for
;Selected Groups dialog box (Group menu).  The next time you open this
;dialog box, Agent will display this tab.

DefGroupProp=0
;This setting shows the tab last displayed in the Default Properties
;for All Groups dialog box (Group menu).  The next time you open this
;dialog box, Agent will display this tab.

PrefsTab=0



;This setting shows the tab last displayed in the Preferences dialog
;box (Options menu).  The next time you open this dialog box, Agent
;will display this tab.

InboundTab=0
;This setting shows the tab last displayed in the Inbound Email dialog
;box (Options menu).  The next time you open this dialog box, Agent 
;will display this tab.

Win95=0
;When running under Windows NT, Agent normally turns off all of its
;Windows 95 features.  But, if you set value to 1, Agent will pretend
;that it really is running under Windows 95.  This allows you to turn
;on the Windows 95 features if you are running the beta version of the
;Windows 95 shell for Windows NT.

;=====================================================================
[Browser]
NormalFont=Arial, 80, 0,0, 0,0,0
;This setting controls the font for normal items.
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

BoldFont=MS Sans Serif, 80, 1,0, 0,0,0
;This setting controls the font for special items (e.g., first message
;in thread).
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

ScrollMargin=2
;This setting controls the minimum number of lines to maintain above
;and below the highlighted item when scrolling with the cursor keys.
;This keeps the highlight from getting pinned at either the top or
;bottom screen rows.

FollowUpIndent=4
;This setting controls the amount to indent follow-up messages in the
;Message List pane (characters).

MaxNestLevel=6
;This setting controls the maximum indentation level for response
;messages in the message list browser.  The maximum level is 15.

CollapseThreads=1
;When non-zero, Agent will initially collapse threads in the Message 
;List pane.

ExpandNewThread=1
;When non-zero, positioning on a new message automatically expands the
;thread if the message is a follow-up and if the first message in the
;thread has been retrieved.

SubjectThreading=1
;When non-zero, Agent will use subjects to combine messages into
;threads, in addition to message references.

ArticleListColumns=<n>,<n>,<n>
;This setting offsets the left edges of the columns in the Message
;List pane (units of 10x the average character width).
;The edge of the left-most column is always 0, so is not included here.

OutBoxColumns=87,432,697
;This setting offsets the left edges of the columns in the Outbox
;browser (units of 10x the average character width).
;The edge of the left-most column is always 0, so is not included here.

NewSubjectStartsNewThread=1
;When non-zero, a follow-up message that contains a different subject
;than its referenced message starts a new thread.  When zero, Agent
;will include the follow-up in its referenced message's thread.

ViewLaunchesBinary=1



;When non-zero, if a message has been saved as a binary attachment,
;double-clicking or pressing Enter on the message launches the
;attachment.

NextStaysInPane=1
;When non-zero, Agent will keep the focus in the same pane when
;skipping between messages in different groups or folders.

MarkSkipsToNextUnread=1
;When non-zero, marking a message causes Agent to skip to the next
;unread message.

WatchSkipsToNextUnread=1
;When non-zero, watching an unread message causes Agent to skip to the
;next unread message.

SkipGroupMarksRead=1
;When non-zero, skipping to the next unread group causes Agent to mark
;all messages in the current group read.

RightButtonSelects=1
;When non-zero, clicking a group, folder, or message header with the
;right mouse button selects the item and displays a context sensitive 
;menu.

ShowUnreadOnly=0
;This option is to be implemented in a future version.

ShowBodiesOnly=0
;This option is to be implemented in a future version.

SortDateDescending=0
;When non-zero, do date sorts descending.  Default is zero (ascending).

SortSizeDescending=0
;When non-zero, do size sorts descending.  Default is zero (ascending).

ScrollLock=0
;When non-zero, you can press the scroll lock key, allowing you to 
;navigate in the browser, using the arrow keys.  You can use this
;feature to edit text in the browser.

AuthorModeZoomed=0
;This option is to be implemented in a future version.

AuthorModeUnZoomed=0
;This option is to be implemented in a future version.

MarkReadMode=1
;This setting controls when Agent marks messages read.  The options
;are:
; 0 Whenever the message body is visible in the Message pane
; 1 Only when the Message pane is selected
; 2 Never mark read
SingleKeyViewsBody=1
;This setting controls the Single Key Read option on the Navigation
;tab of the General Preferences dialog box.  When non-zero, the 
;speedkey (Space) is enabled.  The effect of this speedkey (when the
;Groups or Message List panes have the focus) is the same as View Next
;Unread Body command.

;=====================================================================
[Article]
VariableFont=MS Sans Serif, 100, 0,0, 0,0,0
;This setting controls the variable-pitch font for the message body
;viewer.
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

FixedFont=Courier, 100, 0,0, 0,0,0
;This setting controls the fixed-pitch font for the message body



;viewer.
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>.

UseFixedFont=1
;When non-zero, Agent will use the fixed-pitch font for messages.

WordWrap=1
;When non-zero, Agent will word wrap messages.

ShowHeader=1
;When non-zero, Agent will show all header fields in messages.

QuotedTextMarkers=>:|}
;This setting controls the characters that mark a quoted line of text
;in a message.  If a line begins with any of these characters, it is
;assumed to be quoted.

URLPattern=[a-zA-Z]+:/[^ \t\r\n>)\]"']*[a-zA-Z0-9/]
;This setting is the regular expression defining the pattern for URLs.

TabSpacing=3
;This setting controls the tab spacing for messages.

SaveArticleFields=2
;This setting controls which header fields to save when writing a
;message to a text file.  The options are:
; 0 No fields
; 1 Selected header fields
; 2 All fields

SaveArticleAppend=1
;When non-zero, if the file to which a message being saved already
;exists, Agent will append to it.  When zero, Agent will overwrite the
;file after prompting for verification.

PageDownMode=0
;This setting controls the behavior of the Page Down key in the Message
;pane.  When non-zero, you cannot page down if the last line of the
;message is visible.  When zero, you can page down if the last line of
;the message is visible.

ShowFullAddress=0
;When non-zero, Agent will show the full email address of the author in
;the Message pane and header.

NewsBaseFields="<fields>"
NewsAllFields="<fields>"
MailBaseFields=!to,!subject,!from,!date,cc,bcc
MailAllFields="<fields>"
;These settings control which header fields are displayed at the top of
;the message body.  The News* params control Usenet messages, and the
;Mail* params control email messages.  The *Base* params control the
;fields that are displayed when option Show Header Fields is off, and
;the *All* params control the fields that are displayed when the option
;is on.  Each param may contain a list of comma-separated field names.
;The fields are displayed in the order listed.  If a field name is
;preceded with a !, then the field is always displayed.  Otherwise, the
;field is displayed only if it is actually contained in the message.
;If a *Base* param is empty, then no fields are displayed when Show
;Header Fields is off.  If an *All* param is empty, then all fields are
;displayed when Show Header Fields is on.

SaveArticleFormat=0
;This setting controls formatting of the text file when saving
;messages.  The options are:
; 0 UNIX message file format
; 1 Include a separator line before each message
; 2 No separators before messages

SaveArticleSeparator="========\n"
;This setting controls the separator to be used when the setting



;SaveArticleFormat=1.

SaveArticleFieldList="To,Subject,From,Date,Cc,Bcc"
;This setting shows a comma-separated list of fields to be included in
;saved messages when SaveArticleFields=1.  Agent includes a field only
;if it is actually defined in the message.

ImportUseXFolder=1
;When non-zero, if a message being imported begins with an X-Folder
;field, Agent will place the message in the specified folder.

ImportCreateFolders=1
;When non-zero, Agent will automatically create a folder for messages
;imported with an X-Folder field.

ImportFileMode=0
;This setting controls how Agent decides where to place imported
;messages.  Note: If ImportUseXFolder=1, any X-Folder field in a
;message overrides this setting.
;When non-zero, Agent will file all messages in the folder specified by
;ImportFileFolder. When zero, Agent's Filing filters to file messages
;based on content.

ImportFileFolder="<folder name>"
;This setting is the name of the folder to be used when the setting
;ImportFileMode=1.

;=====================================================================
[Attachment]
PartitionMode=1
;This setting controls how attachment messages are partitioned.
;When non-zero, do not partition (send as a single message). When zero,
;partition into messages (AttachmentPartitionSize controls size)

PartitionLines=10000
;When attachment messages are partitioned, this setting controls the
;maximum number of lines of data to send per message.  Each line
;contains 45 bytes of data, and consists of 63 characters.

TextMode=0
;This setting controls if and how text is sent with attachments.  The
;options are:
; 0 Send text as separate preface message
; 1 Include text at beginning of first partition message
; 2 Send no text

FileMode=644
;This setting controls the UNIX file mode for attachment files.  This
;is a string.  It is the mode that is included at the top of the 
;uuencoded file.

NameConversionMode=0
;This setting controls how attachment filenames are converted.  The
;options are:
; 0 No conversion unless required
; 1 Convert when writing to a FAT volume, even if volume supports
; filenames
; 2 Always convert to 8.3 name

SubjectPattern="[(\[ ][0-9]+ */ *[0-9]+[)\] ]|[(\[ ] [0-9]+ *of
;*[0-9]+[)\] ]|[(\[ ] [0-9]+ */ *[0-9]+$|[(\[] [0-9]+ *of *[0-9]+$|"
;This is the regular expression that controls how Agent searches for
;message headers containing multi-part attachments.

;=====================================================================
[Purging]
;The parameters in this section can be modified within Agent from the
;What to Purge tab on the Default Group Properties dialog box and the
;When to Purge tab on the Default Group Properties dialog box.



PurgeByNumber=1
;This setting controls how Agent's purge operation determines
;whether a message is no longer available.
;When non-zero, Agent will download headers and purge based on those.
;When zero, Agent will purge based on message range reported by the 
;server.

PurgeOnNewHeaders=1
;When non-zero, Agent will purge messages when getting new headers.

PurgeOnExit=1
;When non-zero, Agent will purge messages when exiting Agent.

CompressOnPurge=0
;When non-zero, if Purge Messages is selected from the Group menu, 
;Agent will compact the databases being purged.  Note: A database is
;compacted only when the percent of disk space saved is greater than
;the value of the CompressPercent parameter.

CompressOnExit=0
;When non-zero, Agent will compact all databases when Agent closes.
;Note: A database is compacted only when the percent of disk space
;saved is greater than the value entered in the "Compact only if wasted
;space at least..." field below.

CompressPercent=20
;Before compacting a database, Agent will check to see how much disk
;space would be saved by the compact operation.  This setting allows
;you to bypass the operation if only a small amount of disk space
;would be saved.  Enter the minimum amount of disk space savings, as a
;percentage of the total size of the database, that will cause Agent
;to perform an automatic compaction after either a manual purge
;and/or an automatic purge during exit.

ConfirmPurgeOnExit=1
;When non-zero, Agent will require confirmation before purging and/or
;compacting databases when program is closed.
;When zero, Agent will purge and/or compact the databases without
;asking first.  Note: To purge or compact databases on exit, be sure
;to enable PurgeOnExit and/or CompressOnExit.

AlwaysPurgeUnavailable=1
;When non-zero, if one of the "When the message is no longer available"
;purge options is selected, Agent will purge messages that are no
;longer available during get new headers, even if the "Purge when
;retrieving new headers" setting is disabled (zero).  This setting
;can't be set within Agent.

;=====================================================================
[Message]
UseFixedFont=1
;When non-zero, Agent will use the fixed-pitch font for outgoing 
;messages.

WordWrap=1
;When non-zero, Agent will word wrap outgoing messages in the display 
;window.

IncludeOriginalText=1
;When non-zero, Agent will automatically include the text of the
;original message when creating a follow-up message or email reply.

QuotePrefix="> "
;This setting is the string used to quote text from the original
;message when creating a follow-up message or email reply.

FollowupString="%from% wrote:\n"
;This setting is the string used to generate the first line(s) of a
;follow-up message.  This value should be defined directly from Agent.
;For more information, see Composing an Introduction String.



;If the string is blank, no first line is generated.
;
;The text enclosed in %...% are the names of fields from the original
;message.  Two %% represent a single % literal.
;
;In addition to the standard message fields, the program supports these
;special fields:
; %Full-Name% Full name of author
;
;You may also use the following escape sequences:
; \n newline
; \t tab
; \\ the backslash character itself

ForwardString="In %newsgroups%, %from% wrote:\n"
;This setting is the string used to generate the first line(s) of a
;forwarded Usenet message.  If the string is blank, no first line is
;generated.  Uses the same formatting commands as FollowupString.

MailReplyString="On %date%, you wrote:\n"
;This setting is the string used to generate the first line(s) of an
;email reply.  If the string is blank, no first line is generated.
;The string uses the same formatting commands as FollowupString.

MailReplyMailString="On %date%, you wrote:\n"
;This setting is the introduction string for email replies to email
;messages.  If the string is blank, no first line is generated.  The
;string uses the same formatting commands as FollowupString.

ForwardString="On %date%, %from% wrote:\n"
;This setting is the introduction string for forwarded email messages.
;If the string is blank, no first line is generated.  The string uses
;the same formatting commands as FollowupString.

LineLength=70
;This setting controls the maximum line length for outgoing messages.
;Agent will word-wraps longer lines.
;Setting this to zero disables word-wrap in outgoing messages.

SaveSentMessages=1
;When non-zero, Agent will save messages that have been successfully
;posted in the outbox.

GMTDates=1
;When non-zero, Agent will post all messages and emails in GMT format
;rather than your local timezone.

CurrentGroupOnly=1
;This setting controls which newsgroups are included by default for
;follow-up posts.  Note: If the referenced message includes a
;Followup-To field, Agent will always list the groups from that field,
;independent of this option.
;When non-zero, if the referenced message does not contain a
;Followup-To field, and this option is non-zero, Agent will include
;just the name of the group that was selected when the follow-up
;message was created.  When zero, Agent will include all groups listed
;in the referenced message's Newsgroups field.

ValidateAddresses=1
;When non-zero, Agent will try to validate all email address fields
;(To:, Cc:, Bcc:, From:, Reply-to:, and Sender:) in messages that you
;send.  When non-zero, non-standard addresses may be entered.

ShowAllFields=0
;When non-zero, Agent will allow editing of the Control and Approved
;message fields.

GenerateID=1
;When non-zero, Agent will generate Message IDs when posting messages.

;=====================================================================



[Directories]
Attachments="C:\agent\, *.txt, 0"
;This setting shows the last directory selected in the Attach Binary
;File dialog box.  The third parameter is the listbox index of the
;file-type filter (e.g.,"*.TXT") that was last selected in the dialog 
;box.

Files="C:\agent\, *.txt, 1"
;This setting shows the last directory selected in the Save Messages As
;and the Import Messages dialog boxes.  The third parameter is the
;listbox index of the file-type filter (e.g., "*.TXT") that was last 
;selected in the dialog box.

Signatures="C:\agent\, *.txt, 1"
;This setting shows the last directory selected in the Select Signature
;File dialog box.  The third parameter is the listbox index of the
;file-type filter (e.g.,"*.TXT") that was last selected in that dialog 
;box.

Home=<directory>
;This setting shows the directory where Agent's database files and
;custom dictionaries are stored.  If this parameter's value is blank
;(the default), Agent looks for these files in the directory containing
;AGENT.INI.  Note: Changing this setting does not move your files.  Use
;File Manager to move all the files (*.IDX, *.DAT, and CUST*.TLX) to
;the new location and then restart Agent for this change to take 
;effect.

Shared=<directory>
;This setting shows the directory where Agent's help file and master
;dictionaries are stored.

WAVFiles=<directory>
;This setting shows the last directory selected in the Select WAV File 
;dialog box. 

;=====================================================================
[Colors]
BrowserNormalColor=0,0,0
;This setting controls the color for normal messages.
;<red>,<green>,<blue>

BrowserUnreadColor=128,0,0
;This setting controls the color for unread messages.
;<red>,<green>,<blue>

BrowserSelectedUnreadColor=255,255,0
;This setting controls the color for unread messages that are selected
;(highlighted).  Normally, this should be the inverse of the Control
;Panel's highlight color.
;<red>,<green>,<blue>

ArticleNormalColor=0,0,0
;This setting controls the color for normal text in messages.

ArticleQuotedColor=0,0,255
;This setting controls the color for quoted text in messages.
;A line is quoted if it begins with one of the QuotedTextMarkers.

KillColor=128,0,0
;This setting controls the color that kill filter actions appear on the
;Usenet Filters window.

WatchColor=0,128,0
;This setting controls the color that watch filter actions appear on
;the Usenet Filters window 

;=====================================================================



[Confirm]
DeleteGroup=1
;When non-zero, Agent will confirm group deletions.

StopTasks=1
;When non-zero, Agent will confirm actions that would cancel active 
;online tasks.

DeleteArticle=1
;When non-zero, Agent will confirm message deletions.

DeleteOpenMessage=1
;When non-zero, Agent will confirm closing the message composition
;window if you have modified the message.

DeleteOutboxMessage=1
;When non-zero, Agent will confirm message deletions in the outbox.

CloseWithTasks=1
;When non-zero, Agent will confirm program close when tasks are 
;running.

DefaultAction=0
;This setting controls the default button in confirmation dialog boxes.
;When zero, the default is No; when non-zero, the default is Yes.

MarkAllRead=1
;When non-zero, Agent will confirm the Mark All Messages Unread and
;Mark All Messages Read commands.

LaunchEXE=1
;When non-zero, Agent will confirm the launching of executable 
;attachments.

SendOnClose=1
;When non-zero, Agent will confirm sending queued messages when you
;exit Agent.  You can set this action to "1" by selecting
;Preferences from the Options menu and checking the Send queued
;messages option on the Confirmations tab.

MarkAllGroupsRead=1
;When non-zero, Agent will confirm marking all messages from all groups
;read.  You can set this action to "1" by selecting Preferences from
;the Options menu and selecting Mark all messages in & All groups read
;or unread on the Confirmations tab.

;=====================================================================
[TimeZone]
AssumeLocal=1
;When non-zero, Agent assumes local time if a downloaded message does
;not specify a timezone in its Date field.
;When zero, Agent assumes Greenwich Mean Time (GMT).

;=====================================================================
[Print]
LeftMargin=75
TopMargin=75
RightMargin=75
BottomMargin=75
;These settings control the margins for printing (1/100 inch
;increments).

Fields=1
;This setting controls the header fields Agent will include in printed 
;messages.  The options are:
; 0 No fields
; 1 Subject, author, and date only



; 2 All fields

PageBreaks=0
;This setting controls where to put page breaks.
; 0 None
; 1 Between messages
; 2 Between threads

Font=Times New Roman, 100, 0,0, 0,0,0
;The printer font.

;=====================================================================
[Email]
Mode=<n>
;This setting shows the type of server used to receive email.  The 
;options are:
; 0 SMTP (Simple Mail Transfer Protocol)
; 1 POP (Post Office Protocol)

AutoCheck=1
;When non-zero, Agent will automatically check for email periodically.

POPAccount=
;This setting shows the POP account name.

SavePOPPassword=0
;When non-zero, Agent will save the POP password between sessions.

POPPassword=
;This setting shows the saved POP password.

AlertBox=1
;When non-zero, Agent will display a message box when new email arrives.

AlertSound=1
;When non-zero, Agent will play a sound when new email arrives.

AlertSoundFile=<wav file name>
;This setting controls the name of the WAV file to play for the email
;alert sound.  This may also be the name of a sound listed in the
;WIN.INI [Sounds] section.  If this is blank, Agent will simply beep.

AutoCheckPeriod=0
;This setting controls how often to check for email (minutes).

AutoCheckMode=0
;This setting controls the condition required to automatically check 
;for email.  The options are:
; 0 Only when online for some other reason.
; 1 All the time.  (Unload winsock between checks.)
; 2 All the time.  (Leave winsock loaded between checks.)

LeaveOnServer=0
;When non-zero, Agent will leave email on the POP server after 
;retrieving it.

SkipLong=0
;When non-zero, Agent will skip long email messages.

SkipLongKBytes=64
;This setting controls messages' size threshold for the SkipLong 
;setting (kilobytes).

SkipLongLines=20
;This setting controls the number of body lines to retrieve for 
;messages being skipped.

AutoDecode=1
;This option is to be implemented in a future version.



AutoDecodeDirectory="<string>"
;This option is to be implemented in a future version.

MaxSMTPSessions=2
;This setting controls the number of clients Agent will allow to
;connect simultaneously when receiving email with an SMTP (Simple Mail 
;Transfer Protocol) server.

SMTPAlways=0
;When non-zero, if you are configured to receive email with SMTP, Agent
;will load winsock immediately on program startup and start the SMTP 
;task.

;=====================================================================
[Spelling]
AlwaysSuggest=1
;When non-zero, the spell checker will automatically suggest possible
;replacement words.

CheckRepeatedWords=1
;When non-zero, the spell checker will stop when it finds the same word
;twice in a row.

IgnoreNumeric=1
;When non-zero, the spell checker will ignore words containing numbers.

IgnoreUpperCase=1
;When non-zero, the spell checker will ignore words composed of all
;uppercase letters. 

IgnoreQuotedLines=1
;When non-zero, the spell checker will ignore words which appear on
;lines beginning with a quote character (as defined by the Quoted Text
;setting on the Preferences dialog box's Display tab).

;=====================================================================
[Timing]
GetHostByNameTimeout=30
;This setting controls the timeout period for looking up the host's 
;name (seconds).

ConnectTimeout=10
;This setting controls the timeout period for connecting to the host 
;(seconds).

ResponseTimeout=120
;This setting controls the timeout period for waiting for a response 
;from the host (seconds).

SendTimeout=60
;This setting controls the timeout period for sending a command to the
;server (seconds).  This is the maximum time the program will wait
;during a blocked transmission, not the total time allowed to send a 
;message.

PostTimeout=60
;This setting controls the timeout period for posting a message or
;email message (seconds).  This is the maximum time the program will
;wait during a blocked transmission, not the total time allowed to send 
;a message.

PostResponseTimeout=360
;This setting controls how long Agent will wait for an
;acknowledgment from the server after posting a message or email 
;message (seconds).

SMTPSessionTimeout=300
;This setting controls how many seconds of inactivity to allow on an



;SMTP (Simple Mail Transfer Protocol) receive email session before
;cancelling and closing the session.

;=====================================================================
[Debugging]
ShowUID=0
;When non-zero, Agent will show the group/folder UIDS in the Groups
;pane.  This number is the base filename for each group's IDX and DAT 
;files.

VerboseLog=0
;When non-zero, Agent will include extra information in the log window,
;including a script of Agent's conversation with the news server, and
;task state machine transitions.

FileLog=0
;When non-zero, Agent will write log output to AGENT.LOG.  The contents
;of this file are erased at the start of each Agent session.

TraceLog=0
;When non-zero, Agent will send log output to the Windows debugging
;console, so that it appears in programs like DBWIN.

TraceHelp=0
;When non-zero, Agent will send a debugging statement to the Windows
;debugging console each time Agent sends a request for online help.

ShowArticleDetail=0
;When non-zero, Agent will show some detailed information about
;messages at the bottom of the Message pane.  In particular, this shows
;the message's number as reported by the news server.

ShowMemUsage=0
;When non-zero, Agent will show the total number of allocated blocks in
;the status bar.  This option is used to check for memory leaks.

EnableTrace=0
;When non-zero, Agent will enable debugging trace statements to be sent
;to the Windows debugging port.

WinsockLog=0
;When non-zero, all winsock calls are written to AGENT.LOG.

EnableMenu=0
;When non-zero, Agent will display the debugging menu options.  You can
;also toggle the display of debug options by pressing Ctrl+Shift+D in 
;Agent.

ShowBuild=0
;When non-zero, Agent will display the build number in the title bar
;and About dialog box.

ShowInternalFields=0
;When non-zero, Agent will display internal fields in the Body pane.

MemSafetyLevel=3
;This setting controls the level of Agent's memory tests and 
;validations.  Below are the possible settings:
; 2 (fast) Parameters are fully validated, leading and trailing
; guards are set and tested, and free blocks are filled.  This 
; setting creates minimum runtime impact and catches most common 
; runtime errors.
; 3 (slower)  In addition to the above checks, this setting fills all 
; newly allocated blocks with the in-use pattern.  This level is 
; slower than 2, but generally is only a factor of 2 or 3 slower 
; than the non-debug heap manager.
; 4 (slowest)  The entire memory pool associated with a call is 
; validated on each entry point to the heap manager.  This setting 
; can be very slow, but it is effective at pin-pointing memory 
; overwrites.



MemCheckFrequency=10
;If MemSafetyLevel=3, this setting controls how often the program 
;checks for overwrites.  The default 10 checks every tenth time a heap-
;related function is called.

MemDeferFreeing=1
;When non-zero, freed locations are filled with the free fill value.  
;However, instead of returning these allocations to the free pool for 
;reuse, the manager adds them to the queue of defer-freed allocations.
;Defer=freed allocations remain in the queue until you free them or 
;until the queue fills up and the oldest allocations in the queue are
;freed up automatically.  This option uses more memory, but helps to 
;detect reuse of already freed allocations.

MemDeferQueueLength=1000
;This setting controls how many freed allocations to queue before
;actually freeing the oldest ones for reuse.

MemDeferSizeThreshold=4096
;When MemDeferredFreeing is enabled (non-zero), allocations larger than
;the threshold are freed immediately, to prevent consuming too much 
;memory.

;=====================================================================
[Languages]
enu=English (American),0,custenu.tlx,mainenu.tlx,mainenu.clx
eng=English (International),0,custeng.tlx,maineng.tlx,maineng.clx
frn=French,1,custfrn.tlx,mainfrn.tlx,mainfrn.clx
ger=German,0,custger.tlx,mainger.tlx,mainger.clx
spa=Spanish,0,custspa.tlx,mainspa.tlx,mainspa.clx
itn=Italian,0,custitn.tlx,mainitn.tlx,mainitn.clx
;These settings allow you to customize the way text appears in the 
;panes.  It also allows you to customize spell checker's dictionaries.
;Each setting in this section has the following format:
;<id>=<name>,<apostrophe-flag>,<custom>,<master1>[,...<masterN>]
;
;<id> is a three-letter language ID, which uses the same convention as
;WIN.INI.
;
;<name> is the name of the language as displayed in Agent.
;
;<0 or 1 flag> indicates whether an apostrophe should be considered a 
;word separator.  When set to 1, if a word containing embedded 
;apostrophes is not found in any dictionary, treat the apostrophe as a
;word separator and check each sub-word individually.  Note: Normally,
;this flag is set only for French, in which it is common to create new
;words by combining words with apostrophe.
;
;<custom> is the name of the custom dictionary.   By convention, this
;file is named CUST<id>.TLX.  If the filename has no path, look for
;the file in the Home directory.  If the file does not exist, create
;it.
;
;<master> is the name of one or more master dictionaries.  You can list
;up to 12 files.  When checking words, search the dictionaries in the
;order listed.  By convention, the common words file is named
;MAIN<id>.TLX and the compressed words file is named MAIN<id>.CLX.  If
;the filename has no path, look for the file in the shared directory.
;If none of the master dictionaries for a given language exist, assume
;that the language is unavailable, and remove it from the list of 
;available languages in the UI.

Name=English
;This setting controls the names applied to languages added to the
;Languages list.

UID=<unique ID number>
;This setting identifies the unique ID.



;=====================================================================
[Language <x>]
;Warning!  Do not modify this section manually, particularly the UID 
;value.

Name=%s
;This setting controls the name of the currently selected language.

UID=<unique ID number>
;This setting is the unique ID that Agent uses to identify
;the language being used.  Caution.  Changing this setting may cause
;the language functions not to work properly.

Spell=enu
;This setting controls the language to be used for the Spellchecker.

OldSpell=enu
;When you upgrade, Agent automatically creates a Language for each 
;Spellchecker that was installed.  The OldSpell setting is the name
;of the Spellchecker that was used to create that Language<x> entry.

ListUseVariable=0
;When non-zero, Agent will use the font selected for message
;bodies using a variable-pitch font.

SubjectUseList=0
;When non-zero, Agent will use the bold version of the font
;selected for the Message List for the message subject.

List=MS Sans Serif, 80, 0, 0, 0, 0
;This setting controls the font used in the Message List pane.

Subject=MS Sans Serif, 80, 1, 0, 0, 0
;This setting controls the type of font used for subjects in the
;Message List pane.

Variable=MS Sans Serif, 100, 0, 0, 0, 0
;This setting controls the variable-pitch font used in message bodies.

Fixed=Fixedsys, 100, 0, 0, 0, 0
;This setting controls the fixed-pitch font used in message bodies.

Printer=Times Roman, 100, 0, 0, 0, 0
;This setting controls printer font used for printing browsers and 
;messages.

;=====================================================================
[FolderMenu]
Menu1+
...
MenuN=
;This setting shows a list of the folders that appear on the Copy/Move
;to Folder flyouts.  The names of the options (Menu1, etc.) don't
;matter.  Agent simply uses the first none items from the list to 
;populate the flyouts.

;=====================================================================
[Address]
Position="0 1 -1 -1 -1 -1 144 94 501 513"
;This setting controls the position of the Pick Addresses dialog box
;when it is opened.

Book="<book name>"
;To be implemented in a future version, when Agent supports multiple
;address books.

Name="Jane Doe"
;This setting shows the last name highlighted in the Address Book, used



;to reposition the list the next time you open the window.

FindText="<text string>"
;This setting shows the last text string on which you have searched.

FindMode=4
;This setting identifies the set of bits recording the checkbox
;settings for the last Find operation in the Address Book.

Import/Replace=0
;When non-zero, Agent will replace a duplicate entry when importing
;data.

Expand=0
;When non-zero, Agent will expand the selection in the Pick Address
;dialog box to the full address format.  This also enables the Expand
;option on the Address menu.



Build: 32 bit Agent:
NoFree:    No (Free Agent only topics)
YesOrder:    Yes (How to order Agent)
NoMSMain:    No (Newsreader Contents Graphic)
NoCRight:    No (Microsoft's copyright page statement)
NoFreeTech:    No (Free Agent Tech Support info)
YesMail:    Yes (Receive email topics)
YesFolders:    Yes (All aspects of folders)
YesAddBook:    Yes (Address Book topics)
YesSpelling:    Yes (Spell check topics)
YesSorting:    Yes (Sorting topics)
YesBit32:    Yes (Features only available in the 32bit version)
Forté AgentFullName:    Forté Agent (The long name of the program)
AgentName:    Agent (The short name of the program)
agentLcName:    agent (The lowercase short name of the program)



Release Notes
This topic describes the features most recently added to Agent.    For a more comprehensive set of 
release notes, please check Forté's Web pages (http://www.forteinc.com/forte/).

Version 1.00
Improved the Purging option to give you more control over which articles are purged.    Also, you can now 
purge groups manually, and automatically on program exit.    For details, see the Purging tab of the 
Properties for Selected Group dialog box.

Added an option to compact the databases.    To compact your databases, choose Compact Databases 
from the File menu.

Significantly improved download, threading, and purging performance.    Now, purging most groups should
only take a few seconds at most.

You can now send an email carbon copy (CC) when you post an article.    This is especially useful when 
you want to post a follow-up response and email the original author at the same time.    For more 
information, see Compose Article window.

Moved some commands from the File menu to a new Options menu and the Window menu.    Commands
that control program configuration are now on the Options menu.    Commands that open new windows 
are now on the Window menu.

Agent now allows you to edit all header fields (Distribution, Keywords, etc.) for messages you send.    For 
more information, see Compose Article window and Compose Email window.

You can now mark an article unread while you are viewing its body.

Selecting Watch Thread on an unread    article now skips to the next unread article.    You can disable this 
option with the Navigation tab of the Preferences dialog box.

You can now control whether or not Agent should validate email addresses in your messages.    For 
details, see the Message Posting tab of the Preferences dialog box.

You can now cancel a post after you send it.    To cancel a post, highlight the article in the Article pane and
choose Cancel Article from the Article menu.

Agent now accepts a command line parameter to specify the location of AGENT.INI.    E.g., agent 
<path>.    The optional <path> argument can be either the directory containing AGENT.INI or the name of
the INI file to use as AGENT.INI.

· If no <path> is specified, Agent looks for AGENT.INI in the current working directory.    If the file 
doesn't exist, Agent creates it.

· If <path> is a filename, Agent uses that file as AGENT.INI.    If the file doesn't exist, Agent creates it.
· If <path> is a directory, Agent looks for AGENT.INI in the specified directory.    If the file doesn't exist, 

Agent creates it.    Note: If the directory doesn't exist, Agent assumes that you are specifying a 
filename.    You can prevent this from happening by appending a \ to the end of the directory name to 
force Agent to always treat it as a directory.      For example: c:\agent\.

Added support for Spry's winsock dialer.    This fixes problems using Agent with Internet in a Box and 
CompuServe.    You no longer have to manually start the Spry dialer prior to having Agent go online.

Agent is now less strict when searching for the articles composing a binary attachment.    It ignores case 
and leading/trailing whitespace when comparing the article subjects.

Added "Delete Body" to the Article menu.    Select this option to delete the selected article's body but not 
its header.

Add drag-select support to highlight multiple groups or articles with the mouse.    Just click and drag the 
mouse over the groups or articles.

Agent now starts a new thread when a follow-up article has a different subject than the original.    You can 
control this behavior with the Navigation tab of the Preferences dialog box.



Agent's dialog boxes now have the correct 3D look when running in Windows 95.

After unsubscribing to a group or leaving a group you just sampled, Agent now asks if you want to keep 
the group's articles.    If you say "No," it will immediately delete articles in the group.    This feature helps 
you delete unwanted database files from your disk.

Agent now includes all newsgroups from the original article when you post a follow-up to a cross-posted 
article.    This option is controlled by an AGENT.INI parameter: 

[Message]
CurrentGroupOnly=0

Added a confirmation message when you mark all the articles in group as read or unread.    You can turn 
this message off from the Confirmations tab of the Preferences dialog box.

Agent can now retry refused connections that can occur when the news server is very busy.    For details, 
see the Online tab of the Preferences dialog box.

Added context menus to the Composition and Outbox windows.    Context menus are activated by clicking
the right mouse button.

Add a preference option for selecting which mouse button selects items from the context menu.    See the 
Navigation tab of the Preferences dialog box for details.

Skipping to the next unread article from the Group pane now moves the focus to the Article pane for the 
next group with an unread article and selects that article.    You can disable this behavior by unchecking 
the "Skipping to next unread article jumps..." box on the Navigation tab of the Preferences dialog box.

Agent now adds a leading zero when posting multi-part attachments.    E.g., [04/15].

When an article does not contain a timezone, Agent now assumes local time.    It used to assume GMT.    
This feature is controllable via an AGENT.INI parameter:

[TimeZone]
AssumeLocal=1

Choosing Get Selected Article Bodies when a collapsed thread is selected now retrieves the bodies of all 
the articles in the thread.

You can now specify a location for your database files (*.IDX and *.DAT).    To keep your database files in 
a directory other than Agent's normal working directory, edit the Home parameter in the [Directories] 
section of AGENT.INI.

Ctrl+A now works in the Outbox window.

Added an option to AGENT.INI to override the Port numbers used for the NNTP and SMTP servers.    
See AGENT.INI for details.

Agent now deletes the Outbox files when all the messages in the outbox are deleted.

Agent now strips EOF characters from signatures when posting.

The various debugging parameters are now documented in the AGENT.INI help topic.

Agent now purges all but the most recent article in an ignored thread.

Agent now detects when the news server renumbered the articles in a group.    When this occurs.    Agent 
adjusts the high message numbers accordingly and retrieves all new messages.



Release Notes
Version .99e
These Release Notes contain a detailed description of the new features and bug fixes in Agent 99e.    If 
you are upgrading from an earlier version of Agent to Agent 99e, you will notice several things that have 
changed from previous versions.    In particular, PLEASE NOTE some significant changes in the menus 
and dialog box tabs.

Enhancements
· You can now create filters to Kill and Watch Usenet messages based on the author and subject fields.

· You can now define multiple languages (up to 255).    For each language, you can specify what fonts 
to use for the message list and message body panes and what spell-checker to use when composing 
messages.
Each group has a particular language associated with it.    Thus, when you select a group, the 
message list and message body panes use the fonts for that group's language.

· Agent now keeps track of ranges of retrieved messages instead of only the highest message 
retrieved.    This fixes the problem (experienced by many Demon users) where Agent was not 
retrieving all messages due to non-sequential message IDs on the news server.

· Agent now has a new option which allows you to control whether or not Agent keeps track of gaps in 
the range of retrieved messages (Group Properties | Retrieving dialog | Server Creates messages out
of order).

- When this option is checked, Agent always records any gaps in the list of messages that it has 
retrieved so that it can check for new messages in the gaps the next time it retrieves new 
headers.

- When this option is not checked, Agent records the range of retrieved messages from the lowest 
message retrieved through the highest, ignoring gaps.    Since most news servers don't add 
messages out of order (Demon's server being an exception), you can probably leave this 
unchecked.    Unchecking it will generally improve performance.

· Agent now creates message headers with "Message-ID" instead of "Message-Id" because the latter 
was not recognized by some programs.

· Agent now updates the DAT and IDX files more frequently so that data is less likely to be lost in the 
event of a power failure or PC crash.

· You can now use the F3 key to Find Next in the message composition window.

· Added a Confirmations option that controls whether Agent should prompt for confirmation before 
marking all messages in ALL groups read.    Previously, the confirmation option for selected groups 
also controlled the ALL groups command.

· The Print dialog now allows you to select the range of pages to be printed.

· Single-Key Read is a new option on the Navigate menu.    The SPACE key is the accelerator for this 
option.    This option pages down through the current message.    When it reaches the end of the 
message, it jumps to the next unread message.

You can control which message it jumps to with a new option on the General Preferences | Navigation
dialog, "Single-Key Read views next unread message body."    When this option is checked, Agent 
views the next unread message with a body (as if you pressed Ctrl+B).    If this option is not checked 
and the focus is in the message body pane, then SPACE will skip to the next unread message in the 
thread.    If this option is not checked and the focus is in the message list pane, SPACE will skip to the
next unread message.    Typically, you would check the option if you read messages offline, and 
uncheck it if you read online.

Significant Interface Changes



· The Preferences dialog box in the previous versions has now been split into two dialog boxes: 
General Preferences and Posting Preferences.

· Message sampling has changed significantly.    Below are the major changes:
Empty Group Sample Size and View Empty Group Action are no longer group properties.    You can 
still set them on the Group Properties dialog, but they now apply to all groups.    If you configure Agent
to prompt for action when viewing an empty group, you may now specify the sample count from the 
prompt dialog.
Note:    changing the value in the prompt dialog will also change the setting on the Group Property 
dialog.
Sample Headers from Selected Groups (Online menu) will bring up a new dialog.    From it, you can 
choose to sample the <n> most recent messages, or messages from the last <n> days.    Agent will 
remember the last values you used.    In the past, many people would decrement the highest 
message retrieved number for a group, and get new headers to re-retrieve messages that had been 
deleted or purged.    This dialog provides a more convenient way to do the same thing.    Note that the 
sample count on this dialog is independent of the count on the empty group dialog, so changing this 
value won't affect the empty group sample size.

Miscellaneous Fixes
· Fixed a GPF which could occur when closing Agent.

· Fixed a bug that caused browsers to sometimes fail to redraw correctly when you resized a window.

· Fixed a bug that could cause Agent to delete the wrong message if new messages were received 
while the "Are you sure?" confirmation dialog box was displayed.

· Fixed a bug that caused Agent to GPF when doing certain Find operations.

· Fixed a bug that caused Agent to incorrectly decode certain binary attachments.    This bug only 
affected binaries that were decoded from messages whose bodies were already retrieved, or from 
email messages.

· Fixed a bug that would cause the From field to get mangled if the field contained a syntax error and 
you either fixed the error or chose to leave it unchanged.

· When importing messages from Unix-format files, Agent ignored messages for which the From line 
contained a timezone field.    Agent now recognizes these messages.

· When you delete messages, the confirmation prompt includes the number of messages to be deleted.
This count used to include messages that were marked "keep" and would not actually be deleted.    
Now, the count excludes kept messages.

· The "you have new email" status bar message is now cleared when you    mark read or delete unread 
mail messages.    Previously, the status bar was cleared only when you viewed an unread mail 
message. 

· Fixed a bug which caused the Save Messages As command to overwrite an existing file even after 
you told it not to.

· The Reply-To field may now contain more than one email address.

· Agent now always asks for confirmation if you attempt to delete a message and any text is selected in
the message body.    This is to help users keep from accidentally deleting a message when they 
intended to delete a text selection.

· Agent now displays a warning message if you use the expand addresses option to insert an address 
book entry into a message, when the entry has a Field Text value.

· Fixed a bug which caused Agent to fail to remember the directory last used in the Save Messages As 
dialog.



Release Notes
Version .99d
The Release Notes contain a detailed description of the new features and bug fixes in Agent 99d.    If you 
are upgrading from an earlier version of Agent to Agent 99d, you will notice several things that have 
changed from previous versions.    In particular, PLEASE NOTE that we have changed the behavior of 
some of Agent's navigation features, based on feedback from many Agent users.    

In previous versions of Agent, messages were automatically marked read whenever the message body 
was displayed in the body pane.    Many of our users complained that they accidentally marked messages
read while scrolling through the list pane.    We have added a Preference setting that allows you to choose
when Agent should automatically mark messages read (described in the Release Notes).    ** In particular,
we have changed the default behavior so that Agent now only marks a message read when it is displayed
in the body pane AND the body pane has the focus.** If you prefer the old behavior, you can change this 
setting on the Navigation tab of the Preferences dialog box.

We have also changed the keyboard accelerators that were used to Save/Launch Binary Attachments 
(described in the Release Notes).    We know that this is confusing for our power-keyboard-users, but 
when we added the new "Skip To/View Next Unread Message with Body" feature, we decided that B and 
Ctrl-B were the obvious choices for keyboard accelerators.    The Save Binary function has been renamed
Decode Binary.    Its new accelerator is Ctrl-D (it used to be Ctrl-B).    The accelerator for Launch Binary (it 
used to be Ctrl-Shift-B) is now Ctrl-L.

Address Book - Agent now contains an Address Book.    Select Open Address Book from the Window 
menu to view it.    You can add items to the Address Book by selecting New from the Address menu or 
using the toolbar buttons while the Address Book is open.    You can also add addresses by highlighting a 
Usenet or email message and selecting Add Author to Address Book from the Message menu.32-Bit 
Agent - We now have a 32-bit version of Agent.

We've added built-in support for dial-up networking, allowing Agent to automatically establish a dial-up 
connection when Agent goes online and hang up the connection when it goes offline.    Agent's DUN 
support is configured by the new Dial-Up tab of the Preferences dialog box.    This tab is present in 32-bit 
Agent only, and appears only if DUN has been installed on the computer.

When using Windows 95 or NT Dial-up Networking, Agent assumes that you are connected if ANY 
connection is active (even if it's not the one Agent is configured to use).    This is controlled by an 
AGENT.INI option, and appears on the Preferences dialog box's Dial-Up tab as the checkbox "If another 
connection is already open, use it instead."

The AGENT.INI option is:

[Online]

RasUseAny=1

You can now run multiple instances of 32-bit Agent simultaneously provided each instance is using a 
different data directory.

Email Enhancements and Bug Fixes - The following changes have been made.

· The menu option Reply to All on the Post menu has been added for sending replies to Cc addresses.  
This option is enabled only if a single email message is selected.    In the reply message created, the 
fields are initialized as follows:

To:    The author of the original message
Cc:    All addressees in the original message's To and Cc fields
Bcc: All addressees in the original message's Bcc field

Agent omits your own email address from the fields.

· On the composition window for email messages, the Cc is now in its own edit control field.    This 
makes it easier to Cc your email messages.



· "Re:" is no longer prepended to the subjects of forwarded email messages.

· Source routing addresses are now handled correctly in outgoing posts.

· Fixed bug which caused duplicate mail to be received under some conditions when Agent is set to 
leave mail on server.

Navigation and Marking Messages Read
· We added new Navigation menu options to Skip to or View the next unread message body.    You can 

use these commands to jump to the next unread message for which a body has been retrieved, 
skipping over other unread messages that have not been retrieved.    The keyboard accelerators for 
these features are B and Ctrl-B, respectively.

· We have changed the criteria that Agent uses when automatically marking an article as "read".    The 
following options have been added to the Navigation tab of the Preferences dialog box:

Automatically mark articles read:

( ) Whenever the message body is visible in the Message pane

(x) Only when the Message pane is selected

( ) Never

We have chosen the second option, "Only when the Message pane is selected", as the default in 
order to avoid inadvertently marking articles read when you happen to select them in the Message 
List pane.    

You can change it back to the old behavior by selecting the first option.

In order to make room for these options on the Navigation tab of the Preferences dialog box, we 
created a new tab on the Preferences dialog and moved some options to it.    This new tab is called 
Message List and contains the options having to do with the formatting of the Message List pane.

· Added options in the Marking Read tab of the Group Properties dialog box for marking only messages
without bodies read when retrieving new headers or marked message bodies.    For example, you can
now configure Agent to mark all message headers read, but leave unread message bodies alone 
when you retrieve new headers.

· If Agent is configured to mark all messages read when you jump to a new group, and if Agent is 
configured to automatically skip to the next unread message when you Watch, Ignore, or Mark for 
Retrieval, Agent will now mark all messages read in the old group when it skips to the new group.

Keyboard Accelerators
· The accelerators used for the Save Binary and Launch Binary functions have been changed.

- The Save Binary function has been renamed Decode Binary.    Its new accelerator is Ctrl-D (used 
to be Ctrl-B).

- The accelerator for Launch Binary (used to be Ctrl-Shift-B) is now Ctrl-L.

- To be consistent with other attachment commands, the command "Manually Save Binary 
Attachment" is now "Manually Decode Binary Attachment."    This did not involve any accelerator 
changes.

· The new navigation features, Skip to and View Next Unread with Body, now uses B and Ctrl-B as the 
keyboard accelerators.

· The accelerator for the new Reply to All feature is Shift+R.

· The accelerator Ctrl+M has been added for posting new email messages.

· Formerly undocumented accelerators (G - go to Group pane, A - go to Article pane and B - go to Body
pane) have been changed to 1,2,3.

Winsock Related Changes



· The AGENT.INI parameter [Online]UnloadWinsock has been replaced by two new AGENT.INI 
parameters [Online]LoadWinsockOnStartup16 and [Online]LoadWinsockOnStartup32.

· There is a new checkbox for this option on the Online tab of the Preferences dialog box.

- When this option is checked, Agent loads Winsock immediately on program startup and unloads it
on program exit. 

- When this option is unchecked, Agent loads Winsock when it goes online and unloads it when it 
goes offline.    When using 32-bit Agent with the Windows 95 winsock, you'll want to leave this 
option enabled.

· In some cases, winsock will report that your own computer's name is blank.    If this happens, Agent 
now uses "unknown" instead of the blank name in the SMTP HELO command.    Using a blank name 
caused the email server to report Error 501.

Miscellaneous - The following are some general changes that have been made.

· When Agent is configured to thread by subject, it no longer groups all messages with a blank subject 
in a single thread.    Messages with blank subjects are now left in separate threads.

· When you delete messages, the confirmation dialog now includes the number of messages you are 
about to delete, to help you avoid mistakenly deleting the wrong messages.

· Fixed a bug which made it impossible to resize the browser panes after a browser window had been 
minimized and then restored.

· Fixed a bug that could cause the percent-saved value calculated by the compaction operation to be 
incorrect.

· Agent no longer includes the Newsgroups: field in email replies to Usenet messages, unless the 
same reply is also posted as a Usenet follow-up message.

· If you have queued messages when you close Agent, a Yes/No/Cancel message box will be 
displayed.    Select Yes if you want Agent to send the messages.    Select No to close Agent without 
sending the messages.    Select Cancel if you don't want to close Agent or send the messages.    This 
feature is enabled by the "Send Queued messages when closing application" checkbox on the 
Confirmations tab of the Preferences dialog box and by the AGENT.INI parameter 
[Confirm]SendOnClose=1.

· Agent will now update the AGENT.INI file with new parameters.    There is a new AGENT.INI option, 
[Profile]Build, which identifies the version and build most recently run.    Each time Agent starts, it 
checks this parameter.    If the parameter does not match Agent's current version and build, Agent 
writes any missing parameters to the file, assigning default values to the new parameters.

· On the Attachments tab of the Preferences dialog box, the default value for the Lines per Message 
field has been increased from 900 to 10,000.

· Pressing Page Up while on the first page now causes Agent to scroll up to the first line of the page.

· Double-spaced text no longer appears single-spaced when scrolling forward.

Version .99c
You can now copy or move items from the Outbox to a folder.

You can now select a folder in which to automatically route your outbound messages.

Implemented an interim solution to binary decoding.    Agent now lets you apply all of the attachment 
decoding options to email messages in folders.    But, it never deletes the body of an email message.    
This means that it doesn't store the destination filename in the message after you have extracted the file, 
nor does it display the little camera icon next to the message.    The next release will have the fully 
integrated solution, with MIME support.

The email filter now recognizes the "Apparently-To:" field. If a received or imported email message 
contains an Apparently-To field rather than a To field, Agent treats the field as if it were the To field.



Added a Table of Contents to the AGENT.INI help topic.

Agent now generates its own message IDs when posting messages.    This was done so that sent 
messages, when copied from the outbox to a folder, will thread correctly with replies to the sent 
messages.    You can disable this feature (if Agent's message IDs disagree with your news server) with 
the following INI option:

[Message]
GenerateId=0

You can now cancel a sent Usenet message that has been placed in a folder if you allow Agent to 
generate message ids (the new default).    This will allow you to cancel a message without first retrieving it
from the news server.    If Agent does not generate the message id for the message, you must retrieve it 
from the news server before you can cancel it.

Added a Cancel button to the "Skip to Next Unread Group" message box.

After spell-checking a selected area of text, Agent no longer asks you if you want to start at the beginning 
of the message and spell check the entire message.

You can now selectively specify the header fields to use when printing.

Changed the way the progress bar works.    Hopefully, there's a setting to make everyone happy.    It is 
currently controlled by two INI options.    Click here for details.

Agent now accepts email messages of the form @x:foo@bar    (they're called "source routing 
addresses"), either with or without the enclosing <...>, and will pass the @x routing info to the mail server. 
The full syntax of the routing (@x:) portion of the address is:

@<domain> [,@<domain>]*:
(This means that the routing info consists of one or more @<domain> components, separated by 
commas, with the whole thing followed by a colon).

Enhanced the behavior when replying to a Usenet message which has the "Reply-To:" field set to 
"poster".    Agent now pops up a dialog which gives you the choice of (1) replying to the poster via email, 
(2) posting a Usenet message AND CCing the poster via email, or (3) just posting a Usenet message.

Agent now accepts email addresses without the "@domain" part.    Addresses with just the @ are also 
acceptable.    Agent does not try to determine the actual domain for the address.    Rather, it sends the 
address as is to the mail server, and lets it deal with it.    Most mail servers automatically assume the 
server's local domain if no domain is supplied.

Agent now supports the "In-Reply-To:" field (which identifies the specific message to which the reply 
pertains).

The build number now includes a "32" or "16" to indicate whether you are using the 32-bit or 16-bit 
version of Agent.

Under Preferences->Posting, Agent was limiting the length of the "Reply to Email" and "Forwarded Email"
introduction strings to the number of characters that fit on the screen.    This limit has been removed.

Agent now recognizes "UTC" when parsing the date/times of messages.

Agent now displays a warning message if you attempt to use "Save As" on a header with no body text.

When renaming a folder, the "new name" field automatically defaults to the old name to make it easier to 
edit.

Added end-of-message marker in the message body pane.

Agent now allows you to select text in read-only windows (i.e., in the message body pane) with the 
keyboard.    Previously, you could only use the mouse to select text.    To select text with the keyboard, 
turn off Scroll Lock on your keyboard.

Agent no longer spell-checks words that look like email addresses, domain names, URLs, etc.      
Normally, this means that Agent will not try to spellcheck the introduction line, unless an email address 
contains a proper name.



Various bug-fixes and enhancements in the composition window, including:
· Removed the 60K size restriction in composition and message window.
· Fixed a bug that could make Agent hang while word-wrapping very long message that contained no 

hard carriage returns. 
· Some performance improvements
· Added end-of-message marker in composition window
· Fixed a bug in the function that calculates the space consumed by tabs, which is used to determine 

when to wrap lines in messages being formatted for transmission.    Also fixed problem that caused 
text to be wrapped incorrectly when displaying messages. 

· Fixed a GPF that could occur if you entered a very long field value in the "Value for:" edit control on 
the composition window. 

Agent now remembers an message's original newsgroup.    This allows Agent to use the correct Group 
Properties, Introduction Strings, etc. when you reply to a message from a folder.    For messages created 
outside the context of a group (original email messages and Usenet messages created when no group is 
selected), Agent sets the field to blank, which will cause it to use the default group properties for the 
message.

Added the Post->New Copy of Message command.    This will allow you to resend a message that has 
been copied to a folder.

Explorer-style file dialogs in Windows 95.

Support for long filenames.

When opening any of the tabbed dialogs (e.g., Preferences, Properties for Selected Group), Agent now 
automatically selects the tab you were viewing the last time you had the dialog open.

Added new controls to the Attachments tab of the Properties for Selected Group and Default Properties 
for All Groups dialog boxes (Group menu).    When saving a binary attachment, you now have the option 
of using the name of the message as the attachment's filename.

Agent now uses the operating system's own timezone setting rather than storing an Agent-specific 
timezone.    The timezone setting controls no longer appear on the Preferences dialog.

Eliminated the hourglass when Agent does the merge/purge step after retrieving new headers.

Added the "Newsgroups:" header field on CCed copies of Usenet posts (so that when you get a copy of 
the email you get an indication in the header fields of what group it was associated with).

Fixed a problem which could cause a menu to be dismissed when the New Email Notification message 
was displayed.

Fixed a problem in the composition window which could cause text to be garbled or disappear after 
pasting text that came from a UNIX machine (UNIX machines use a single \n character as a line 
terminator instead of \r\n pairs).

Fixed a problem which could prevent you from copying or moving a message into a folder because Agent 
would think you had already copied/moved it.    Agent now does a better job of checking for duplicates, 
and also lets you override the warning and copy the messages anyway.

Fixed a problem which prevented Agent from accepting some less common format for email addresses.

Fixed a problem in which Agent was stopping all online tasks even if you answered "No" to the "Stop all 
online tasks?" prompt.

Fixed a problem which caused the current thread to collapse when new email was received.

Fixed a problem which caused a "435 Duplicate" error when posting multi-part Usenet messages.

Fixed a problem which could cause Agent to retrieve two copies of an email message if you had "Leave 
on server" enabled.

Fixed a problem in which the 'Newsgroup:' header field was not being initialized correctly when displaying 
messages in a folder.



The X-Attachment field is now visible when displaying all header fields for an email message.    This field 
contains the name of any attached file.

Fixed an intermittent printer problem which could cause a generic "Error encountered during print" 
message running under Windows 95. 

Fixed some problems in controlling the scroll lock light.    Now Agent maintains its internal state and its 
own scroll indicator, but does not enable/disable the keyboard scroll lock light.

Bullet-proofed against date/time calculation errors.

Fixed a GPF that occurred when trying to repaint an empty Body pane (after an operation such as 
resizing, scrolling, pressing a key, clicking in empty window).

Fixed a problem that prevented a right-mouse click from changing the window focus.    This occurred 
when you had two Newsgroup windows open and switched between them by clicking with the right-
mouse button.

Fixed a problem that could lead to an "out of memory" error when deleting messages.    This generally 
occurred if you pressed Delete in an empty message list.

Fixed a GPF that could occur if you defined a folder before you got groups for the first time and then got 
new or refreshed the group list.

Fixed a GPF that could occur if you received an email with no header fields.

Fixed a GPF that could occur when you dragged and dropped a message with a long subject field.

Fixed two problems that could cause Agent to "unlock" messages when upgrading to Agent 99a or 99b 
from early version of Free Agent.

Fixed a problem in the French spell-checker.    It didn't deal with words that contained apostrophes.

Fixed a problem which could prevent Agent from retrieving all parts of an email message.    Apparently, 
some listservers send multiple messages with the same message id.    Agent would see the "duplicate" ID,
and assume that it had already retrieved the message.

Fixed a GPF that could occur if Agent checked for email while purging.

Fixed a problem in which active retrieval tasks could be disrupted if you changed the sort in a group that 
had any messages queued for retrieval.    This resulted in Agent not retrieving all marked message 
bodies.

Fixed a problem that could result in "error 550: User Unknown" when sending an email message.    This 
occurred if you had your field defaults set to always CC: yourself, and then you overrode that for an 
individual email by blanking the CC: field in the outgoing post.

Fixed a problem that was allowing email recipients to see who was BCCed on the email.    Agent now 
omits the Bcc field from the message when it is sent.

Fixed a problem that caused an Ignored thread to be marked "unread" if it was moved to a folder.

Fixed a problem that could cause Agent to hang or GPF if it read a message header which contained a 
References field with contained the message's own message id.    (We found another newsreader that 
incorrectly generated messages with this problem.)

Fixed a problem which could make new text wrap incorrectly in the composition with if you included one of
your quote characters (i.e. >) in the newly typed text.

Fixed a problem that caused the checkmark next to "Online->Debug log to Agent Log" not to be 
displayed.

Fixed a problem that was making the Tooltip help appear as a separate window on the Windows 95 
taskbar. 

Fixed a problem that was causing Agent to access the hard drive every second or so.    This problem only 
occurred if you were not running a disk cache program, such as SmartDrive.



Fixed a problem when Agent couldn't find the "Inbox" folder if the folder name started with a blank.

Fixed a problem which could cause a GPF @ 0001:4F93 or cause Agent to hang when merging in new 
headers.    These cases were due to messages that had a Reference: field that contained references to 
themselves.

Fixed error that could cause "503 need RCPT posting email" error message.

Fixed a problem that could cause the body pane to reset to the top when you    received new email or 
pressed a key that changed the state of the message (i.e. Keep, Ignore).

Fixed problem in spell-checker that could cause it to jump over a misspelled word (after deleting a 
previous word).

The menus have been changed to follow the new MS guidelines for using menu ellipses.

Agent was sometimes using the wrong icon for incoming email messages, marking them as Usenet 
messages.    This has been fixed.

Fixed a problem that could cause Agent to hang reading an email with a long "To:" list.

Version .99b
Fixed a problem that would cause messages to be deleted when canceling a Move to Folder operation.

Fixed the "Error reported by server: -ERR bad number 0" problem when checking for new email.    This 
would occur if you told Agent to leave your mail on the server AND your server does not support UIDL.

Fixed two problems that only affected users who receive email via SMTP:

· GPF at 0001:1C4F that occurred when starting Agent.
· Agent was loading winsock on startup regardless of whether the "load on startup" option was 

checked.

Fixed GPF @ 0014:F9C7 which occurred if the data and/or shared directories specified in AGENT.INI no 
longer existed.

Fixed a Skip to Next Unread problem when viewing a sorted group.    If you changed the sort for a group, 
but Agent hadn't actually re-sorted the group (it was part of a multiple selection), and you performed a 
skip to next unread that jumped into that group, Agent jumped to the first unread message in the old sort 
and then re-sorted.    The result is that you ended up in a random location in the message list.

Fixed a bug which causes the Watch and Ignore flags to not propagate correctly if you selected Watch or 
Ignore while the Message list was sorted by anything other than Thread.

Version .99a
Due to email's tight integration, we've made a minor yet pervasive change to our terminology.    We've 
replaced the word "Article" with "Message."

User-defined folders have been added.    Folders appear in the Group pane (which is now called the 
Groups/Folder pane) along with newsgroups.    The commands for adding, removing, and showing folders
appear on the Group menu.    You can drag and drop messages into folders or use the Copy/Move to 
Folder options on the Message menu.    To have a folder appear on your Copy/Move to Folder flyouts, 
choose Manage Folder Menus from the Options menu.

You can now sort messages.    To sort the messages in a group or folder, choose the desired sort from the
Group menu or simply click on the column label corresponding to the type of sort you want (e.g., click 
"Author" in the Message List pane to sort by author).    Note:    To sort by thread when viewing one of the 
other sorts, click on the "Status" column.    You can change order (ascending or descending) of the date, 
size, and author sorts with the Display tab of the Preferences dialog box (you must resort the Message 
List pane for these changes to take effect).

You can now receive email from POP3 and SMTP servers.    To configure Agent for email, choose 
Inbound Email from the Options menu and fill in the System Profile tab.    To check for new mail, choose 
Check for Email from the Online menu.    To import your old mail from Eudora or Pegasus, search for 



"Importing messages" in this help file.

Added additional Introduction Strings strings for replying from an email.

Added a progress indicator when downloading message bodies.    Among other things, you can now tell 
how much progress you're making on each part of a binary download.

Added support for "poster" in the follow-up field.      Here's how it works:
· When posting a Usenet article, if you wish to have follow-up messages sent to you via email, set the 

Followup-To field to "poster".
· If you followup to a message with "poster" in the Followup-To field, Agent now creates an email 

message composition window rather than a news message composition window.

Modified the right mouse button behavior to work like Windows 95, which also allows you to select items 
from the context menus with either the right or left buttons.    To revert to the old behavior, edit the 
following line in AGENT.INI:

[Browser]
RightButtonSelects=0

Added protection against automatically launching executable binary attachments.    For details, see the 
Confirmations tab of the Preferences dialog box.

You can now choose which fields appear at the top of message bodies.    See AGENT.INI for details.

Added Ctrl+H as a keyboard accelerator to toggle "Show All Header Fields."

Added the "Organization" field to the list of fields you can set in email messages.

Fixed bug which could cause Agent to hang on some servers when it tried to retrieve an message that 
was no longer available.




